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Introduction

The Upgrade Guide for Sage 100 contains details on all of the new features in Sage 100 
2025 and a comprehensive checklist to guide you through migrating your data from 
earlier versions of Sage 100. 

Use this guide after you've installed Sage 100 2025 following the instructions in the 
Sage 100 Installation and System Administrator's Guide. You can find the installation 
guide and other documentation on the Sage 100 Documents page. 

Depending on your purchase agreement, some features described here may not be available in 
your product.
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What's New in Version 2025

This chapter describes the enhancements added in Sage 100 version 2025. Changes to 
the Sage 100 Desktop are listed first, followed by global changes, module-specific 
changes, integrations, and then retired features.

Depending on your purchase agreement, some features described here may not be 
available in your product.

Note: The Sage 100 2025 release features 25 suggestions from customers and 
business partners via the Sage 100 ideas site and other channels. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit 
the ideas site to share your ideas and vote for your favorites.

Your Sage 100 business partners at work! This idea was a suggestion from 
90 Minds, Inc. where “More Minds Are Better Than One.”

Sage 100 Desktop Changes
The following changes were made to the Sage 100 Desktop.

Resources Button

On the Web Content tab, the Resources button has been removed. For a one-stop shop 
to the Sage Community Hub, Knowledgebase, Product Documents page, Sage 
University, and additional services, click the Resources button on the Help tab instead.

To access file layout and program information, visit the Sage 100 Documents page and 
then select Sage 100 2025 > Administrator and Technical Documentation.
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Global Changes

Global Changes
The following changes are carried throughout multiple modules.

Option to Expand the Accounts Receivable Invoice Number

You can now expand the invoice number length from 7 to 20 characters in the Accounts 
Receivable, Sales Order, and Job Cost modules. In Common Information Options, use 
the Select the maximum length of the invoice number field to increase the length up to 
20 characters to meet your business needs.

Forms, reports, and screens are automatically changed to accommodate the expanded 
invoice number. Existing invoice numbers are not automatically converted to the new 
length.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

A/R Invoice Expansion Conversion Utility

The A/R Invoice Expansion Conversion Utility has been added to the Utilities menu. In the 
Sage 100 Desktop, select File > Run. In the Run Program window, enter *utl in the 
Program field to open the Utilities menu.

Use this utility if you want to convert your existing 7-digit numeric invoice numbers to the 
new invoice number length. Invoice numbers containing characters, or a combination of 
numerics and characters will not be changed.

Audit Tracking for Sales Orders and Purchase Orders

You now have the option to enable audit tracking for sales orders and purchase orders.  
This feature includes the following highlights:

 l In Sales Order Options and Purchase Order Options, the Changes to Track field and 
Track Additions in Detail check box have been added.

 l You can retain an audit trail of all changes, deletions, and additions.

 l When the option to track All is selected, the new Sales Order Audit Report and 
Purchase Order Audit Report are available.
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 l A Purge button on the audit report provides access to the new Purge Audit 
Report utility. You can also access the utility on the Utilities menu in each 
module.

 l In Sales Order Entry and Purchase Order Entry, click the new Audit Viewer button to 
view changes in the Audit Activity window. This feature is available if the user has 
permissions to the audit report for the module in Role Maintenance.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Copy Package Tracking Number in Accounts Receivable and Sales 
Order

In Summary Package Tracking, click the new Copy Tracking Number to Clipboard button 
to quickly copy a tracking number into an email or document.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Crystal Reports Runtime Update

The Crystal Reports Runtime 64-bit and 32-bit will be updated when installing Sage 100 
2025 server or workstation on a machine that has all current prerequisites. This update 
includes security enhancements, compatibility, performance improvements, and new 
features. 

Accounts Payable
The following change was made in the Accounts Payable module.

Switch View button in Invoice Payment Selection

The Switch View button has been added in the Select Invoices for Payment window, 
enabling you to toggle between the grid view and list view. Click the button to use the list 
view where you press CTRL + SHIFT to select invoices. Or click the button again to use 
the grid view where you use the Include check box to select invoices. The selected view 
will persist by user.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.
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Accounts Receivable

Accounts Receivable
The following changes were made in the Accounts Receivable module.

View Last Invoice Date and Amount Posted for Customer

The Last Invoice Date and Last Invoice Amount fields have been added on the Statistics 
tab in Customer Maintenance/Inquiry. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Print Extended Item Description

You now have the option to print the extended item description for miscellaneous items 
and charges on the following Accounts Receivable forms and their associated quick print 
tasks: Invoice Printing and Invoice History Printing.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Customer on Credit Hold Message in Cash Receipts Entry

In Cash Receipts Entry, if the selected customer is on credit hold, the "Customer on 
Credit Hold" message displays in red on the task.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Bank Reconciliation
The following changes were made in the Bank Reconciliation module.

Set Default Sort Columns by User

In the Check, Deposit and Adjustment Entry task and the Reconcile Bank task, the 
columns entered in the Sort Columns window now persist by user. This feature enables 
each user to select their own default sort columns.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.
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View Total Amount for Cleared Transactions

In Reconcile Bank, the Total Amount Cleared field has been added on the Checks tab 
and Dep/Adjust tab. This field displays the total for all cleared entries on each tab. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Business Insights
The following change was made in the Business Insights module.

New Views for Request for Quote

For the following primary views in Business Insights, new secondary views have been 
added for the Purchase Order Request for Quote feature.

Note: The views that are indented underneath each primary view are the 
secondary views available in the Business Insights Explore navigation pane when 
you access the primary view.

 l Purchase Order View (primary view accessed on the Business Insights Explorer 
menu or the Purchase Order Explore menu)

 l Purchase Order Quotes

 l Vendor History Quote

 l Open PO By Vendor Name View (primary view accessed on the Business Insights 
Explorer menu or the Purchase Order Explore menu)

 l Open Purchase Order Quotes

 l Vendor View (primary view accessed on the Business Insights Explorer menu or the 
Accounts Payable Explore menu)

 l Vendor History Quotes
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General Ledger

General Ledger
The following change was made in the General Ledger module.

Posting Date for Reversed Journal Entry

When using the Journal Reversal button in Account Maintenance to reverse a journal 
entry, the posting date in General Journal Entry will default to the original date of the 
entry. If the original date is in a closed period, the posting date will default to the current 
accounting date.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Inventory Management
The following changes were made in the Inventory Management module.

Option to Add Universal Product Code for an Item

On the Item Maintenance Additional tab, you can now add the Universal Product Code 
(UPC) or European Article Number (EAN) for an item. You have the flexibility to select 
from five different types of UPC or EAN codes in the UPC / EAN Type field  to meet your 
business needs.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Option to Sort by Product Line on Physical Count Reports

The ability to sort by product line has been added to the Physical Count Worksheet in the 
Sort Report By field, and in the Physical Count Variance Register and Count Card 
Variance Register in the Sort Lines By field.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Option to Print Extended Item Description on Physical Count Worksheet

The Print Extended Item Description check box has been added on the Physical Count 
Worksheet.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Print Items with Zero Balances on Trial Balance Report

The option to print inventory items where the quantity-on-hand ending balance and the 
dollar-amount-on-hand ending balance are zero has been added to the Trial Balance 
Report.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Options to Keep Window Open After Print or Preview for Inventory Labels

The Keep Window Open After Print and Keep Window Open after Preview check boxes 
have been added to Inventory Label Printing.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Inventory Requirements Planning
The following change was made in the Inventory Requirements Planning module.

View Production/Purchase Quantity Detail in IRP Inquiry and IRP Report

In Inventory Requirements Planning Inquiry, a new Production/Purchase Quantity 
column has been added to the Detail view. This saves you time from having to look up 
quantity information in the Item Detail window. The Production/Purchase Quantity detail 
now prints on the Inventory Requirements Planning Report.
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Paperless Office

Paperless Office
The following changes were made in the Paperless Office module.

Quote Document

A new Quote document has been added for the Purchase Order Request for Quote 
feature. You can define the settings and default delivery options for quotes in the 
following Paperless Office tasks.

 l Form Maintenance

 l Electronic Delivery Message Maintenance

 l Default Delivery Options

 l Vendor Viewer

 l Paperless Office Delivery Options in Vendor Maintenance/Inquiry

B/R Positive Pay Export Log Document

The B/R Positive Pay Export Log document has been added in the following Paperless 
Office tasks:

 l Journal and Register Maintenance

 l Journal and Register Viewer

 l Electronic Delivery Message Maintenance

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Form Code Name Saved in PDF Log for Customer and Vendor forms

When customer or vendor forms are sent through Paperless Office, the form code name 
is now saved in the PDF log. The Form Code field has been added in Customer Viewer 
and Vendor Viewer.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Sage 100 Customer Upgrade Guide 9

https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP/


Export to Excel button Added in Viewer Tasks

The Export to Excel button has been added in all Paperless Office Viewer tasks, so you 
can export contents from list boxes to Microsoft Excel.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Production Management
The following changes were made in the Production Management module.

Standard Cost Rate per Piece Labor Improvements

In Activity Code Maintenance, you can now establish a standard cost rate per piece and  
divisor for an activity code to calculate budget labor cost. This provides you with the 
flexibility to define a standard cost rate per hour and/or rate per piece for an activity code. 
The standard cost rate per piece is the functionality that was in the Work Order module.

This feature includes the following changes in Activity Code Maintenance:

 l Standard Cost/Hour field renamed to (Standard Cost) Rate/Hour field

 l The following new fields have been added:

 l (Rate/Hour) Divisor field 

 l (Standard Cost) Rate/Piece field 

 l (Rate/Piece) Divisor field 

Also, on the Work Ticket Transaction Entry Lines tab, the Qty Completed field has been 
added.

Work Ticket Template Maintenance Improvements

The following improvements have been made in Work Ticket Template Maintenance:

 l Revision numbers for work ticket templates are now alphanumeric instead of numeric 
only.

 l The Description field has been added next to the Revision No. field, and you can 
enter a template description when step 000000 is selected.
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Production Management

 l Next to the Step No. field, the Description field has been renamed to Step Description 
field.

 l Click the new Step Overview button to view detail step information.

 l Attachments are now specific to a work ticket step instead of the entire work ticket 
template.

 l When you click Cancel, the following key fields are now available: Template No. and 
Revision No. This improvement reduces the number of clicks necessary to access 
each key field.

 l To make the budgeting of a step more intuitive, the Calculate Budget check box has 
been added on the Work Ticket Template Maintenance Additional tab. Select this 
check box to recalculate budget values using the information from the activity code 
assigned to the step. When the check box is selected, the following fields can only be 
viewed: Setup Hours, Hours, Labor Cost, and Material Cost.

Copy From Step

In Work Ticket Template Maintenance, the Copy From feature has been enhanced. You 
can now copy a specific step from a work ticket template, or an open or closed work 
ticket. The Copy From button is available when any step is selected.

You can also use this feature to renumber a step in a new template that has not been 
used yet. 

Option to Relieve WIP on Last Completion

On the Production Management Options Entry tab, the Relieve WIP on Last Completion 
check box has been added. Select it to post remaining WIP to the inventory account when 
the work ticket is completed.

Enhanced Scheduling to Calculate Budgets

When the Enhanced Scheduling feature is enabled, labor budget hours in Work Ticket 
Entry are now based on the same calculated hours used for Enhanced Scheduling.
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Purchase Order
The following changes were made in the Purchase Order module.

Option to Require Cancellation Code When Deleting Order/Quote

On the Purchase Order Options History tab, the Cancel/Reason Code Required When 
Deleting Orders/Quotes check box has been added. Select this check box to require the 
entry of a cancellation code when a purchase order/quote or  line is deleted.

In addition, if Yes or Prompt is selected at the Retain Deleted Orders/Quotes or Retain 
Deleted Lines for Orders/Quotes field and you delete a purchase order/quote or line, the 
Cancellation Code window will automatically appear.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Reverse Work Ticket Cost and Quantities in Return of Goods

If the Production Management module is integrated with Purchase Order and if a 
purchase order is costed to a work ticket, you can now reverse the appropriate work ticket 
cost and quantities from the Work Ticket files. 

On the Return of Goods Entry Lines tab, the following fields have been added: Work 
Ticket No., W/T Desc, Step No., and Step Desc. Use these fields to modify the work ticket 
distribution information for line items on the original purchase order. You can also enter 
work ticket distribution information for returns for which there is no corresponding 
purchase order.

Request for Quote

In Purchase Order Entry, you can now enter a quote and email a Request for Quote to 
one or multiple vendors using Paperless Office to find the lowest cost for purchased 
materials.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Changes in Purchase Order Entry

The following features have been added in Purchase Order Entry for quotes:
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Purchase Order

 l On the Header tab, a new Quote option has been added in the Order Type field.

 l When entering a quote, you have the option to determine the unit cost to use for 
items based on the Select Unit Cost for Quote field in Purchase Order Options. 

 l When using the Copy From feature, you can copy existing quotes.

 l Quotes sent to vendors are created using the vendor's alias item numbers.

 l Click Generate Order to generate a purchase order from a quote. This feature is 
available based on a security option.

 l Click the new drop-down button next to the Print button to select Purchase 
Order Printing or Quote Printing.

New Tasks on the Purchase Order Main Menu

The following new tasks have been added for quotes:

 l Auto Generate Orders from Quotes

 l Quote Printing

Option to Print Quotes on Reports

The option to print quotes has been added and the Completed status now applies to 
quotes on the following reports:

 l Open Purchase Order Report

 l You can also print quotes on hold. In the selection grid, the 
Required/Expire Date column applies to quotes now.

 l Open Orders by Item Report

 l Open Orders by Job Report

 l Purchase Order Recap

 l Purchase Order History Report

 l You can also print canceled quotes. 

Changes in Purchase Order Options

On the Entry tab, the following options have been added for quotes:

 l Use Default Order Date When Generating Purchase Order

 l Default Days Until Quote Expires

 l Select Unit Cost for Quote
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The following fields have been renamed to include quotes:

 l On the Main tab: Days to Retain Completed Purchase Orders/Quotes field

 l On the History tab:

 l Retain Purchase Order/Quote History field

 l Retain Deleted Orders/Quotes field

 l Retain Deleted Lines for Orders/Quotes field

Changes on the Purchase Order Utilities Menu

The following tasks have been renamed to include quotes:

 l Purge Completed Purchase Orders/Quotes

 l Purge Exp Quotes/Master/Repeating Orders

The Create Purchase Order History utility now includes quotes when creating records in 
the Purchase Order History files.

Other Changes

The following changes have been made in other modules for quotes:

 l In Accounts Payable, quotes display on the Vendor Maintenance P/Os tab and you 
can search for quotes in the Search for Purchase Orders window. 

 l In Inventory Management, quotes display on the Item Maintenance Orders tab and 
you can search for quotes in the Search for Purchase Orders window.

Option to Not Back Order Purchase Order When Returning Item

On the Return of Goods Entry Header tab and Lines tab, the Back Order PO check box 
has been added. If a returned item is no longer needed, clear this check box so that a 
back order will not be created for the returned item on the purchase order. 

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Sales Order

Sales Order
The following changes were made in the Sales Order module.

Customer Telephone on Sales Order Invoices

The customer telephone number has been added on the Header tab of the following 
tasks:

 l Sales Order Entry 

 l S/O Invoice Data Entry

 l Sales Order and Quote History Inquiry

 l A/R Invoice History Inquiry for sales order invoices

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Require Cancellation Code When Deleting Order/Quote

On the Sales Order Options History tab, the Cancel/Reason Code Required When 
Deleting Orders/Quotes check box has been added. Select this check box to require the 
entry of a cancellation code when a sales order/quote or line is deleted.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Print Extended Item Description

You now have the option to print the extended item description for regular items, 
miscellaneous items, charges, and special items on the following Sales Order forms and 
their associated quick print tasks: 

 l Sales Order Printing 

 l Picking Sheet Printing 

 l Invoice Printing 

 l Packing List Printing 

 l Additional Packing List Printing 

 l Sales Order and Quote History Printing 
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 l Bar Code Sales Order Printing 

 l Bar Code S/O Picking Sheet

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Visual Integrator
The following change was made in the Visual Integrator module.

Enter a Descriptive Name for Temp Fields

In Import Job Maintenance and Export Job Maintenance, you can now enter a descriptive 
name for temporary fields. On the Data tab, click the Add Temp Field button and in the 
new Temp Field window, enter a name of up to 20 characters.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Visual Process Flows
The following change was made in the Visual Process Flows module.

Request for Quote Process Flow

On the Visual Process Flows Purchases menu, the Request for Quote process flow has 
been added. Use this process flow to create quotes for purchase orders, print or email 
quotes for one or more vendors, and generate purchase orders.
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Integrations

Integrations
The following integrations are available in Sage 100 2025.

Sage Supply Chain Intelligence (SSCI) Integration – Available Fall 2025

Integrate Sage 100 with Sage Supply Chain Intelligence (formerly known as Anvyl) for 
powerful purchase order management.  SSCI bridges the gap between issuance of a 
purchase order and receipt of goods, providing a cloud-based way to collaborate with 
suppliers, consolidate shipments, create custom P/O workflows, and even create and edit 
purchase orders, and have the data flow back into Sage 100.

Use the Sage Supply Chain Intelligence Setup app to perform integration for Sage 100 
2025, 2024.2, and 2023.5.

For instructions, see Set Up Sage Supply Chain Intelligence (Anvyl) Integration in 
Sage 100 help.

Sage Intelligence Reporting Version 8.0

Sage Intelligence Reporting version 8.0 is now available with the Sage 100 2025 release.

Retired Features
The following features are no longer available in Sage 100 version 2025.

Microsoft 365 Connector and Office 365 Contacts

The Microsoft 365 Connector and Office 365 Contacts are now retired in Sage 100 
version 2025. The interface to bring customers onto the Connector was deprecated by 
Microsoft in April 2024, and these add-ons are no longer available in version 2025.

SData Security 

In Role Maintenance, the SData Security tab has been removed for both subscription and 
non-subscription versions of Sage 100.

In System Configuration, the Enable Native SData Provider and Access within Role 
Maintenance check box has been removed.
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With the retirement of SData Security, the option to install the Native SData Provider 
Adapter has been removed from the  Productivity Applications screen (accessed from the 
Sage 100 Autorun.exe).

Vault-Only Accounts

On August 1, 2024, Nuvei/Paya discontinued the creation of vault-only accounts to 
improve security and payment card industry (PCI) compliance. A vault-only account is an 
account used to store the last 4 digits of a credit card; it cannot be used to process credit 
card transactions. 

In Sage 100 2025, vault-only accounts are no longer automatically created. You must 
have a Nuvei/Paya merchant account to add credit cards for new customers. Also, the 
following changes have been made:

 l In A/R Payment Type Maintenance, if you remove the virtual terminal ID and 
merchant key for a credit card payment type and click Accept, a message will appear 
to notify you that credit card records will be disconnected from Nuvei/Paya. At this 
message, you can click Yes to disconnect the credit card record from Nuvei/Paya, or 
click No to return to Payment Type Maintenance and enter a virtual terminal ID and 
merchant key.

 l When adding a credit card on-the-fly in an Accounts Receivable or Sales Order data 
entry task, a virtual terminal ID and merchant key must be defined for the credit card 
payment type in Payment Type Maintenance or Company Maintenance to save the 
credit card record.

 l When copying a company in Company Maintenance, the source company's virtual 
terminal ID and merchant key for credit card payment types are not copied to the 
destination company.
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Changes in Version 2024

This chapter describes the enhancements added in Sage 100 version 2024 and 
subsequent updates. Changes to the Sage 100 Desktop are listed first, followed by global 
changes and then module-specific changes.

Depending on your purchase agreement, some features described here may not be 
available in your product. 

Changes in Version 2024.2
The following enhancements were added in update 2 for Sage 100 2024.

Production Management

The following change was made in the Production Management module.

Option to Relieve WIP on Last Completion

On the Production Management Options Entry tab, the Relieve WIP on Last Completion 
check box has been added. Select it to post remaining WIP to the inventory account when 
the work ticket is completed.

Sage Supply Chain Intelligence (SSCI) Integration – Available Fall 2025

Integrate Sage 100 with Sage Supply Chain Intelligence (formerly known as Anvyl)  for 
powerful purchase order management.  SSCI bridges the gap between issuance of a 
purchase order and receipt of goods, providing a cloud-based way to collaborate with 
suppliers, consolidate shipments, create custom P/O workflows, and even create and edit 
purchase orders, and have the data flow back into Sage 100.

Use the Sage Supply Chain Intelligence Setup app to perform integration for Sage 100 
2025, 2024.2, and 2023.5.

For instructions, see Set Up Sage Supply Chain Intelligence (Anvyl) Integration in 
Sage 100 help.
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Changes in Version 2024.1

Changes in Version 2024.1
The following enhancements were added in update 1 for Sage 100 2024.

Sage 100 Desktop Change

The following change was made to the Sage 100 Desktop.

Updated Tour the Desktop Video

On the Help tab, click the Tour the Desktop Video button to view the most recent features 
added to the Sage 100 Desktop and learn how to customize your Desktop.

Global Change

The following global change was made.

Microsoft SQL Server Installation Change

Sage no longer includes a Microsoft SQL Server Runtime Edition for Sage 100 installed 
with Client/Server architecture using a Microsoft SQL Server database. For more 
information, see Microsoft SQL Server Installation Process in the Sage 100 2024 
Installation Guide on the Sage 100 Documents page.

Accounts Payable

The following change was made in the Accounts Payable module.

1099 Form Changes for Individuals

To support 1099 Form changes for individuals, the following fields have been added on 
the Vendor Maintenance Additional tab and print on the Vendor Listing:

 l (1099 Form) First Name             

 l (1099 Form) Middle Name             

 l (1099 Form) Last Name             

These fields are available only when Individual is selected in the Vendor Type field.
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Inventory Requirements Planning

The following changes were made in the Inventory Requirements Planning module.

Explode Bill without Production Management Integration

You can now explode parent and component items on a multi-level bill even if Inventory 
Requirements Planning is not integrated with the Production Management module. The 
Bill of Materials module must be set up for the current company to explode items.

Consolidate Demands

Demands are now consolidated for the same item when creating a work ticket or 
purchase order to stock. This enhancement allows you to create one work ticket or 
purchase order for multiple demands on the same item, instead of creating a separate 
work ticket or purchase order for each demand. Demands for the same item are 
consolidated automatically if the item’s procurement type is Make to Stock or Buy to 
Stock.

In addition, the following changes have been made:

 l In the Item Detail window, the default selection in the Make To field is now based on 
the item’s procurement type.    

 l In the Items to Produce/Items to Purchase window:     

 l You can now increase the production/purchase quantity beyond the 
quantity recommended.      

 l If an item has a price level set and you change the production/purchase 
quantity, the Unit Cost field is updated accordingly.      

 l When creating a work ticket or purchase order to stock, IRP will use the 
earliest demand date as the date required.    

Option to Explode Phantom Bills

The Include Phantom Bills check box has been added in Inventory Requirements 
Planning Options. You can select this check box to explode the components of the 
phantom bill onto the level of the bill where the phantom bill appears.

Library Master

The following change was made in the Library Master module.
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Changes in Version 2024.1

Sage Connect Integration

You can integrate Sage 100 with Sage Connect, an application built on Sage Network 
platform. This integration enables a one-way push of data from a Sage 100 company to 
Sage Connect.

Use the Sage Network Setup app to perform integration. This application will be available 
shortly as a separate installer. Contact your Sage partner.

For instructions, see Set Up Sage Connect Integration in Sage 100 help.

When a Sage 100 company is integrated with Sage Connect, the Enable Sync for Sage 
Connect check box is selected by default on the Company Maintenance Payment tab.

Production Management

The following change was made in the Production Management module.

View Quantity Remaining in Materials Where-Used Inquiry

A new Quantity Remaining column (displaying the quantity required minus the quantity 
issued) has been added in the Materials Where-Used Inquiry window.

In addition, if the selected item is the parent of a work ticket, the following changes have 
been made:

 l Description column displays "Parent Item Code" 

 l Step Number, Activity Code, and Work Center columns are blank 

 l Due Date column             displays the work ticket production due date

Sales Order

The following change was made in the Sales Order module.

Apply General Ledger Account to Credit Memo

When creating a sales order credit memo and recalling the invoice from history, the new 
Apply to Credit Memo window appears. You can select to apply either the general ledger 
sales account from history or the sales return account to the credit memo.
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Changes in Version 2024
The following enhancements were added in Sage 100 2024. 

Sage 100 Desktop Changes

The following changes were made to the Sage 100 Desktop.

Resources Button 

On the  Help tab, the Resources button has been added to provide a one-stop shop to the 
Sage Community Hub, Knowledgebase, Product Documents page, Sage University, and 
additional services. 

The following buttons have been removed on the Help tab: Product Documents, 
Knowledgebase, Downloads and Updates, Online Community, Sage University, and 
Order Checks and Forms.

Information Center Page Updates

The Sage 100 Information Center page has updated links to the Resource Center, 
Product Documents page, and more. 

Global Changes

The following changes are carried throughout multiple modules.

Installation Change

The Sage 100 installation program now detects if a computer is running the 64-bit version 
or 32-bit version of Windows, and defaults the bit version of the Sage 100 install 
accordingly. 

For example, if you're installing Sage 100 2024 on a computer running the 64-bit version 
of Windows, the installation program defaults to install the 64-bit version of Sage 100 but 
can be changed. If you have other 32-bit versions of Sage 100 on your system, we 
recommend installing the 32-bit version of Sage 100. For information on how to convert to 
the 64-bit version of Sage 100, see the Upgrade Guide on the Sage 100 Documents 
page.
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Changes in Version 2024

Demo Data Refresh (Phase 1)

Inventory items and descriptions  in Sage 100 demo data have been updated to use 
current industry terms.

Automatic Display of Full Extended Item Description

In Role Maintenance, the Inventory Management security option, Allow Automatic 
Display of Full Extended Item Description When Not in a Grid, has been renamed  
Allow Automatic Display of Full Extended Item Description. 

In addition to suppressing the automatic display of the extended item description in Item 
Maintenance, you can now also suppress it in data entry tasks when the item description 
is in the primary grid and an item is entered on a new line in the grid or when tabbing past 
the item on an existing line. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Improvements to Delete and Change Utilities

The following changes have been made in Accounts Payable Delete and Change 
Vendors, Accounts Receivable Delete and Change Customers, and Inventory 
Management Delete and Change Items:

 l You can now access and enter information when data entry is in progress or the main 
entity task is in use. For example, you can access Delete and Change Vendors when 
invoice entry is in progress or when Vendor Maintenance is in use.

 l File checking occurs upon clicking the Proceed button. For example, the delete and 
change vendor process can be performed only if tasks associated with the Vendor 
table are not in use and all data entry in progress has been posted.

 l Tab order has changed. The Change tab is first, followed by the Delete tab.

 l The vendor name, customer name, or item description now displays for starting and 
ending codes in each utility.

 l New security options in Role Maintenance enable you to determine which users can 
perform the delete or change processes.

Also, the following changes apply to General Ledger Change Accounts:
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 l You can now access and enter information when data entry is in progress or the main 
entity task is in use.

 l File checking occurs upon clicking the Proceed button. The change process can be 
performed only if tasks associated with the Accounts table are not in use and all data 
entry in progress has been posted.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Improved Audit Tracking

Data tracked and printed on the audit trail has been expanded for vendors, customers, 
employees, and items. This enhancement provides improved security compliance in the 
Accounts Payable, Accounts Receivable, Payroll, and Inventory Management modules, 
and includes the following changes:

Note: Improved audit tracking for the Payroll module is available only if Sage 100 
Payroll 2.24.1 is installed on Sage 100 2024.

 l Changes, deletions, and additions are now tracked for all data related to the main 
entity.  

 l A Purge button has been added to the audit report for each module, providing access 
to the new Purge Audit Report utility. You can also access the utility on the Utilities 
menu.

 l Task security is now used in Role Maintenance to determine access to the 
Purge Audit Report utility. Previously, security options determined access 
to the purge audit feature.

 l In the Payroll module, a Purge button has also been added to the Pay Rate 
Change Report that tracks employee pay rate changes.

 l A new Audit Viewer selection has been added to the More button in Vendor 
Maintenance, Customer Maintenance, Employee Maintenance, and Item 
Maintenance. This selection is available if the user has permissions to the audit 
report for the module in Role Maintenance.

 l In module options tasks in which you can specify changes to track for audit history, 
the default setting is now All when a new company is set up. Previously, the default 
was None.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 
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Changes in Version 2024

Print Audit Reports Anytime

Audit reports in the Accounts Payable, Accounts Receivable, Payroll, and Inventory 
Management modules can now be printed when the main entity is in use.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

ALE Lookups

The search value will no longer be cleared when the operand is changed.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Accounts Payable

The following changes were made in the Accounts Payable module.

Vendor Date Established

On the Statistics tab in Vendor Maintenance and Vendor Inquiry, the Date Established 
field has been added to show the system date the vendor was created on. You can edit 
this field with the appropriate security setup.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

1099 Form fields for Vendor

On the Vendor Maintenance Additional tab, the following changes have been made for 
1099 Form fields:

 l The W-9 Form on File check box has been added, enabling you to track W-9 Forms 
for a vendor.

 l You can now retain the taxpayer ID/Social Security number for non-1099 vendors. If 
Business or Individual is selected at the Vendor Type field, select the new option 
"None" at the Default Form field, and then enter the taxpayer ID number or Social 
Security number for the non-1099 vendor.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.
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Inventory Management

The following changes were made in the Inventory Management module.

Delete Warehouses and Change Warehouses Utilities

Two new tasks, Delete Warehouses and Change Warehouses, have been added to the 
Inventory Management Utilities menu. Designed as separate tasks, these utilities feature 
task security and the following functionality: 

 l Use Delete Warehouses to delete existing warehouse codes from your company 
data files. Deleting warehouses is necessary when virtual warehouses for scrap, 
returns, and multi-bin are no longer needed, or when a physical warehouse location 
closes.

 l Use Change Warehouses to renumber or merge  existing warehouse codes in your 
company data files.

Both utilities feature the flexibility to access and enter information when data entry is in 
progress or the main entity task is in use. File checking occurs upon clicking the Proceed 
button.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Switch Views in Lot/Serial Inquiry

The Switch View button has been added in the Lot/Serial Inquiry window. Click this button 
to switch the view of columns displayed in the Lot/Serial Inquiry list box. The last view 
selected persists by user.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.
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Changes in Version 2024

Inventory Requirements Planning

The following change was made in the Inventory Requirements Planning module.

Regenerate IRP Data

Important! If you're upgrading from Sage 100 2023.2 or earlier, you must 
regenerate your IRP data file to apply the latest schema changes and fixes. 
Improvements have been made to correctly link components back to parent items, 
particularly when the same subassembly appears on a bill of material multiple 
times.

Library Master

The following changes were made in the Library Master module.

Restricted Mode for Administrator Tasks

A new option  to turn on Restricted mode has been added in the Administrative Tools 
screen, allowing you to limit the users that can log in to Sage 100 when Administrative 
tasks (such as testing modifications or adding user-defined fields) are performed. 

You determine which users can log in with the new Role Maintenance security option, 
Allow Access During Restricted Mode. Turning on Restricted mode will not force users 
currently logged in (without rights for Restricted mode) out of Sage 100. Instead when 
launching a new task, a message appears telling them to log out.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Email Notification for Task Scheduler Jobs

In Task Scheduler, the Job Status Notification field has been added. You can send email 
notifications when jobs succeed or fail.

Option to Process All Tasks

In Task Scheduler, the Process All Tasks check box has been added. This option 
provides you with the flexibility to process all tasks defined on the Tasks tab, even if one 
or more tasks fail.
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Field Order Changed in User Maintenance and User Settings

The  fields on the User Maintenance Preferences tab and in User Settings have been 
reorganized into groups of similar options.

Auto-Complete Search Index Automatically Updated

The Enable Update Search Index check box has been added on the Preferences tab in 
System Configuration. Select this check box to automatically update the auto-complete 
search index in the ../MAS90/MAS_System folder when changes are made to customer, 
employee, vendor, general ledger account, or item records. 

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Paperless Office

The following changes were made in the Paperless Office module.

Report Setting in Report Viewer and Period End Report Viewer

The Report Setting used to print a report or period-end report now displays in the viewer 
task, so you can easily identify reports without having to open individual PDFs.

Electronic Delivery Message Maintenance

A new [ReportSetting] token has been added as a merge field in Electronic Delivery 
Message Maintenance, allowing you to include the Report Setting used to print the report 
to PDF in the subject line and body of an email.

Option to Display PDF After Printing Report

The Display PDF After Printing check box has been added in the Paperless Office 
Selection window. 

View Detail in Results of Electronic Delivery

A Detail button has been added in the Results of Electronic Delivery window. Click it to 
view details about documents sent to customers and vendors, including the date and time 
the document was submitted and the status.
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Changes in Version 2024

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Improvements in Error During Electronic Delivery

You can now resize the Error During Electronic Delivery window to view all information. 
Also, the Copy Error Status to Clipboard button has been added to provide a one-click 
copy of Error Status text to your computer clipboard.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Option to Ignore All Errors in Setup

The Ignore All Errors check box has been added in the Form Maintenance window, 
allowing you to set the default for this option in Error During Electronic Delivery. Select 
this check box to suppress the Error During Electronic Delivery window from 
automatically displaying so that form printing tasks no longer have to be monitored for 
errors.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Improvement in Viewer Tasks

In viewer tasks, the log record you've selected in the list box now persists after clicking a 
button on the side bar.

Relink PDF Documents Utility

The Relink PDF Documents utility has been added to the Utilities menu available from the 
Run Program window. In the Sage 100 Desktop, select File > Run. In the Run Program 
window, enter *utl at the Program field to open the Utilities menu.

Use this utility to update the PDF location reference in the Paperless Office log records 
for PDFs that were moved to a new server or folder using a method other than the Move 
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button in viewer tasks. This provides a faster way to relink the Paperless Office log 
records than the Link Maintenance utility.

Production Management

The following changes were made in the Production Management module.

Activity Code List

An Activity Code List button has been added next to the Activity Code field in Activity 
Code Maintenance. Click this button to view a list of all activity codes.

Data Conversion for Earlier Version of Production Management

The Production Management module code has changed from JT to PM. When you 
convert Production Management data from an earlier version of Sage 100, the converted 
company data files are changed to use the PM prefix. 

Important! If you're upgrading from the standalone version of Production 
Management that was previously available, you must be on version 2021.x of the 
standalone version before upgrading to the Production Management module that 
is part of Sage 100 2024.

Include Materials From Option

The Include Materials From field has been added in Cost Roll-Up Register, enabling you 
to determine if materials from the bill, work ticket template, or both bill and template are 
included when calculating the cost of the bill.
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Changes in Version 2024

Purchase Order

The following changes were made in the Purchase Order module.

Quick Close of Partially Received Purchase Orders

The Clear Back Order upon Accept check box has been added on the Lines tab in 
Receipt of Goods Entry, enabling you to easily close a partially received purchase order. 
Also, the Apply Purchase Orders button has been added next to the new check box, 
providing you with the flexibility to close any partially received purchase orders that have 
been applied to the primary order. 

This feature is available based on the new security option in Role Maintenance, Allow 
User to Clear Back-Ordered Quantity in Receipt of Goods Entry.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Received Status for Purchase Orders

A new order status of Received has been added. When purchase orders have been 
received but not invoiced, the order will now have a status of Received instead of Back 
Order to correctly reflect the state of the order. 

You can print orders and reports based on the Received status for the following:

 l Purchase Order Printing

 l Open Purchase Order Report

 l Open Orders by Item Report

 l Open Orders by Job Report

 l Purchase Order Recap

 l Open Orders by Work Ticket

 l Purchases Clearing in Open PO Format

 l Open Purchase Order Work Ticket Report (Production Management report)

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Return Merchandise Authorization

The following change was made in the Return Merchandise Authorization module.

View Applied Sales Orders

If multiple sales orders have been applied to an invoice, you can now view the sales order 
number and related customer purchase order number in the following:

 l In RMA Item Selection, the Sales Order No. and Customer PO columns have been 
added to the list box.

 l In the Invoice List lookup (accessed by clicking the Lookup button in the Invoice No. 
field on the RMA Entry or RMA Receipts Entry Lines tab), "Multiple" appears in the 
Sales Order No. and Customer PO columns when more than one order has been 
applied to the invoice. Previously, only the primary sales order and customer 
PO were displayed.

 l In the Invoice Lines List lookup (accessed by clicking the Lookup button in the Item 
Code field on the RMA Entry or RMA Receipts Entry Lines tab), the Sales Order No. 
and Customer PO columns have been added.

Sales Order

The following changes were made in the Sales Order module.

Option to Print Forms for Generated Back Orders

The Print Forms for Generated Back Orders field has been added on the Forms tab in 
Sales Order Options, enabling you to automatically reset the Print Order check box and 
Print Pick Sheets check box in Sales Order Entry for back orders created during the Sales 
Journal Update. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Display Ordered Quantity in Red

On the User Maintenance Preferences tab, an option has been added to display the 
ordered quantity in red text on the Lines tab in Sales Order Entry and S/O Invoice Entry 
when the quantity exceeds a specific value. In the S/O Ordered Qty in Red When field, 
you can select to display the ordered quantity in red text when it exceeds available 
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Changes in Version 2024

quantity, when it exceeds quantity on hand, or when the available quantity is lower than 
the reorder point.
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Changes in Version 2023

This chapter describes the enhancements added in Sage 100 version 2023 and 
subsequent updates. Changes to the Sage 100 Desktop are listed first, followed by global 
changes, module-specific changes, and then a list of features that are now available for 
the non-subscription version of Sage 100.

Depending on your purchase agreement, some features described here may not be 
available in your product. 

Changes in Version 2023.5
The following enhancements were added in update 5 for Sage 100 2023.

Production Management

The following changes were made in the Production Management module.

Option to Relieve WIP on Last Completion

On the Production Management Options Entry tab, the Relieve WIP on Last Completion 
check box has been added. Select it to post remaining WIP to the inventory account when 
the work ticket is completed.

Sage Supply Chain Intelligence (SSCI) Integration – Available Fall 2025

Integrate Sage 100 with Sage Supply Chain Intelligence (formerly known as Anvyl) for 
powerful purchase order management.  SSCI bridges the gap between issuance of a 
purchase order and receipt of goods, providing a cloud-based way to collaborate with 
suppliers, consolidate shipments, create custom P/O workflows, and even create and edit 
purchase orders, and have the data flow back into Sage 100.

Use the Sage Supply Chain Intelligence Setup app to perform integration for Sage 100 
2025, 2024.2, and 2023.5.

For instructions, see Set Up Sage Supply Chain Intelligence (Anvyl) Integration in 
Sage 100 help.
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Changes in Version 2023.4

Changes in Version 2023.4
The following enhancements were added in update 4 for Sage 100 2023.

Accounts Payable

The following change was made in the Accounts Payable module.

1099 Form Changes for Individuals

To support 1099 Form changes for individuals, the following fields have been added on 
the Vendor Maintenance Additional tab and print on the Vendor Listing:

 l (1099 Form) First Name             

 l (1099 Form) Middle Name             

 l (1099 Form) Last Name             

These fields are available only when Individual is selected in the Vendor Type field.

Inventory Requirements Planning

The following changes were made in the Inventory Requirements Planning module.

Explode Bill without Production Management Integration

You can now explode parent and component items on a multi-level bill even if Inventory 
Requirements Planning is not integrated with the Production Management module. The 
Bill of Materials module must be set up for the current company to explode items.

Consolidate Demands

Demands are now consolidated for the same item when creating a work ticket or 
purchase order to stock. This enhancement allows you to create one work ticket or 
purchase order for multiple demands on the same item, instead of creating a separate 
work ticket or purchase order for each demand. Demands for the same item are 
consolidated automatically if the item’s procurement type is Make to Stock or Buy to 
Stock.
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In addition, the following changes have been made:

 l In the Item Detail window, the default selection in the Make To field is now based on 
the item’s procurement type.             

 l In the Items to Produce/Items to Purchase window:                 

 l You can now increase the production/purchase quantity beyond the 
quantity recommended.                     

 l If an item has a price level set and you change the production/purchase 
quantity, the Unit Cost field is updated accordingly.                     

 l When creating a work ticket or purchase order to stock, IRP will use the 
earliest demand date as the date required.                     

Option to Explode Phantom Bills

The Include Phantom Bills check box has been added in Inventory Requirements 
Planning Options. You can select this check box to explode the components of the 
phantom bill onto the level of the bill where the phantom bill appears.

Library Master

The following change was made in the Library Master module.

Sage Connect Integration

You can integrate Sage 100 with Sage Connect, an application built on Sage Network 
platform. This integration enables a one-way push of data from a Sage 100 company to 
Sage Connect.

Use the Sage Network Setup app to perform integration. This application will be available 
shortly as a separate installer. Contact your Sage partner.

For instructions, see Set Up Sage Connect Integration in Sage 100 help.

When a Sage 100 company is integrated with Sage Connect, the Enable Sync for Sage 
Connect check box is selected by default on the Company Maintenance Payment tab.
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Changes in Version 2023.3

Production Management

The following change was made in the Production Management module.

View Quantity Remaining in Materials Where-Used Inquiry

A new Quantity Remaining column (displaying the quantity required minus the quantity 
issued) has been added in the Materials Where-Used Inquiry window.

In addition, if the selected item is the parent of a work ticket, the following changes have 
been made:

 l Description column displays "Parent Item Code" 

 l Step Number, Activity Code, and Work Center columns are blank 

 l Due Date column             displays the work ticket production due date

Sales Order

The following change was made in the Sales Order module.

Apply General Ledger Account to Credit Memo

When creating a sales order credit memo and recalling the invoice from history, the new 
Apply to Credit Memo window appears. You can select to apply either the general ledger 
sales account from history or the sales return account to the credit memo.

Changes in Version 2023.3
The following enhancement was added in update 3 for Sage 100 2023.

Inventory Requirements Planning

The following change was made in the Inventory Requirements Planning module.

Regenerate IRP Data

Important! If you're upgrading from Sage 100 2023.2 or earlier, you must 
regenerate your IRP data file to apply the latest schema changes and fixes. 
Improvements have been made to correctly link components back to parent items, 
particularly when the same subassembly appears on a bill of material multiple 
times.
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Production Management

The following change was made in the Production Management module.

Include Materials From Option

The Include Materials From field has been added in Cost Roll-Up Register, enabling you 
to determine if materials from the bill, work ticket template, or both bill and template are 
included  when calculating the cost of the bill.

Changes in Version 2023.2
The following enhancements were added in update 2 for Sage 100 2023.

Development Studio

The following change was made in Development Studio.

Primary and Secondary Buttons

With the implementation of Themes in Sage 100, each button on an application screen is 
categorized as either a primary button or a secondary button. 

A new keyword and value “IgnoreTheme=YES” can be placed in the Tag field to override 
the attributes assigned to a control by the current active theme. When this keyword and 
value are found, the attributes from the definition of the control in the library file will be 
used instead.

Production Management

The following changes were made in the Production Management module.

Option to Summarize Material Lines in Work Ticket Entry

The Summarize Material Lines by Step and Item check box has been added in 
Production Management Options, allowing you to summarize material lines with the 
same item number, step number, and scrap percentage on one line in Work Ticket Entry.

Also, the Combine Material Line Item Comments check box has been added. You can 
select this check box to combine all unique comments from summarized material lines at 
the Comment field on the Work Ticket Entry Materials tab.
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Changes in Version 2023.1

Edit Start and End Times in Labor Entry

You can now edit start and end times in Labor Entry if Only capture, no edit allowed is 
selected at the Capture Start/End Times field in Production Management Options and the 
Role Maintenance security option Allow Full Access to Labor Entry is selected.

Changes in Version 2023.1
The following enhancements were added in update 1 for Sage 100 2023.

Global Changes

The following enhancements were added throughout multiple modules.

Next Lot Number button 

The Next Lot Number button has been added in Lot/Serial Number Distribution. Click the 
Next Lot Number button to use the next automatically incremented lot number entered at 
the Next Lot/Serial Number field in Item Maintenance. This enhancement is carried 
throughout the following modules:

 l Bill of Materials

 l Inventory Management

 l Purchase Order

 l Production Management

 l Return Merchandise Authorization

 l Sales Order

Work Ticket to Purchase Order Post-Conversion Link Utility

The Work Ticket to Purchase Order Post-Conversion Link Utility has been added to the 
Sage 100 Utilities menu available from the Run Program window. Use this utility to 
update existing work order links on open purchase order detail lines and match the links 
to their corresponding open work tickets.

The utility analyzes work order data and provides recommended actions. After running 
the utility, results are recorded in the System Activity Log.
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Sage 100 Desktop Changes

The following changes were made to the Sage 100 Desktop.

Information Center Page

A new Sage 100 Information Center page has been added, providing dynamic content 
and announcements for you.

Recent Tab Added to the Ribbon

The Recent tab has been added to the ribbon, showing tasks that have been accessed 
from the File menu, Home tab, Web Content tab, and Modules tab. On the View tab, you 
can set how many recent items to show. You can also hide the Recent tab by right-
clicking the ribbon and clearing Show Recent in the Ribbon.

Expanded Tooltips

Expanded tooltips now show where tasks are located. For example, hovering over 
Company Maintenance displays the tooltip Located in the Library Master Main menu.

Active Tab on the Ribbon Persists

The last tab accessed on the ribbon persists after exiting Sage 100. For example, if the 
Favorites tab was the last tab used when you exited Sage 100, it will be the active tab the 
next time you log in.

Global Changes

The following changes are carried throughout multiple modules.

Installation Simplification

In version 2023, Sage 100 has been consolidated into a single product with three 
installation approaches. The option to install Sage 100 Standard, Sage 100 Advanced, 
and Sage 100 Premium has been removed. Instead, during installation you will have the 
option to select the architecture to use (Stand-Alone or LAN or Client/Server). If you 
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select the Client/Server architecture, you will be prompted to select the database to use 
(ProvideX or Microsoft SQL Server).

Also, the following installation changes have been made:

 l On the Sage 100 Integration Engine Service screen, a Skip button has been added. If 
you're not integrating Sage 100 with Sage CRM, you can click Skip to bypass 
configuring the Integration Engine.

 l On the Productivity Applications screen, the Configure Sage 100 Integration Engine 
option has been added.

Select Serial Numbers by Range

The Select Serial Numbers by Range button has been added in Lot/Serial Number 
Distribution. You can select serial numbers using a range instead of scrolling through a 
list to find the starting and ending serial numbers. This enhancement is carried 
throughout the following modules:

 l Bill of Materials

 l Inventory Management

 l Purchase Order

 l Production Management

 l Return Merchandise Authorization

 l Sales Order

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Default Years to Retain History

In module options tasks in which you can specify how many years to save history, the 
default setting is now nine years. The minimum required number of years to retain history 
has not changed, and this update will not affect your existing settings.

Activity Log Updates 

When the Accounts Payable Remove Inactive Vendors utility and the Accounts 
Receivable Remove Inactive Customers utility are run, the Activity Log is updated with a 
list of inactive vendors and customers removed.
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Image Viewer

The Image Viewer in Item Maintenance and Miscellaneous Item Maintenance has been 
updated so that you can delete an image when you have the appropriate security set up. 
The delete feature is available based on the new security option in Role Maintenance, 
Allow User to Delete Image Files with the Image Viewer.

iShip Replacement

The iShip tracking tool has been replaced. In data entry tasks, when you click the 
Tracking button, the tracking ID will now be used to determine which carrier the package 
belongs to and you will be redirected to the appropriate site. The carriers handled 
automatically are USPS, UPS, FedEx, DHL, and OnTrac. If the package ID does not 
belong to one of these carriers, you will be redirected to a Google search with the 
package ID.

SAP Crystal Reports 2020

SAP Crystal Reports has been updated to version 2020. Crystal runtime components 
(SP30) are the same version as in Sage 300, Sage Fixed Assets, and Sage HRMS.

Accounts Payable

The following changes were made in the Accounts Payable module.

Masked 1099 Vendor Taxpayer ID/Social Security Number

The 1099 Vendor Taxpayer ID/Social Security Number is now masked in data entry tasks 
and will also print masked on the Vendor Listing, Vendor Listing with Balances, and 
Vendor Mailing Labels. Only users with the appropriate security setup can view this 
sensitive information and access the option Print Unmasked Taxpayer ID/SSN check 
box. 

The check box is available based on the new security option in Role Maintenance, Allow 
Viewing, Printing, and Editing of Highly Sensitive 1099 Information.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 
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Masked ACH Bank Account and Routing Numbers

The vendor electronic payment bank account and routing numbers are now masked in 
data entry tasks and will also print masked on the Vendor Listing. The routing transit 
numbers are also masked in ACH Maintenance. Only users with the appropriate security 
setup can view this sensitive information and access the option Print Unmasked 
ACH Information check box in Vendor Listing.  

The check box is available based on the new security option in Role Maintenance, Allow 
Viewing, Printing, and Editing of Highly Sensitive ACH Information.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Improvements in Invoice Payment Selection

The Include check box has been added in the Select Invoices for Payment window, 
enabling you to quickly select each invoice for payment. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Vendor Maintenance

On the Additional tab in Vendor Maintenance, the DBA Name field has been renamed the 
1099 Name field.

Development Studio

The following change was made in Development Studio.

Grid Definition Maintenance

When defining grid columns in Grid Definition Maintenance, you can now exclude 
columns from being exported to Excel by entering EXCEL=No at the Tag field.
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Inventory Management

The following changes were made in the Inventory Management module.

Option to Hide Inactive Warehouses

The Display Quantities for Inactive Warehouses check box has been added on the 
Additional tab in Inventory Management Options to allow you to hide inactive 
warehouses. 

A Show/Hide Inactive Warehouses button has been added in the following locations:

 l Main tab on Item Maintenance and Item Inquiry

 l Quantity tab on Item Maintenance and Item Inquiry

 l Reorder Maintenance

 l Item Quantity Inquiry

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Show/Hide Zero Quantities for Lot/Serial Items

The Display Zero Quantities for Lot/Serial Items in Cost Detail check box has been added 
on the Additional tab in Inventory Management Options. You can select this check box to 
initially display lot/serial items with zero quantities on the Cost Detail tab in Item 
Maintenance and Item Inquiry.

A Show/Hide Zero Quantity Lot/Serial Rows button has also been added on the Cost 
Detail tab in Item Maintenance and Item Inquiry.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Remove Inactive Items Utility

The Remove Inactive Items task has been added to the Inventory Management Utilities 
menu. After running the utility,  the Activity log is updated with a list of inactive items 
removed.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Inventory Requirements Planning

The following changes were made in the Inventory Requirements Planning module.

Inventory Requirements Planning Options

The following options have been added:

 l Pull In Work Ticket check box

 l Push Out Work Ticket check box

 l Round Integer Unit of Measure check box

 l Base Effective Date on Release Date of Demand check box

 l Calculate Build Time for Make Items Using field

Inventory Requirements Planning

The following fields have been added, providing  more options for the IRP generation 
process:

 l Effective Date field

 l Include Sales Quotes check box

 l Explode Make Action field

 l Create Work Ticket with Materials From field

 l Default Lead Time (Days) field

 l Default Build Time (Days) field

 l Advanced Arrival Allowance (Days) field

If the Inventory Requirements Planning module is not integrated with Production 
Management or Purchase Order, you can now click Production or Purchase to view a 
report of inventory demand. 

Expanded Summary and Detail Information

In Items to Produce and Items to Purchase, you now have the option to view summary 
information for items with pending actions.

Item Detail now displays the recommended action, action date, and required date to meet 
demand for each detail record.
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Schedule IRP Generation with Task Scheduler

You can now schedule the IRP generation process with Library Master Task Scheduler. 
This provides you with the flexibility to run the generation after business hours or 
overnight.

Inventory Requirements Planning Inquiry

Inventory Requirements Planning Inquiry has been added to the Inquiries menu. Use this 
task to view purchase or production information for an item based on the last completed 
IRP generation process. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Reports Menu

A Reports menu has been added, along with the following reports: Action By Vendor 
Report, Inventory Requirements Planning Report, Projected Demands Report, and Work 
Ticket and Sales Order Demand.

Action By Vendor Report

The Action By Vendor Report includes the ability to select by warehouse code and then 
print the warehouse code on the report. The standard unit of measure also prints on the 
report.

Projected Demands Report

The following changes have been made:

 l A fiscal/calendar year option has been added, enabling you to print the report for a 
selected year.

 l When the Consolidate Customers check box is selected if item projected demands 
are included in the consolidation, the Qty Sold column on the report displays the 
item's total quantity sold. If item projected demands are not included in the 
consolidation, the Qty Sold column displays the sum of the consolidated customer's 
quantity sold.

Library Master

The following changes were made in the Library Master module.
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Option to Suppress Expired Messages

The Suppress Expired Messages check box has been added in User Maintenance, 
enabling you to suppress displaying expired license messages by user.

Retain Last Path in Data File Display and Maintenance

When you click the Folder button in Data File Display and Maintenance, the Select File 
window now shows the folder location of the last file viewed.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Paperless Office

The following change was made in the Paperless Office module.

Updated Printer Driver

The Amyuni PDF Converter, the virtual printer driver used to create PDF documents, has 
been updated to version 6.5.1.7.

Production Management

The following changes were made in the Production Management module.

Enhanced Scheduling 

Enhanced scheduling features have been added throughout the Production Management 
module to provide you with more flexibility and functionality.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Production Management Options Schedule tab

In Production Management Options, a Schedule tab has been added with the following 
new options:

 l Select the Enable Enhanced Scheduling check box to use the forward or backward 
scheduling method to schedule work tickets. Enhanced scheduling is the functionality 
that was in the Work Order module. 
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If you  prefer to use basic scheduling, clear the Enable Enhanced Scheduling check 
box. Basic scheduling is the functionality that was in previous releases of Production 
Management. 

 l The Maximum Number of Months to Schedule field has been added.

 l You can define default work center closures that will be used for all work centers.

Activity Code Maintenance

The following enhanced scheduling fields have been added in Activity Code 
Maintenance:

 l Calculation Method

 l Ignore Queue Time 

Work Ticket Template Maintenance

The following enhanced scheduling fields have been added in Work Ticket Template 
Maintenance:

 l Calculation Method

 l Hours Per Activity / Activities per Hour / Number of Hours

 l Overlap Percent

 l Ignore Queue Time 

Work Center Maintenance

The following changes have been made in Work Center Maintenance:

 l Enhanced scheduling fields have been added: Queue Time (Hours), Efficiency 
Percent, Number of Workers or Machines, and Minimum Scheduling Time Period 
(Minutes)

 l You can set up the number of hours a work center is available for operation each day 
of the week at the Available Hours fields. 

 l Closures for specific work centers can be set up.

 l Click Copy From to copy information from an existing work center when creating a 
new one.

 l Click Apply to copy available hours and closures from an existing work center to one 
or more other work centers.

 l The Memo button is available to view, create, and maintain memos.
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Work Ticket Entry

In Work Ticket Entry, the following changes have been made for enhanced scheduling:

 l On the Schedule tab, the Schedule button has been added to access the new 
Schedule Work Ticket window.

 l In the Schedule Work Ticket window, you can select the forward or backward 
scheduling method to determine when each step of a work ticket is started and how 
long each step takes to complete.

 l Use forward scheduling to enter the start date of a work ticket, and the 
scheduling process will calculate the due date for the work ticket. 

 l Use backward scheduling to enter the due date for a work ticket, and  the 
scheduling process will calculate when the work ticket will be released to 
the work center, in order for the work ticket to be completed on time.

 l On the Schedule tab, the Manually Schedule check box has been added to give you 
the option to manually enter the production start date and production due date on the 
Schedule tab and the Steps tab. 

 l On the Steps tab, the following fields have been added to the secondary grid: Ignore 
Q Time, Overlap Percent, Prod Queue Date, Sched Method, Scheduling Hrs, Scaling 
Method, Scaling Factor, and Extended Time.

Work Ticket History Inquiry

You can now view detailed step information on the Work Ticket History Inquiry Schedule 
tab by selecting a step in the list box and clicking the Additional Information button. 

Work Center Capacity Inquiry

Work Center Capacity Inquiry has been added to the Inquiries menu. Use this task to 
review commitments against work centers in three formats: daily, weekly, and detail.

Scheduled Capacity Report

Scheduled Capacity Report has been added to the Reports menu. Use this report to print 
commitments against work centers in three formats: daily, weekly, and detail.

Material Issue Workflow Improvements in Work Ticket Transaction Entry

In Work Ticket Transaction Entry when creating a materials transaction, you can now 
import available material lines with remaining quantity to issue in bulk to the Lines tab. 
This enhancement speeds data entry. 
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You have the option to select all available material lines, or you can use the new Material 
Selection window to select specific material lines to issue. The Material Selection button 
has been added on the Work Ticket Transaction Entry Lines tab to open the Material 
Selection window.

Lot/Serial History

A Lot/Serial History button has been added in the following locations:

 l Materials tab on Work Ticket History Inquiry

 l Inquiry tab on Work Ticket History Inquiry for the Materials and Completions views

 l Inquiry tab on Work Ticket Entry for the Materials and Completions views

Selections for Purging Work Ticket History 

In Purge Work Ticket History, selections have been added to enable you to purge by work 
ticket number, release date, and close date.

Work Ticket Template Maintenance

You can now add a scrap percentage for each item on the Materials tab in Work Ticket 
Template Maintenance.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Labor Entry 

In Labor Entry if you're capturing punch in/out time for an employee and the Payroll 
module is integrated with Production Management,  you can now select a department 
worked in at the Dept No. field that is different than the employee's assigned department 
in Payroll Employee Maintenance. 

When you update the Payroll Check Register, the department worked in and its general 
ledger accounts will be used instead of the employee's assigned department.

Add Activity Codes and Work Centers On the Fly

You can add on-the-fly activity codes and work centers in Work Ticket Class 
Maintenance, Work Ticket Template Maintenance, and Work Ticket Entry with the 
appropriate security setup in Library Master Role Maintenance.
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Option to Relieve WIP Based on Percent Complete

The Relieve WIP Based on Percent Complete check box has been added on the Work 
Ticket Entry Header tab and the Work Ticket Class Maintenance Main tab. Select this 
check box to use the prorated cost for WIP when entering a partial completion in Work 
Ticket Transaction Entry.

Explode Bill Subassemblies

In Work Ticket Entry, the Explode Subassemblies check box has been replaced by the 
Explode Bill Subassemblies field. When the Bill of Materials module is integrated with 
Production Management and enhanced scheduling is used, selecting Yes at the Explode 
Bill Subassemblies field  now creates work ticket steps for each subassembly on a 
multilevel bill. This  functionality was in the Work Order module and has now been added 
to Production Management.

Explode Template Subassemblies

In Work Ticket Entry, the Explode Template Subassemblies field has been added, 
providing the ability to explode subassemblies defined on a work ticket template when 
enhanced scheduling is used.

Recalculate Material Budgets

On the Materials tab in Work Ticket Entry, the Recalculate Material Budgets button has 
been added, enabling you to recalculate budgets for the step assigned to the selected 
material line. All the material detail lines assigned to the same step will be recalculated. 
Click the arrow next to the button, and then select Recalculate Material Budgets All Steps 
to recalculate budgets for all material lines and steps in the grid. 

Work Ticket Entry Copy Feature

In the Work Ticket Entry Copy From window, the Production Start Date field has been 
added to simplify the process of copying a manually scheduled work ticket.

During the copy process, the system will calculate the number of days between the start 
date entered here and the source work ticket start date. The difference between the dates 
will be used to automatically adjust all of the scheduling dates in the source work ticket 
steps as they are copied.
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Create Work Ticket with Materials From Option

A new option has been added in Production Management Options, enabling you to create 
a work ticket using the materials from the bill, work ticket template, both the bill and 
template, or you can select to be prompted with a message in Work Ticket Entry asking 
which materials to use.

Data Conversion for Earlier Version of Production Management

The Production Management module code has changed from JT to PM. When you 
convert Production Management data from an earlier version of Sage 100, the converted 
company data files are changed to use the PM prefix. 

Important! If you're upgrading from the standalone version of Production 
Management that was previously available, you must be on version 2021.x of the 
standalone version before upgrading to the Production Management module that 
is part of Sage 100 2023.

Features No Longer Subscription Only

The following features were initially available only if you purchased  Sage 100 through a 
subscription plan. They are now available to all users, regardless of whether  Sage 100 
was purchased as a subscription or perpetual license.

 l Journal and Register Viewer: Access to the Paperless Office Journal and Register 
Viewer is available from various locations.

 l Task Scheduler: You can email reports printed from a Task Scheduler job.

 l Data File Display and Maintenance Enhancements: You can now select a subset 
of fields from the table to be displayed. When selected, you can define filters and 
apply them to one or more of the fields to limit the rows displayed in the Key Scan 
screen. The status text on the Key Scan screen will indicate when a filter is active.

 l Map Service: An option has been added on the Preferences tab in User 
Maintenance allowing you to select which map service to use when clicking the Map 
button in Sage 100 tasks. Use Google Maps, Bing Maps, or MapQuest.
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Changes in Version 2022

This chapter describes the enhancements added in Sage 100 version 2022 and 
subsequent updates. Changes to the Sage 100 Desktop are listed first, followed by global 
changes,  module-specific changes, any updates to Microsoft 365 integration, retired 
features, and then a list of features that are now available for the non-subscription version 
of Sage 100.

Depending on your purchase agreement, some features described here may not be 
available in your product.

Changes in Version 2022.6
Version 2022.6 contains program fixes for Sage 100. For more information, see the 
release notes.

Changes in Version 2022.5
The following enhancement was added in update 5 for Sage 100 2022.

Production Management

Option to Summarize Material Lines in Work Ticket Entry

The Summarize Material Lines by Step and Item check box has been added in 
Production Management Options, allowing you to summarize material lines with the 
same item number, step number, and scrap percentage on one line in Work Ticket Entry.

Also, the Combine Material Line Item Comments check box has been added. You can 
select this check box to combine all unique comments from summarized material lines at 
the Comment field on the Work Ticket Entry Materials tab.
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Changes in Version 2022.4

Changes in Version 2022.4
The following enhancements were added in update 4 for Sage 100 2022.

Global Changes

The following enhancements were added throughout multiple modules.

Next Lot Number button 

The Next Lot Number button has been added in Lot/Serial Number Distribution. Click the 
Next Lot Number button to use the next automatically incremented lot number entered at 
the Next Lot/Serial Number field in Item Maintenance. This enhancement is carried 
throughout the following modules:

 l Bill of Materials

 l Inventory Management

 l Purchase Order

 l Production Management

 l Return Merchandise Authorization

 l Sales Order

Work Ticket to Purchase Order Post-Conversion Link Utility

The Work Ticket to Purchase Order Post-Conversion Link Utility has been added to the 
Sage 100 Utilities menu available from the Run Program window. Use this utility to 
update existing work order links on open purchase order detail lines and match the links 
to their corresponding open work tickets.

The utility analyzes work order data and provides recommended actions. After running 
the utility, results are recorded in the System Activity Log.

Changes in Version 2022.3
The following enhancements were added in update 3 for Sage 100 2022.

Accounts Payable

The following changes were made in the Accounts Payable module.
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Form 1099 Tax Reporting Version

Form 1099 Tax Reporting has been updated to version 2.98.

DBA Name for 1099 Forms

There has been a functionality change of where the 1099 DBA Name field prints on the 
1099 Form.

If there is a name entered in the DBA Name field on the Additional tab in Vendor 
Maintenance, it will now print on Line 1 of the Recipient Name box of the 1099 Form and 
the Vendor Name will print on Line 2 of the Recipient Name box of the 1099 Form.

Updates for 1099 Form Tax Reporting

The following options have been added to support Form 1099 printing for tax year 2022:

 l For the 1099-DIV Form:

 l Box 11 is now FATCA filing requirement check box.

 l Subsequently, old box numbers 11 through 15 have been renumbered to 
new box numbers 12 through 16, respectively. The new boxes are as 
follows:

 l Box 12 - Exempt-interest dividends

 l Box 13 - Specified private activity bond interest dividends

 l Box 14 - State

 l Box 15 - State Identification No.

 l Box 16 - State Tax Withheld

 l For the 1099-MISC Form:

 l Box 13 is now FATCA filing requirement check box

 l Subsequently, old box numbers 13 through 17 have been renumbered to 
new box numbers 14 through 18, respectively. The new boxes are as 
follows:

 l Box 14 - Excess golden parachute payments 

 l Box 15 - Nonqualified deferred compensation

 l Box 16 - State tax withheld
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 l Box 17 - State/Payer's state no.

 l Box 18 - State Income

Production Management

Work Ticket Entry Copy From

In the Work Ticket Entry Copy From window, the Production Start Date field has been 
added to simplify the process of copying a work ticket.

During the copy process, the system will calculate the number of days between the start 
date entered here and the source work ticket start date. The difference between the dates 
will be used to automatically adjust all of the scheduling dates in the source work ticket 
steps as they are copied.

Changes in Version 2022.2
The following enhancement was added in update 2 for Sage 100 2022.

Accounts Receivable

Option to Print Zero Balance Customers with No Invoices 

The Customers with No Invoices check box has been added to Statement Printing. You 
can select this check box to print statements for zero balance customers that do not have 
any invoice detail printing on the statement.

Changes in Version 2022.1
The following enhancements were added in update 1 for Sage 100 2022. 

Inventory Requirements Planning

The Inventory Requirements Planning (IRP) module is now compatible with the version of 
Production Management  that was released in Sage 100 2022. The updated version of 
Inventory Requirements Planning is automatically installed with update 1 if you have the 
Production Management module installed. Inventory Requirements Planning is 
automatically registered if Production Management is registered, so you do not need a 
new license  key. 
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Data Conversion and Material Requirements Planning

If you already have the Material Requirements Planning (MRP) module installed, 
Inventory Requirements Planning is still  installed, but you cannot have both modules 
activated for the same company at the same time. Activating IRP for a company 
deactivates MRP for that company. 

When you open  Inventory Requirements Planning Options,  you will be asked if you want 
to convert your MRP data to IRP data. If you convert your MRP data, your MRP data files 
are deleted after the conversion process is complete. You can choose not to convert your 
MRP data and proceed with the IRP setup, and this will remove your MRP data. 

Maintain Projected Demands

Maintain Projected Demands has been added to the Main menu. You can use Maintain 
Projected Demands to manually enter demand information before generating the IRP 
data file that's used to show demand and create work tickets and purchase orders. 

Library Master

The following enhancements were added in the Library Master module.

Data File Display and Maintenance Updates

The following changes have been made in Data File Display and Maintenance:

 l Two new options have been added to the Operator list in the Filter window:

 l Contains CRLF: Use this operator to find records that contain carriage 
return/line feed characters. 

 l Non Printable: Use this operator to find records that contain non-printable 
characters.

 l In the Select Fields window, you can select up to 25 fields to display in columns in the 
Key Scan window.

OAuth Authentication Method for SMTP Mail Server

In Company Maintenance on the E-mail tab, you can now select the OAuth authentication 
method for your SMTP mail server even if you purchased Sage 100 through a perpetual 
license. Previously the OAuth authentication method was available only if you purchased 
Sage 100 through a subscription plan. 
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Changes in Version 2022
The following enhancements were added in Sage 100 2022. 

Sage 100 Desktop Changes

The following changes were made to the Sage 100 Desktop. 

Add Public Favorites

You can add tasks and other items to the new Public Favorites group. These items are 
listed on the Favorites panel when you click Public Favorites, and they are available to all 
Sage 100 users. For Sage 100 tasks, access is based on the users' security setup. For 
instructions, see Add Items to the Favorites Content Group in the Sage 100 help. 

Global Changes

The following changes are carried throughout multiple modules.

Exclude Inactive Items From Lookups

A Display Inactive Items check box has been added to the ALE Lookups section on the 
Preferences tab in Company Maintenance. Clear this check box to exclude items from 
Lookups if the Inactive check box  in Item Maintenance is selected for the item. 

For more information, see the field help for the Display Inactive Items check box. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Save Date Selections for Reports

When creating or modifying a report setting, you can specify whether you want to save 
the dates entered in the Selections grid. To save the dates, select the Save Date 
Selections check box that has been added to the Save As Report Setting window. Clear 
the check box to omit the dates from the report setting. The check box is selected by 
default. 
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We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Default Years to Retain History

In module options tasks in which you can specify how many years to save history, the 
default setting is now five years. The minimum required number of years to retain history 
has not changed, and this update will not affect your existing settings. 

Accounts Receivable

The following changes were made in the Accounts Receivable module. 

Pay Cycle Option

A new check box, Allow employees with other pay cycles for bonus and commissions, 
has been added to the Pay Cycle window that opens when you're updating the 
Commission Edit Register. 

Select this check box when you're processing a pay run that falls outside of employees' 
regular pay cycle assigned in Employee Maintenance. For example, select the check 
box if employees are typically paid weekly, but you're paying a monthly bonus. 

Note: This check box is available only if you're using Sage 100 Payroll version 
2.22 or later. 

Search for Quotes

A Quotes check box has been added to the Search for Open Orders window accessed 
from the S/Os tab in Customer Maintenance. Select this check box to find quotes for the 
current customer. 

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Business Insights

The following views have been added to the Business Insights Explorer menu and the 
Production Management Explore menu. The views that are indented underneath each 
primary view are the secondary views available in the Explore navigation pane when you 
access the primary view. 

Sage 100 Customer Upgrade Guide 60

Changes in Version 2022

https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP/


Changes in Version 2022

 l History Work Tickets View

 l History Work Ticket Steps

 l Work Ticket Line Items

 l Purchase Order Line Items PM

 l Open Work Tickets View

 l Open Work Ticket Steps

 l Work Ticket Line Items

 l Purchase Order Line Items PM

 l Work Ticket Labor View

 l Open Work Tickets

 l Open Work Ticket Steps

Inventory Management

The following changes were made in the Inventory Management module.

More Options When Uploading Images

When you're uploading images in Item Maintenance, you can now use the following 
image types:

 l JPEG

 l PNG

 l TIFF

You can still use the types that were previously available as well (JPG, GIF, and BMP). 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Order Type Options on Search for Sales Orders Window

When searching for orders using the Search for Sales Orders window, you can select 
check boxes corresponding to the order types to include in your search results. All sales 
order types are now available, including quotes, master orders, and repeating orders. 

Also a Quoted field has been added to the bottom of the tab. The field displays the item's 
quantity used in Sales Order quotes. 
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The Search for Sales Orders Window can be accessed from Item Maintenance and Item 
Inquiry. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Changes Related to Production Management

The following changes, which are related to the Production Management module, were 
made in Inventory Management. 

Note: If custom labels have been entered in the Terminology fields in Production 
Management Options, the custom text appears in place of the default 
terminology. 

Changes in Item Maintenance

The following changes  are applicable if the Production Management module is activated.

 l The options in the Procurement field on the Main tab are Make to Stock,  Buy to 
Stock, Buy to Order, and Subcontract.

 l An On WT column is included in the Quantities box on the Main tab and on the 
Quantity tab. The column shows the total quantity being produced for the parent item 
on work tickets with a status of Released. 

 l A Req for WT column is included in the Quantities box on the Main tab and on the 
Quantity tab. The column shows the total quantity being consumed for the raw 
material on work tickets that have a Released status. 

If the Include Open Work Ticket Materials as Inventory Demand check box in 
Production Management Options is selected, then open work tickets are also 
reflected in this column. 

 l On the Additional tab, the Template No. field appears instead of the Routing No. 
field.

 l On the Quantity tab, the following columns have been added:

 l On WT 

 l Req for WT
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Changes in Version 2022

 l On the Transactions tab, the following columns have been added: 

 l Work Ticket No.

 l Step No.

 l Work Ticket Description

 l On the Orders tab, the following have been added:

 l Work Ticket display option

 l Work Ticket No. column

 l Work Ticket Description column

 l Step No. column

Other Changes

 l The text on the Configure Quantity Available Calculation window and the summary 
window references work tickets instead of work orders if the Production Management 
module is installed. 

 l You can choose whether to include work ticket quantities in the quantity available 
calculation when you're running the Inventory Management Setup Wizard if the 
Production Management module is installed. 

 l The text on the Item Status window references work tickets instead of work orders if 
the Production Management module is installed. 

 l In Product Line Maintenance, if the Production Management module is activated, 
the options in the Procurement field are Make to Stock,  Buy to Stock, Buy to Order, 
Subcontract.

Production Management

The following changes were made in the Production Management module. 

Installing Production Management

The Production Management module is now part of the Sage 100 installation program. 
The module is no longer available as a separate installation. 

Setup Wizard

A new setup wizard has been added to guide you through setting up the module. 
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Production Management Options

The following changes were made in Production Management Options.

 l A Years to Retain Work Ticket History field has been added to the Main tab. 

 l A General Ledger check box has been added to the Integrate with section on the 
Main tab. 

 l A record is written to the Activity Log after Payroll data is synchronized with 
Production Management. 

 l The Dynamic Materials check box, which enables the feature, is now on the Entry 
tab. 

 l A User Defined tab has been added. This tab replaces the Miscellaneous Codes 
Maintenance task, which is no longer available. Use this tab to create generic code 
classes that are used to categorize the codes created in User Defined Info Codes 
Maintenance. 

Work Ticket Template Maintenance

The following changes were made in Work Ticket Template Maintenance.

 l When using the Copy From feature, you have the option to copy memos. 

 l On the Materials tab, the following buttons have been added: Alias Item and Item 
Quantity Inquiry

 l An Add Attachment button has been added to the Attachments tab.

Employee Maintenance

The following fields were added to the Employee Maintenance window: 

 l Telephone Ext

 l Telephone Type

 l E-mail Address

 l Pay Method

 l Autopay Hours

User Defined Info Codes Maintenance

User Defined Info Codes Maintenance has replaced Miscellaneous Codes Maintenance. 
Use this task to create codes that can then be applied to work ticket templates. You must 
first create code classes on the User Defined tab in Production Management Options. 
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Attachment Category Maintenance 

Attachment Category Maintenance has been added to the Setup menu. Use this task to 
maintain attachment category codes and descriptions.

Work Ticket Entry

The following changes were made in Work Ticket Entry. 

 l You can now create and maintain memos for work tickets and steps. 

 l The More button has been removed and an Attachments button has been added. 

 l A Labor Issue Method field with a drop-down list has been added. 

 l A Materials Issue Method field with a drop-down list has been added. 

 l When creating a work ticket, bill numbers and template numbers are now entered on 
the Header tab. The option to copy from bills and templates has been removed from 
the Copy From window. 

 l When using the Copy From window, you now choose to copy from either an open 
work ticket or work ticket history. 

Labor Entry

Labor entries are now entered in a primary and secondary grid in which multiple records 
for the same day can be viewed and modified. 

Labor entries are no longer updated to the Payroll module by updating the Periodic Labor 
Register. Instead, you now import labor entries into Payroll using the Labor button on the 
Pay Cycle window. For more information, see "Payroll Integration Changes" (page 65).

Materials Where-Used Inquiry

In Materials Where-Used Inquiry, you have the option to view material usage in either 
work tickets or templates. Also you can sort by multiple columns. 

Payroll Integration Changes

The following changes related to integration with the Payroll module have been made in 
Production Management. 

 l The Periodic Labor Register has been renamed Periodic Labor Report. This report is 
no longer used to push labor entries to the Payroll module for use in Payroll Data 
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Entry. 

 l Labor entries are now imported into Payroll by clicking the Labor button on the Pay 
Cycle window. Labor Entry records can be imported into Payroll only if Yes is 
selected in the (Integrate with) Payroll field in Production Management Options. 

Data Conversion for Work Order

If you're upgrading from an earlier version of Sage 100, Work Order data is included in 
your source company, and the Production Management module is installed in your target 
company, your Work Order data is converted to Production Management data. 

Note: If you had purchase orders linked to work orders in your source data, the 
purchase orders will not be linked to the converted work tickets after you run 
conversion. You must manually relink the purchase orders. 

Data Conversion for Earlier Version of Production Management

The Production Management module code has changed from JT to PM. When you 
convert Production Management data from an earlier version of Sage 100, the converted 
company data files are changed to use the PM prefix. 

Important! If you're upgrading from the standalone version of Production 
Management that was previously available, you must be on version 2021.x of the 
standalone version before upgrading to the Production Management module that 
is part of Sage 100 2022.

Note: Report settings saved in the standalone version of Production Management 
are not migrated to the version of the module available with Sage 100 2022. 

Sage Intelligence Reporting

Sage Intelligence Reporting now works with the 64-bit version of Sage 100 and Windows. 

Sales Order

The following changes were made in the Sales Order module. 

Sage 100 Customer Upgrade Guide 66

Changes in Version 2022



Changes in Version 2022

View Order Type, Ship Date, and Expire Date in History

The following fields have been added to the Sales Order and Quote History Inquiry 
window:

 l Order Type

 l Ship Date (for standard orders and back orders)

 l Expire Date (for quotes)

These fields have also been added to the SO_SalesOrderQuoteHistoryWrk table, so they 
can be added to forms. 

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Visual Process Flows

The following changes were made to the Visual Process Flows Designer.

 l You can select multiple elements at the same time by pressing the Shift key while 
selecting them with your mouse. You can move and resize the elements together and 
create permanent groups. For more information, see Visual Process Flow Designer 
in the Sage 100 help. 

 l Buttons with up/down and left/right arrows have been added to the Actions window. 
Use the buttons to move the Actions window to another area of the Designer window. 

 l Guidelines now appear when you start to move an element to help you align it with 
other elements in the Designer window. 

 l An Underline button has been added to the text formatting toolbar. 

 l You no longer have to press the Enter key to add text to an element. 

Work Order

The Production Management module has replaced Work Order. The Work Order module 
is no longer part of the Sage 100 installation program. 

When running conversion, if your source company has Work Order data and the 
Production Management module is installed for version 2022, the Work Order data is 
converted to Production Management data. 
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Note: If your data includes work orders that are linked to purchase orders, you will 
have to manually relink the purchase orders to work tickets after you convert the 
data. 

Microsoft 365

References to Office 365, including task names, have been changed to Microsoft 365. 

Features No Longer Subscription Only

The following features were initially available only if you purchased Sage 100 through a 
subscription plan. They are now available to all users, regardless of whether Sage 100 
was purchased as a subscription or perpetual license. 

 l Spell Check: A red line appears underneath misspelled words. You can right-click 
the word to view a list of suggestions, ignore the misspelling, or add it to your custom 
dictionary. 

 l Full Text Search in Lookups: In Lookup views, in the Search list, you can select Full 
Text. Your search criteria is then matched against all text in the records instead of a 
single field. 

 l Theme Maintenance: This task, located on the Library Master Main menu, allows 
you to customize the appearance of Sage 100 windows. 

 l Document Date Warnings: This feature allows you to display a warning message 
when a user enters a date that is outside of settings defined in Company 
Maintenance. 
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Changes in Version 2021

This chapter describes the enhancements added in Sage 100 2021 and subsequent 
updates for that version. Global changes are listed first, followed by module-specific 
changes, any updates to Microsoft 365 integration, and then retired features.

For a list of program fixes, see the release notes for version 2021 and the release notes 
for version 2021 updates. 

Changes in Version 2021.6
The following enhancements were added in Version 2021.6.

Accounts Payable

The following changes were made in the Accounts Payable module.

Form 1099 Tax Reporting Version

Form 1099 Tax Reporting has been updated to version 2.98.

DBA Name for 1099 Forms

There has been a functionality change of where the 1099 DBA Name field prints on the 
1099 Form.

If there is a name entered in the DBA Name field on the Additional tab in Vendor 
Maintenance, it will now print on Line 1 of the Recipient Name box of the 1099 Form and 
the Vendor Name will print on Line 2 of the Recipient Name box of the 1099 Form.

Updates for 1099 Form Tax Reporting

The following options have been added to support Form 1099 printing for tax year 2022:

 l For the 1099-DIV Form:

 l Box 11 is now FATCA filing requirement check box.

 l Subsequently, old box numbers 11 through 15 have been renumbered to 
new box numbers 12 through 16, respectively. The new boxes are as 
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Changes in Version 2021.5

follows:

 l Box 12 - Exempt-interest dividends

 l Box 13 - Specified private activity bond interest dividends

 l Box 14 - State

 l Box 15 - State Identification No.

 l Box 16 - State Tax Withheld

 l For the 1099-MISC Form:

 l Box 13 is now FATCA filing requirement check box

 l Subsequently, old box numbers 13 through 17 have been renumbered to 
new box numbers 14 through 18, respectively. The new boxes are as 
follows:

 l Box 14 - Excess golden parachute payments 

 l Box 15 - Nonqualified deferred compensation

 l Box 16 - State tax withheld

 l Box 17 - State/Payer's state no.

 l Box 18 - State Income

Changes in Version 2021.5
The following enhancement was added in Version 2021.5.

Accounts Receivable

The following change was made in the Accounts Receivable module.

Option to Print Zero Balance Customers with No Invoices

The Customers with No Invoices check box has been added to Statement Printing. You 
can select this check box to print statements for zero balance customers that do not have 
any invoice detail printing on the statement.

Changes in Version 2021.4
Version 2021.4 contains program fixes for Sage 100. For more information, please see 
the release notes.
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Changes in Version 2021.3
Version 2021.3 contains program fixes for Sage 100. For more information, please see 
the release notes.

Changes in Version 2021.2
The following enhancements were added in Version 2021.2. 

Accounts Payable 

The following change was made in the Accounts Payable module.

DBA Name and Address for 1099 Forms

DBA (doing business as) name and address fields have been added to the Additional tab 
in Vendor Maintenance and the Vendor Maintenance On-the-Fly window. 

If a DBA name is entered, it is printed on the vendor's 1099 form in addition to the vendor 
name. 

If a DBA address is entered, it is printed on the vendor’s 1099 form instead of the vendor 
address. 

The fields are available if an option other than None is selected in the Vendor Type field. 

Updates for 1099 Form Tax Reporting

The following options have been added to support Form 1099 printing for tax year 2021:

 l For the 1099 MISC form:

 l Box 11: Fish Purchased for Resale

 l For the 1099 DIV form:

 l Box 2e: Section 897 Ordinary Dividends

 l Box 2f: Section 897 Capital Gain
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Changes in Version 2021.1

Library Master

ODBC Password Support

Password fields are available when unified logon is enabled to support access through 
third-party ODBC applications.

Changes in Version 2021.1
Version 2021.1 contains program fixes for Sage 100. For more information, please see 
the release notes.

Changes in Version 2021
The following changes were made in version 2021.

Global Changes

The following changes are carried throughout multiple modules.

Company Types

You can now see at a glance whether the current company is live, a demo, and so forth. 
After selecting types for your companies in Company Maintenance and setting up display 
preferences in System Configuration, you can see the type in the title bar of your task 
windows. 

Type Field in Company Maintenance 

A Type field has been added in Company Maintenance. You must select one of the 
following options: Live, Archive, Demo, Test.

When you upgrade from an earlier version of Sage 100, Live is automatically selected for 
all companies that are converted, but you can change the type if needed. 

When you install demo data, Demo is automatically selected as the company type. 

Display Options in System Configuration

On the Preferences tab in System Configuration, check boxes for each company type 
have been added in the Display Company Type in Windows Title Bar section. 
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Select one or more of these check boxes to display the company type after the company 
code in the title bar for task windows. 

For example: Customer Maintenance (ABC - Demo) 5/31/2025

Security Option to Delete or Overwrite Companies

A new security option has been added in Role Maintenance. If the Allow Delete/Overwrite 
Live and Archive Companies check box is selected, the applicable users will be able to 
delete or overwrite companies with Live or Archive selected as the type. A message 
appears to confirm the intention to delete or overwrite the company.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Check Number Field Expanded

The check number field has been expanded to hold 10 characters. Task windows, forms, 
and reports have been updated to reflect this change. 

This enhancement was carried throughout the following modules:

 l Accounts Payable

 l Bank Reconciliation

 l General Ledger

 l Payroll (requires Sage 100 Payroll 2.21 or later)

 l Purchase Order 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Select Which User Identifier to Display

A User Display Option field has been added to the Preferences tab in System 
Configuration. Use this field to select which user identifier appears in various locations 
throughout Sage 100, including report footers, the Activity Log, and so forth. The 
following options are available: 

 l User Logon

 l Name

Sage 100 Customer Upgrade Guide 73

Changes in Version 2021

https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP/
https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP/


Changes in Version 2021

 l User Code (the default selection)

 l E-mail Address

User Logon is the default selection. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

64-Bit Version of Sage 100

A 64-bit version of Sage 100 is now available. When running the Sage 100 installation 
wizard on a computer with a 64-bit version of Windows, you’ll have the option to install 
either the 32-bit version or the 64-bit version. 

Warnings!

 l After installing the 64-bit version of Sage 100, any 32-bit versions installed on 
the same computer will no longer work. 

 l If you install the 64-bit version of Sage 100 then only workstations with the 64-
bit version of Windows will be able to run Sage 100.

If you’re installing Sage 100 on a computer with a 32-bit version, you can install the 32-bit 
version of Sage 100 2021, and then run the Sage 100 32-bit/64-bit Switch Utility Wizard 
after you’ve converted your data and completed your testing. This utility converts your 32-
bit version of Sage 100 2021 to 64 bit. 

If necessary you can also use the utility to convert from the 64-bit version of Sage 100 to 
the 32-bit version. 

For more information, see "Converting to 64-bit Version of Sage 100" (page 201). 

Payment Center Rebranding

Paya (formerly known as Sage Payment Solutions) has retired the Payment Center 
website and replaced it with the Paya Exchange website. Labels within Sage 100 have 
been changed from Payment Center to Paya Exchange. 

Credit card and ACH payment processing work flows have not changed. Paya Desktop 
Connect has replaced Sage Exchange Desktop as the locally installed application that is 
required. 
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Edge Used for Embedded Browser

Microsoft Edge is now used as the embedded browser in the Sage 100 Desktop if you 
have a version of Edge installed that was released on or after January 15, 2020. 

Edge is a more modern browser that delivers better page rendering and performance.

Map Sage 100 Users to Sage ID Accounts

A User Merge Utility has been added to the Administrative Tools window to help you map 
user records created in the Sage Provisioning Portal to user records created in Sage 100. 

Use this utility when you’re migrating data from an on-premises version of Sage 100 to 
one in the Sage Partner Cloud. For more information, see User Merge Utility in the help. 

Accounts Payable

The following changes were made in the Accounts Payable module.

Form 1099-NEC Option in Form 1099 Tax Reporting

Nonemployee Compensation has been added to the Form Type list in Form 1099 Tax 
Reporting. 

A/P Open Invoices Paid Today Utility

An Open Invoices Paid Today Utility has been added to the Sage 100 Utilities menu 
available from the Run Program window. Use this utility to ensure that the Paid Today 
field in the Open Invoice file is set correctly when related records are missing due to 
power loss or some other unusual circumstance. You can schedule the utility to run 
automatically using Task Scheduler. 

Accounts Receivable

The following changes were made in the Accounts Receivable module.

Use Original or Current Cost When Applying Credit Memo

When applying a credit memo to an invoice in Invoice Data Entry, you have the option to 
recall Accounts Receivable invoice information from history. This option is available if 
Yes or Summary is selected in the (Invoice History) Retain in Detail field in Accounts 
Receivable Options.
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After you enter an invoice number, a message asks if you want to copy invoice 
information from history. 

If Yes is selected in the (Invoice History) Retain in Detail field, line details are included. If 
Summary is selected only the invoice header information is used. 

If you click Yes to use information from the history files, a second message asks if you 
want to recall the item cost from history. You can click the Details button in the message 
window to view the cost information from both history and inventory for each item on the 
invoice. Check with your accountant about the appropriate costing method for returned 
inventory.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Settings Saved When Creating Form Code in A/R Invoice Printing

When you save a new form code in A/R Invoice Printing, all of the settings are now saved. 
Previously only the Paperless Office output setting was saved. 

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Bank Reconciliation

The following changes were made in the Bank Reconciliation module.

Exclude Wire Transfers from Positive Pay Export

When running the Positive Pay Export Wizard, you can specify whether to include wire 
transfers when the file is created.   

Custom Office

The following changes were made in the Custom Office module.
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Select Role When Adding UDT to UDT Maintenance

When adding a UDT to the UDT Maintenance menu, you no longer need to access Role 
Maintenance to set up security for the UDT task. 

In User-Defined Field and Table Maintenance, when you click the Add UDT to Desktop 
button, the Menu Wizard now starts. The Select Roles page in the wizard allows you to 
specify which roles will have access to the UDT task. 

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Two-Line Column Descriptions

You can now create two-line column descriptions for customized grids. In the Column 
Properties window, insert a carriage return token ( <CR> ) to create a line break in a 
column description. 

Only one line-break is allowed in the description. In a dual-grid panel with no column 
description for the secondary grid, the description displays in one row when the column is 
moved from the primary grid to the secondary grid. 

Fixed Assets

The following enhancements were added to the Fixed Assets module.

Update in Period End Processing

The posting book check boxes in the Period End Processing window have been replaced 
by a grid with Book Name and Close Book columns. The Close Book column contains 
check boxes that you can select for the books that you want to process for period end. 

The change was made to support the additional posting books added in Sage Fixed 
Assets version 2021. 

Inventory Management

The following changes were made in the Inventory Management module.

Sage 100 Customer Upgrade Guide 77

Changes in Version 2021



Changes in Version 2021

Default Date Range for Transactions

You can select a default date range for the Transactions tab in Item Maintenance and 
Item Inquiry. 

The default date range is based on the selection in the Transaction Date Search Default 
Selection field that has been added to the Additional tab in Inventory Options. 

When viewing the Transactions tab, you can change the default date range by clicking the 
Search button and entering different criteria in the Transaction Date row.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Library Master

The following changes were made in the Library Master module.

Role Security Enhancements

Several security-related enhancements have been made to simplify the security setup 
process. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Note: Unless otherwise noted, these features are available if you purchased Sage 
100 through a subscription plan.

Security Menu

A Security Menu has been added to the Library Master module. This menu includes the 
tasks listed below. Some tasks are new and some were relocated from other menus.

 l Administrator Tools

 l Export Roles (subscription only)

 l Import Roles (subscription only)

 l Role Maintenance

 l Role Report

 l Role/User Inquiry (subscription only)
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 l User Maintenance

 l User Report

Note: The Security menu is available for both subscription and non-subscription 
versions of Sage 100. However, some tasks are available only in the subscription 
version.

Role Maintenance Enhancements

The following changes were made in Role Maintenance. 

Role Types

A Type field has been added with types such as Admin, Auditor, Employee, and so forth. 
You’ll be required to select a type when creating new roles. Existing roles created in 
earlier versions of Sage 100 will automatically have Converted as the selected type, but 
you can change it.

Note: The Type field is available for both subscription and non-subscription 
versions of Sage 100.

Role Templates

When creating a role, you can click Copy and then select one of several predefined role 
templates. Templates have been added for most modules and are available based on 
which modules are installed.

To view a detailed list of permissions available with each role template, print the Role 
Report and select Role Template Details in the Type of Report to Print field. You can also 
view an existing template in Role Maintenance by clicking the Role Template List button 
and selecting a template. 

Task Tab

On the Tasks tab, you can sort the module list alphabetically or by the default menu 
order. When the modules are sorted alphabetically, the subcategories are still sorted 
using the default menu order. 

The security alias feature has been removed for various tasks. For example, Item Inquiry 
appears on the Sales Order Inquiries menu. In earlier versions of Role Maintenance, you 
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would have to go to the Inventory Management section to grant  access to Item Inquiry in 
the Sales Order module. Item Inquiry is now included in the Sales Order section.  

Security Options

Security events and module options have been combined onto one tab in Role 
Maintenance, and they are now referred to as Security Options.

On the Security Options tab, you can sort by module, group, or security option. When you 
sort by group, the security options are still organized by module, but there are 
subcategories such as Batches, Data Entry, and so forth. 

Help text for the selected security option is displayed at the bottom of the window. 

Filtering Role Settings

A Filter button has been added in Role Maintenance. Click this button to open the Filter 
Role Settings window, which you can use to filter the information that appears in the tree 
view on the various tabs. 

This window provides several filter options, such as by module and menu group. You can 
apply the filter to all tabs or certain ones. 

Applying Role Changes to Other Roles

After making a change to a role, you can click the Apply button to open the Apply Role 
Changes window. In this window, you can select which changes to apply and to which 
roles they should be applied. 

Assigning Users to Roles

Click the Assign button to open the Assign Users to Role window. Use this window to 
assign the current role to users in some or all companies.   

Removing Users from Roles

Click the Remove button to open the Remove Users from Role window. Use this window 
to remove users from the current role.

Importing and Exporting Roles

Click the Import and Export buttons to import and export roles. You must click the buttons 
before selecting a role. 
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When you export roles, they are exported to the file and location that you specify. When 
you Import a role, you can select which of the roles included in the import file that you 
want to import.

Role Report Enhancements

When printing the Role Report, you can select Role Template Details in the Type of 
Report to Print field to view a list of all permissions available for one or more role 
templates. A Role Template field has been added to the Selections grid.

The Include Tasks and Events with No Access check box that was added in the 2020.1 
update has been replaced with an Include Tasks and Options field. Use this field to 
specify whether to print tasks and security options for which the role has access, no 
access, or both. 

Options for sorting tasks and security options have been added. 

The role type now prints on the report for both subscription and non-subscription plans. 

Exclude Role Option in User Maintenance

An Exclude check box has been added to the Maintenance tab in User Maintenance. Use 
this check box if you’ve assigned a role to a user for all companies, but want to exclude 
them from the role in specific companies.

User Report Enhancements

The Include Tasks and Events with No Access option that was added in the 2020.1 
update has been replaced with an Include Tasks and Options field. Use this field to 
specify whether to print tasks and security options for which the user has either access, 
no access, or both. 

Options for sorting tasks and security options have been added. 

Role/User Inquiry

Role/User Inquiry has been added to the Security menu. Use this task to select a role, 
user, task, or security option and view related information about the selected item. The 
information is displayed in a tree view and can be exported to Excel. 
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Maintain Default Form Codes 

A new task, Default Form Maintenance, has been added to the Library Master Setup 
menu. 

Use this task to:

 l Maintain default form codes by company and role or individual user. 

 l Select a template for Standard form codes if it there is no template already 
associated with the code.

 l Prevent users from changing the default form code within the form tasks.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Copy Custom Forms, Custom Reports, and Settings

When copying a company in Company Maintenance, you have the option to copy form 
and report settings, default form selections, custom forms, and custom reports. 

Select the Forms check box to copy the form settings, default form selections, and 
custom forms from the source company to the destination company. 

Select the Reports check box to copy report settings and custom reports from the source 
company to the destination company. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Build Search Index for Specific Company Types

When running the Build Search Index utility for the advanced auto-complete feature, you 
can now specify which company types to index. 

Sage 100 Customer Upgrade Guide 82



In Task Scheduler, you can specify the company type codes in the Run Time Arguments 
field, which has been added to the Tasks tab. This new field appears when Build Search 
Index is selected in the Task field.

Access Administrative Tools 

You can now access the Administrative Tools window from the Library Master Main 
menu.  

OAuth Authentication for SMTP Mail Server

On the E-mail tab in Company Maintenance, you can now select between two 
authentication methods to use when connecting to the SMTP server:

 l Basic: This option works the same as earlier versions of Sage.

 l OAuth (Open Authorization): This new option is an open standard authorization 
protocol used to grant access using access tokens instead of sharing a user name 
and password.

If you're going to use the OAuth method, you will need to obtain your OAuth client 
credentials from your authenticating application, such as those offered by Microsoft and 
Google. To learn more, visit oauth.net.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

ACA PII Worktable Available in Report Manager

When adding a Payroll report using the Report Manager wizard, you have the option to 
include the ACA PII (personally identifiable information) worktable in the report.

Paperless Office

The following changes were made in the Paperless Office module.

Default Delivery Options

A new Default Delivery Options task has been added to the Paperless Office Setup 
menu. Use this task to make default form selections that are automatically set in the 
Paperless Office Delivery Options window when creating a new customer or vendor 
record. You can change the defaults if needed.
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Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Electronic Delivery Log 

An Electronic Delivery Log button has been added to the following tasks:

 l Customer Viewer

 l Vendor Viewer

 l Employee Viewer 

 l Journal and Register Viewer

 l Period End Reports Viewer

 l Report Viewer 

Select a document and then click this button to view the most recent date and time that 
the document was sent, the user logon of the person who sent it, the status of the 
submission attempt, and the recipient's email or fax number. 

Click the Electronic Delivery Submissions List button to view a list of all attempts to send 
the document. 

View List of Documents That Have Been Sent

Two inquiry tasks have been added to the Paperless Office Main menu:

 l Customer Electronic Delivery Inquiry

 l Vendor Electronic Delivery Inquiry

Use these tasks to view a list of documents that have been sent to customers and 
vendors. 

You have several options for filtering the list, including the delivery type and status. The 
status reflects whether emails were successfully submitted to the SMTP server and 
whether faxes were successfully submitted to the fax server. 

You can resend the documents from the list box or export the list to Microsoft Excel.
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Note: These features are available if you purchased Sage 100 through a 
subscription plan.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Email Additional Salespeople

When sending forms to customers, you can also send them to all salespeople who are 
receiving a commission on the sale. 

To enable this feature, select the E-mail Add’l Slspn check box that has been added to 
the Paperless Office Delivery Options window accessed through Salesperson 
Maintenance. You can enable the feature for:

 l Statements 

 l Sales orders

 l Sales Order invoices

Document Lookup in Paperless Office Delivery Options

A Document Lookup button has been added next to the Document field in Paperless 
Office Delivery Options. Click the button to view a list of forms that have been set up for 
the selected customer or vendor. 

New Options for Associated Documents

You are no longer limited to PDF files when associating documents with journals and 
registers. Any document type can be associated, including Word documents, Excel 
workbooks, images, and so forth. Field labels in various windows have been updated to 
reflect the change.

In the Journal and Register Viewer, you can click the Edit Associated Document button 
to:

 l Select a different document to associate with the journal or register. 

 l Add a document if none was previously associated.

 l Remove an associated document. 
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The button is available based on a new security option, Allow Editing of Associated 
Document for Journal and Register PDF Documents. 

Documents are Updated Only If Printed and Sent

Forms are no longer flagged as updated when they are printed as PDFs but not 
electronically delivered due to an interruption in the process. 

Previously when the printing and delivery process was interrupted, forms were 
sometimes flagged as updated when they were printed but not sent. 

This update affects the following forms:

 l Accounts Receivable Invoice Printing 

 l Job Cost Invoice Printing 

 l Purchase Order Printing 

 l Return Order Printing 

 l Customer RMA Printing 

 l RMA Receiver Printing 

 l Sales Order Printing 

 l Sales Order Invoice Printing 

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Purchase Order

The following changes were made in the Purchase Order module.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Purchases Clearing From History Report

The Purchases Clearing From History Report has been added to the Purchase Order 
Period End Processing menu. 

Unlike the Purchases Clearing Report, you can run this report after running period end 
processing, so you can get the information needed to reconcile the purchases clearing 
account at any time. 
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Invoice Lines Added in Receipt History Inquiry

When viewing a receipt of invoice record in Receipt History Inquiry, the invoice lines now 
appear on the Lines tab. 

Invoice Lines Added to Receipt History Report

Line details from receipt of invoice records are now included on the Receipt History 
Report when you select the Print Line Information check box if you’re retaining history in 
Purchase Order Options.

Drill Down Options in Purchase Order Entry and Inquiry

Two drill-down buttons have been added to the Totals tab in Purchase Order Entry and 
Purchase Order Inquiry. 

A Receipt History Inquiry button has been added next to the Last Receipt Date field. If 
one or more receipts exist for the purchase order, you can click the button to view the 
receipt(s).

An Invoice History Inquiry button has been added next to the Last Invoice Date field. If 
one or more invoices exist for the purchase order, you can click the button to view the 
invoice(s). 

Note: During data conversion, the program attempts to populate the P/O Receipts 
History Detail file using line detail from the A/P Invoice History Detail file for 
existing Receipt of Invoice Records. However, the line detail will not be populated 
if the line detail does not exist in the A/P file. 

Form 1099-NEC Option Available

You can select the 1099-Nonemployee Comp form when entering a document in the 
following tasks: 

 l Purchase Order Entry

 l Receipt of Goods Entry

 l Receipt of Invoice Entry

 l Return of Goods Entry

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.
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Sales Order

The following changes were made in the Sales Order module. 

Suppress Prompts in Daily Sales Reports/Updates

You can now suppress the prompts that ask you to print the reports listed below when 
printing from Daily Sales Reports/Updates. The reports will print automatically. 

 l Daily Sales Recap Reports

 l Gross Profit Journal

 l Shipping Exception Report

 l Job Transaction Journal

 l Daily Back Order Report

 l Daily Deposit Recap

To automatically print the reports without prompts, go to Sales Order Options and, on the 
Printing tab, select the Automatically Print All Additional Reports That Apply check box. 

The reports listed above are available based on how the Sales Order module is set up.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Use Original or Current Cost When Applying Credit Memo

When applying a credit memo to an invoice in Invoice Data Entry, you have the option to 
recall invoice information from history. This option is available if Yes or Summary is 
selected in the (Invoice History) Retain in Detail field in Accounts Receivable Options.

After you enter an invoice number, a message asks if you want to copy invoice 
information from history. 

If Yes is selected in the (Invoice History) Retain in Detail field, line details are included. If 
Summary is selected only the invoice header information is used. 

If you click Yes to use information from the history files, a second message asks if you 
want to recall the item cost from history. You can click the Details button in the message 
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window to view the cost information from both history and inventory for each item on the 
invoice. Check with your accountant about the appropriate costing method for returned 
inventory.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Visual Integrator

The following changes were made in the Visual Integrator module.

Options for Managing Log Files

A Setup menu has been added to the Visual Integrator module. Visual Integrator Options 
has been added to the menu. 

In Visual Integrator Options you can manage the log files that are generated when 
running import and export jobs and when automatically scheduled jobs are run. 

You can specify whether to reuse the existing log files when jobs are run or create new 
ones. You can also select the location where log files are saved. 

Visual Process Flows

Visual Process Flows are now based on HTML5 instead of Adobe Flash. The new visual 
process flows feature a blue and white color scheme and new images. Some images are 
no longer available. 

Tool tips no longer appear when hovering over an icon. Instead you must click the icon to 
see the tool tip. If a visual process flow had multiple tool tips, they have been combined. 

By default, tool tips, print options, report options, and inquiry selections are shown. After 
opening a visual process flow, click twice on an icon to hide the corresponding 
information. After you’ve hidden the information, you can click once to show it or hide it 
again. 
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If you’ve created custom visual process flows in earlier versions of Sage 100, they will still 
work, with the exception of the show/hide functionality. However, you should review them 
because adjustments may be needed. 

The editor for customizing visual process flows has been redesigned. 

Office 365 Integration

A new task, Self Service Invitations, has been added to the Office 365 Integration menu in 
the Library Master module. Use this task to send email invitations to employees so that 
they can start using the employee self service features. 

You must have the Payroll module to use the employee self service features, and the 
employees must have records created in Employee Maintenance. 
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Changes in Version 2020

This chapter describes the enhancements added in Sage 100 2020 and subsequent 
updates for that version. Global changes are listed first, followed by module-specific 
changes, any updates to Microsoft 365 integration, and then retired features.

For a list of program fixes, see the version 2020 release notes and the release notes for 
version 2020 updates. 

Changes in Version 2020.6
The following change was made in update 6 for Sage 100 2020.

Library Master

The following change was made in the Library Master module.

OAuth Authentication for SMTP Mail Server

On the E-mail tab in Company Maintenance, you can now select between two email 
authentication methods to use when connecting to the SMTP server:

 l Basic Email Authentication: This option works the same as earlier versions of Sage.

 l Modern Email Authentication or Open Authorization (OAuth): This new option is an 
open standard authorization protocol used to grant access using access tokens 
instead of sharing a user name and password.

If you're going to use the OAuth method, you will need to obtain your OAuth client 
credentials from your authenticating application, such as those offered by Microsoft® and 
Google®. To learn more, visit oauth.net.

For instructions on setting up OAuth in Sage 100, see How to Configure Sage 100 OAuth 
Email Settings. 

Changes in Version 2020.5
Update 5 for Sage 100 2020 contains program fixes. For more information, please see 
the release notes.
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Changes in Version 2020.4

Changes in Version 2020.4
The following changes were made in update 4 for version 2020.

Accounts Payable

The following changes were made in the Accounts Payable module. 

Updates for 1099 Form Tax Reporting

The following options have been added to support Form 1099 printing for tax year 2021:

 l For the 1099 MISC form:

 l Box 11: Fish Purchased for Resale

 l For the 1099 DIV form:

 l Box 2e: Section 897 Ordinary Dividends

 l Box 2f: Section 897 Capital Gain

Changes in Version 2020.3
Update 3 for Sage 100 2020 contains program fixes. For more information, please see 
the release notes.

Changes in Version 2020.2
The following changes were made in update 2 for Sage 100 2020.

Global Changes

The following change was made in update 2. 

Map Sage 100 Users to Sage ID Accounts

A User Merge Utility has been added to the Administrative Tools window to help you map 
user records created in the Sage Provisioning Portal to user records created in Sage 100.
  

Use this utility when you’re migrating data from an on-premises version of Sage 100 to 
one in the Sage Partner Cloud. For more information, see User Merge Utility in the help.
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Library Master

The following changes were made in the Library Master module. 

Access Administrative Tools

You can now access the Administrative Tools window from the Library Master Main 
menu.

ACA PII Worktable Available in Report Manager

When adding a Payroll report using the Report Manager wizard, you have the option to 
include the ACA PII (personally identifiable information) worktable in the report.

Purchase Order

The following changes were made in the Purchase Order module. 

Form 1099-NEC Option Available

You can select the 1099-Nonemployee Comp form when entering a document in the 
following tasks:

 l Purchase Order Entry

 l Receipt of Goods Entry

 l Receipt of Invoice Entry

 l Return of Goods Entry

Changes in Version 2020.1
The following changes were made in update 1 for Sage 100 2020.

Accounts Payable

The following changes were made in the Accounts Payable module. 

Easily Add Distribution Balance to Current Line

A Net Balance button has been added in the following locations:
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 l Invoice Data Entry Lines tab

 l Repetitive Invoice Entry Lines tab

 l General Ledger Distribution window accessed through Manual Check and Payment 
Entry

Click the Net Balance button to add the undistributed balance to the current line.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Form 1099-NEC Option in Form 1099 Tax Reporting

Nonemployee Compensation has been added to the Form Type list in Form 1099 Tax 
Reporting.

The 1099-NEC form was added in other locations in the 2020 update. For more 
information, see 1099-NEC Form Added under What's New in Version 2020.

Accounts Receivable

The following changes were made in the Accounts Receivable module. 

Payments Tab Added to Invoice History Inquiry

A Payments tab has been added to Invoice History Inquiry. The tab shows all payments 
applied to the selected invoice.

You can click the Cash Receipts History button to view more details about payments 
processed through Cash Receipts Entry.

You can click the Payment Information button to view more details about credit card and 
ACH payments.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Run Utility for Payments Today Fields as Scheduled Task

The utility used to update the Payments Today field, previously named ARWAR4, has 
been renamed AR_OpenInvoicePaymentsToday_ui. You can set up a scheduled task to 
run this utility in Task Scheduler.
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Note that the logic behind the utility now runs automatically when you’re working in Cash 
Receipts Entry and A/P from A/R Clearing.

Fixed Assets

The following changes were made in the Fixed Assets module. 

Update in Period End Processing

The posting book check boxes in the Period End Processing window have been replaced 
by a grid with Book Name and Close Book columns. The Close Book column contains 
check boxes that you can select for the books that you want to process for period end.

This change was made to support the additional posting books added in Sage Fixed 
Assets version 2021.

Inventory Management

The following changes were made in the Inventory Management module. 

Ability to Trace Item Use by Lot and Serial Number

You now have multiple options to trace where items from a particular lot or with a 
particular serial number have been used, including items used as bill and kit components.

Note that the ability to trace items is applicable only to transactions processed after 
you’ve installed this update .

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Where-Used Inquiry Window

A Where Used button has been added to the Lot/Serial Inquiry window accessed from the 
Main menu or from Item Maintenance. You can click the Where Used button to see where 
items from the current lot or with the current serial number were used as a component of 
a sales kit or a bill. The button is available when you select a Sales Order invoice with the 
type SI, or a Production Entry transaction with the type BI.
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Other Changes in Lot/Serial Inquiry

Additional changes have been made to the Lot/Serial Inquiry window accessed from the 
Main menu.

 l The item code and description now appear on the main window instead of in the list 
box.

 l If a lot or serial number has more than one item associated with it, the Item List 
window automatically opens so that you can select an item.

 l The item code has also been removed from the Search for Lot/Serial Transactions 
window.

 l The Zoom button has been renamed History Inquiry.

 l When you click the OK button, the information displayed in the window is cleared, 
and you can select a different lot or serial number.

Customer Recall Report

The new Customer Recall Report has been added to the Reports menu, and it can be 
accessed from Lot/Serial Inquiry when the task is accessed from the Main menu.

Use this report to view a list of customers to whom you have sold or shipped lot or serial 
items that must be recalled.

Lot Serial Transaction History Report

A Print Where-Used Items check box has been added to the Lot Serial Transaction 
History Report. When this check box is selected, the report shows the transactions in 
which lot and serial items have been used either as a standalone item or as a component 
of a bill or sales kit.

We’re listening! Lot and serial traceability was a suggestion on the Sage 100 ideas 
site. Visit the ideas site to share your ideas and vote for your favorites.

Library Master

The following changes were made in the Library Master module. 
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Exclude Tasks and Events from Reports Based on Access

You can exclude unnecessary information from reports by clearing the Include Tasks and 
Events with No Access check box.

The check box has been added to the following report tasks:

 l Role Report

 l User Report

If this check box is cleared, the tasks and events to which the role or user has no access 
are excluded from the reports.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Visual Integrator

The following changes were made in the Visual Integrator module. 

Filter Options for Job Log

A Filter List button has been added to the Job Log window. You can filter by the status 
(failed or skipped) or you can filter by records that passed but have one or more invalid 
fields.

Export Option for Job Log

After filtering records for an import job using the new Filter List button, you can click the 
Export List button to export two files:

 l A file that contains the filtered records. This file is the same type as the original 
source file, and the records are formatted the same way so that you can make 
corrections and then import the file again.

If the job definition indicated that the first record in the original source file is a list of 
field names, this record is copied as the first record in the new output file.

 l A text file with information on why each record failed.
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The files are exported to the same folder where the original file is stored. The file names 
will match the original source file name with the time and date appended.

Row Number in Job Log

When importing data using either an ASCII file or a delimited file as the source, the row 
number from the source file appears in the Job Log.

ALE Lookups For Job Numbers

ALE lookups are now used when selecting jobs in the following locations:

 l Export Job Selection window that opens when you start Export Job Maintenance

 l Import Job Selection window that opens when you start Import Job Maintenance

 l Copy From button and Chain To fields in Export Job Maintenance and Import Job 
Maintenance

 l Job Select

Browse Buttons on Log Detail Window

Browse buttons have been added to the Record Detail window. Use the buttons to 
navigate to the next, previous, first, and last record.

Company Colors Used for Import and Export Jobs

If you have a company-specific background color set up in Company Maintenance, the 
color is now used for certain screens in Visual Integrator when you’re working with import 
and export jobs. For example, you’ll see the color when you select a job, and view the job 
log. Not all screens are affected because Visual Integrator is not company-specific.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Changes in Version 2020
The following changes were made in Sage 100 2020.

Global

The following changes are carried throughout multiple modules.
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Expanded Name Fields

The following fields have been expanded to 50 characters:

 l Customer name

 l Customer contact name

 l Vendor contact name

 l Confirm to name

 l Requested by name

The fields previously held 30 characters. Note that the field for vendor names was 
expanded to 50 characters in a previous release. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Expanded Fields for Address Information

The following fields have been expanded for customer, vendor, and employee 
addresses:

 l Address lines: from 30 to 40 characters

 l City: from 20 to 30 characters

 l Country name: from 30 to 50 characters

Changes for Telephone and Fax Fields

The following changes have been made for telephone and fax number fields. 

 l Telephone and fax number fields have been expanded from 17 to 20 characters. 

 l The telephone extension field has been expanded from 5 to 6 characters. 

 l A Type field has been added for customer, vendor, and contact telephone numbers. 
You can select Work, Cell, Home, or Other.

 l A Primary check box has been added for the two telephone number fields in 
Customer Contact Maintenance and Vendor Contact Maintenance. 

International Address Support

You can now enter an international address for customers, vendors, and contacts. To 
support international addresses, the following changes have been made:
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 l The Country field has been moved above the address lines. A country code is 
needed to ensure that the correct city and state or province is entered based on the 
ZIP or postal code. 

 l ZIP Code fields have been renamed ZIP/Postal Code.

 l State fields have been renamed State/Province.

 l Telephone and fax number fields support international number formats.

 l In Company Maintenance, the following changes were made:

 l On the Main tab, the following fields were added: Country, ZIP/Postal Code, City, 
State/Province. 

 l An Additional tab was added to this task. The federal and state tax ID number fields 
were moved to this tab, and fields for contact information and a trade name were 
added.

 l On the Preferences tab, a Default Country Code field was added.

Maintenance Task for State and Province Codes

State/Province Code Maintenance has been added to the Library Master Setup menu. 
State and province codes are maintained for each country code. You can enter and 
maintain the state or province name, alternate code, and geocode. The state and 
province codes for Canada and the United States are prepopulated.

Default Country Code

A Default Country Code field has been added to the Preferences tab in Company 
Maintenance. The default code will be automatically used in data entry and maintenance 
tasks, but it can be changed. 

Data Conversion

When you convert your company data from an earlier version of Sage 100, USA will 
automatically be entered as the default country code on the Preferences tab in Company 
Maintenance. 

Various Task Window Updates

To accommodate the expanded fields and longer field labels, some task windows have 
been resized, and fields were rearranged on others. In some instances in which the field 
is view-only, it may be truncated due to space constraints.
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Report and Listing Updates

Reports and listings have been modified to accommodate updated fields and formats. 
The longer customer and contact names are accommodated if they print on a separate 
line or if there is enough space. 

Form Updates

The expanded field sizes are reflected in the work tables, but the forms have not been 
updated to accommodate the expanded fields. 

The Country, City, State/Province, and ZIP/Postal Code fields added in Company 
Maintenance have been added to the work tables, but they have not been added to the 
forms. The forms still print the information in the four address lines that were on the 
window prior to this release. 

Country Code Selections Grid Option

A Country Code field has been added to the Selections grid for various form printing 
tasks. For any source documents with no value in the Country Code field, the default 
country code entered in Company Maintenance will be used for selection purposes. 

Import Jobs

Any Visual Integrator import jobs that include address information must be modified to 
include the CountryCode column, and it must be imported before the ZipCode column.

Payroll Version

If you're using Sage 100 Payroll, you must upgrade to version 2.20.1. Earlier versions 
have not been updated to support international addresses, and you will encounter errors. 
More changes to support international addresses are planned for Sage 100 Payroll 
2.20.2. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Map Service Choices

You now have a choice of which map service to use when you click a Map button next to 
address field. A Select Map Service field has been added to the following locations:

Sage 100 Customer Upgrade Guide 101

Changes in Version 2020

https://www5.v1ideas.com/TheSageGroupplc/Sage100ERP/


Changes in Version 2020

 l The Preferences tab in User Maintenance.

 l The User Settings window accessed from the File menu. 

You can select Bing Maps, Google Maps, or MapQuest. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Export to Excel Button Added for List Boxes

An Export to Excel button allows you to export the contents of a list box to Microsoft 
Excel. The button has been added for numerous list boxes throughout Sage 100. 

As part of this enhancement, the related module option in Role Maintenance has been 
renamed Allow Export to Excel from Lookups/Grids/Lists. 

Add PII Work Tables To Custom Reports

You can add multiple work tables that contain personally identifiable information (PII) to 
custom reports. When running the Menu Wizard accessed through Report Manager, if 
you’re adding a custom report for which work tables that contain PII are available, you’ll 
have the opportunity to add them. Note that users’ ability to view PII is dependent on their 
role security. Currently only the General Ledger and Payroll modules include work tables 
that contain PII. 

Admin Rights Not Required for Workstation Synchronization

You no longer need administrative rights on your workstation to run the Workstation 
Synchronization program that automatically starts after some Sage 100 updates are 
installed on the server. 

To eliminate the need for administrative rights, some files are now installed in a different 
location. The Sage folder that was previously installed in this location:

C:\Program Files (x86)\Common Files

Is now installed in this location: 

C:\Program Data
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New Desktop Utilities

You can access two utilities from the Sage 100 Desktop File menu. 

Customization Import

Use this utility to import custom settings if you were using the classic Desktop in an earlier 
version of Sage 100 and made any of the following customizations: 

 l Added tasks to a public or private folder on the My Tasks tab

 l Added tasks or shortcuts to other programs to the button bar 

If you’re using the latest version of Sage 100 on the same workstation as your earlier 
version, the utility adds your public and private tasks and shortcuts to other programs to 
the Favorites panel on the standard Desktop.

To start this utility, on the Desktop File menu, point to Desktop Utilities, and click 
Customization Import. 

Logging Level

Use this utility if asked to do so by Sage customer support. This utility was previously 
accessed by browsing to the ..\MAS90\Launcher\ folder and double-clicking 
launcher.logging.exe. 

To start this utility, on the Desktop File menu, point to Desktop Utilities, and click Logging 
Level.

Links to Sage University Training

A Sage University button ( ) has been added to additional task windows in the 

Common Information and Library Master modules and to the Visual Process Flows 
Manager window. 

Click the button to view a list of training videos related to the task. Depending on your 
Business Care plan, there may be no charge to watch the videos.

Accounts Payable

The following changes were made in the Accounts Payable module.

Sage 100 Customer Upgrade Guide 103

Changes in Version 2020



Changes in Version 2020

Encrypt PII for Inactive Vendors

As a means to comply with consumer privacy laws that require you to either delete or 
deidentify personally identifiable information (PII) so that it can’t be used to identify an 
individual, there are two ways to encrypt an inactive vendor’s PII:

 l An Encrypt button has been added to the Additional tab in Vendor Maintenance. 

 l An Encrypt Vendor Personally Identifiable Information utility has been added to the 
Accounts Payable Utilities menu. You can use this utility to encrypt vendor PII if the 
vendor’s record has already been deleted in Vendor Maintenance. 

After PII is encrypted, it no longer appears in task windows or reports. Furthermore, the 
data cannot be viewed in Data File Display and Maintenance or accessed through Visual 
Integrator or external reporting using an ODBC data source. For more information, see 
Encryption for Inactive Vendors' Personally Identifiable Information in the help. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Reverse Check Run Utility

A Reverse Check Run utility has been added to the Accounts Payable Utilities menu. You 
can use this utility to reverse an entire check run. Check runs are selected by entering 
either a register number or a bank code and check number. Checks with a type of Auto (a 
standard check) and Electronic that are posted to the cash disbursements journal can be 
reversed.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

New Options for Retaining Paid Invoices

Two new fields have been added to the Additional tab in Accounts Payable Options:

 l Months to Retain Paid Invoices (replaces Days to Retain Paid Invoices)

 l Purge Paid Invoices During
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You can enter a value ranging from 0 to 9,999 in the months field, and select whether 
paid invoices are purged during period-end or year-end processing.

Note: These fields are available if you purchased Sage 100 through a 
subscription plan; otherwise, you’ll still have the Days to Retain Paid Invoices 
field. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

1099-NEC Form Added

The IRS is introducing Form 1099-NEC, used to report nonemployee compensation, for 
tax year 2020. Nonemployee Comp (to be used for Form 1099-NEC) is now available to 
select in the following locations:

 l Vendor Maintenance — Default Form field on Additional tab

 l 1099 Payment History window — 1099 Form Type field

 l A/P Invoice Data Entry — (1099 Payment) Form field on the Header tab

 l Manual Check and Payment Entry — 1099 Form field on the Lines tab

Because From 1099-NEC is now used for nonemployee compensation, changes have 
been made to Form-1099 MISC. Included in the changes, Box 7 is now used for the 
Payer Made Direct Sales of $5,000 or More check box. For more details on the form 
changes, see the IRS website: www.irs.gov/instructions/i1099msc

In Vendor Maintenance, the Misc Box 9 check box has been renamed Payer Made Direct 
Sales $5000+. This check box is now used for Box 7 on Form 1099-MISC. 

If you’ve already recorded nonemployee compensation for tax year 2020 in Box 7, a utility 
is available to more the totals to Box 1. Contact Sage Support for more information. 

Unlimited Cost Types in Open Invoice By Job Report

You are no longer limited to selecting only 12 cost types when printing the Open Invoice 
by Jobs Report. In the Cost Types to Print section of the task window, the check boxes for 
individual cost types have been replaced with a Select Cost Types button. Click this 
button to open the Cost Type Selection window and select all cost types needed for the 
report.
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Relocation of Paperless Option in Vendor Maintenance

To access the Paperless Office Delivery Options window from Vendor Maintenance, click 
the arrow in the top-right corner of the window, and then select Paperless Delivery 
Options.

Accounts Receivable

The following changes were made in the Accounts Receivable module.

eInvoicing for Accounts Receivable Invoices

Through the eInvoicing feature that works with Paya Connect Desktop, you can send your 
customers emails that include an invoice summary and a link for online payments. 
Customers can use the payment link to make online credit card and ACH payments. If 
you’re using Paperless Office for invoicing, the invoice PDF is attached to the email. After 
customers make online payments, you can import them into Cash Receipts Entry.

There are two ways to enable eInvoicing for customers:

 l To enable the feature for an individual customer, select the eInvoice Payments check 
box on the Additional tab in Customer Maintenance. 

 l To enable the feature for a range of customers, use the Global Customer Field 
Change utility.

An eInvoice Payments check box has been added to the Header tab in Invoice Data 
Entry. The check box is selected by default if the eInvoice Payments check box in 
Customer Maintenance is selected, but you can clear it as needed. 

If the check box is selected, the invoice information is sent to Paya when the Sales 
Journal is updated, and the email with the invoice information and Pay Now link is then 
sent to the customer. 

An eInvoice Payments button has been added to the Cash Receipts Deposit window. 
Click this button to import online payments. 

A merchant account with Paya (formerly Sage Payment Solutions) is required to use 
eInvoicing. Paya will provide you with a user ID and API key, which you must enter in 
System Configuration. 
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Next, enable the feature in Company Maintenance, and then you can enable it for 
customers in Customer Maintenance. For more information, see the eInvoicing article in 
the Sage 100 help. 

A utility, eInvoicing Error Log Viewer, has been added to the Accounts Receivable 
Utilities menu. After you update the Sales Journal, a message lets you know if there were 
any invoices that should have been sent to Paya Connect but were not. Use the viewer to 
see which invoices were not sent, view error information, and send the invoices to Paya 
Connect. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Viewing Addresses in Invoice History Inquiry

In Invoice History Inquiry, the address no longer appears on the Main tab. Click the new 
Addresses button to view the bill-to and ship-to addresses for the invoice.

New Options for Retaining Paid Invoices

Two new fields have been added to the Additional tab in Accounts Receivable Options:

 l Months to Retain Paid Invoices (replaces Days to Retain Paid Invoices)

 l Purge Paid Invoices During

You can enter a value ranging from 0 to 9,999 in the months field, and select whether 
paid invoices are purged during period-end or year-end processing.

Note: These fields are available if you purchased Sage 100 through a 
subscription plan; otherwise, you’ll still have the Days to Retain Paid Invoices 
field. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Encrypt PII for Inactive Customers

As a means to comply with consumer privacy laws that require you to either delete or 
deidentify personally identifiable information (PII) so that it can’t be used to identify an 
individual, there are two ways to encrypt an inactive customer’s PII:
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 l An Encrypt button has been added to the Additional tab in Customer Maintenance.

 l An Encrypt Customer Personally Identifiable Information utility has been added to the 
Accounts Receivable Utilities menu. You can use this utility if the customer’s record 
has been deleted in Customer Maintenance. 

After PII is encrypted, it no longer appears in task windows or reports. Furthermore, the 
data cannot be viewed in Data File Display and Maintenance or accessed through Visual 
Integrator or external reporting using an ODBC data source. For more information, see 
Encryption for Inactive Customers' Personally Identifiable Information in the help.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Relocation of Paperless Option in Customer Maintenance

To access the Paperless Office Delivery Options window from Customer Maintenance, 
click the arrow in the top-right corner of the window, and then select Paperless Delivery 
Options.

Custom Office

The following changes were made in the Custom Office module.

Improved Grid Customization

When you’re editing a panel with a grid, right-clicking within the grid now opens the 
Customize Grid Definition window. The appearance of the grid is virtually identical to its 
appearance in Sage 100 task windows. As you edit the grid 

 l Drag and drop columns to rearrange them. 

 l If the panel has a primary and secondary grid, drag and drop columns to move them 
from one grid to another. 

 l Click a column label to open the Column Properties window, which lets you specify 
various properties, such the column length and description, and whether it’s locked. 

 l Click the Add Column button to add additional columns. 

 l Access the Bulk Hide window, which lets you set the Hidden option for all columns in 
the grid. 
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Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Apply Grid Customizations to a Customization Group

When selecting a customization group from the User list in the Customizer Panel 
Selection window, you can now customize the grid(s) included in the panel. The 
customized grids will be available to all users in the customization group. 

Save UDF Changes in Pending Status

It’s no longer necessary to choose between updating your user-defined field (UDF) 
changes right away or discarding them. UDF additions and modifications are now saved 
in a pending table. In the User-Defined Fields window, when you click Cancel, a message 
will let you know that your changes have been saved. You can return to the User-Defined 
Fields window at a later time to continue working on your changes and update them when 
you’re ready. 

A new task, Pending Changes Summary, has been added to the Custom Office Main 
menu. You can also access this task by clicking the Summary of Pending Changes button 
in User-Defined Field and Table Maintenance. 

Use this task to view a list of pending changes. Click the Update All button to update all 
changes. If you have changes for multiple tables, a message appears after each table 
has been updated. You can click Continue to update the remaining tables or click Stop to 
leave the remaining changes in pending status to be updated at a later time. 

When you have changes in pending status, a Pending folder appears beneath the 
module list in User-Defined Field and Table Maintenance. Expand the folder to view a list 
of tables with pending changes. You can select a table and click the Delete Pending 
Changes button to delete all pending changes for the table. 

You can schedule an update of the pending changes using Task Scheduler. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.
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Mask Information in Data Entry Fields

A Mask Display check box has been added to the Options tab in the Multi-Line Definition 
window. Select this check box to display filled-in circles in place of the actual characters 
when data is entered into this field. 

Note that the data is not encrypted and it is masked only when displayed in task windows. 
For example, the actual characters would appear if this field is added to a lookup view or if 
you viewed the table in Data File Display and Maintenance. 

A Mask Display check box has also been added to the Add/Edit Field window. If you 
select this check box, the Mask Display check box in the Multi-Line Definition window is 
selected by default when you add the UDF to a panel. 

Inventory Management

The following changes were made in the Inventory Management module.

Expiration Dates for Lot and Serial Items

Expiration dates can be added for items with lot or serial numbers when items are 
received into inventory or produced through Bill of Materials. Expiration dates can be 
manually entered, or you can enter settings to automatically calculate them. You can also 
calculate sell-by, use-by, and return dates to determine how many days before or after an 
item's expiration date it can be distributed. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

The expiration date feature must be enabled in Inventory Management Options, and the 
related settings are entered in this task. However, you can override the settings for 
product lines and individual items in Product Line Maintenance and Item Maintenance. 

For more information, see Set Up Expiration Dates for Lot and Serial Items in the Sage 
100 2020 help.

Utility for Adding and Changing Expiration Dates

The Change Lot and Serial Expiration Dates utility has been added to the Inventory 
Management Utilities menu. Use this utility to add expiration dates for existing items and 
to change any expiration dates that have already been entered. 
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Note: Before using the utility, you must:

 l Enable the expiration date feature in Inventory Management Options.

 l For applicable items, select the Track Lot/Serial Expiration Date check box in 
the Lot/Serial Expiration Settings window, accessed using the More button in 
Item Maintenance. 

For more information, see Change or Add Expiration Dates for Lot and Serial Items in the 
Sage 100 help. 

Change Lot/Serial Expiration Date from Item Maintenance

To change expiration dates for lots or serial numbers one at a time, click the Change 
Lot/Serial Expiration Date button, which has been added to the Cost Detail tab in Item 
Maintenance.

Option to Exclude Expired Items From Reorder Calculations

An Include All Expired Lot/Serial Items in Quantity Available check box has been added 
to the following windows:

 l Auto Reorder Selection (Purchase Order)

 l Inventory Reorder Report (Inventory Management)

You can clear this check box to exclude expired items from the calculation of the 
available quantity. 

Forms, Reports, and Registers

A new report, Lot Serial Expiration Status Report has been added to the Inventory 
Management Reports menu. Use this report to view a list of items' expiration dates. You 
can also use the report to view a list of items that are missing an expiration date or a list of 
items that are expired as of a specified date.

The expiration date is printed on the reports and registers listed later in this section if the 
Track Lot/Serial Expiration Dates check box is selected in Item Maintenance. 

If applicable, the expiration date prints on the following registers:
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 l Bill of Materials registers:

 l Production Register

 l Disassembly Register

 l Inventory Management registers:

 l Transaction Register

 l Physical Count Variance Register

 l Count Card Variance Register

 l Purchase Order registers:

 l Receipt of Goods Register

 l Return of Goods Register

 l Material Requisition Register

If applicable, the expiration date is printed on the following reports:

 l Bill of Materials reports

 l Production History Report

 l Inventory Management 

 l Inventory Detail Transaction Report

 l Lot/Serial Transaction History Report

 l Purchase Order 

 l Receipt History Report (if the Print Lot/Serial Information check box is 
selected)

 l Return Merchandise Authorization reports (if the Print Lot/Serial Information check 
box is selected)

 l Return Reason Report

 l RMA Receipts History Report

 l Sales Order reports (if the Print Lot/Serial Distributions check box is selected)

 l Shipping History Report

 l Open Sales Order Report 

 l Open Sales Order by Item Report 

 l Open Sales Order by Promise Date Report
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 l Open Sales Order by Job Report 

 l Lot and Serial Number History Report 

The expiration date has been added to the worktables for the following forms to make it 
easier to add the field to the forms if needed.

 l A/R invoice (historical)

 l B/M production label

 l I/M receipts label

 l P/O return order

 l R/A customer RMA

 l R/A RMA receiver

 l S/O sales order

 l S/O picking sheet

 l S/O invoice

 l S/O packing list

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Job Cost

The following changes were made in the Job Cost module. 

Option for Expensing Work-In-Process Costs

A new field, Recognize WIP when Billing % Complete Jobs, has been added to the Main 
tab in Job Cost Options. This field is available when the (Post to General Ledger) Work in 
Process check box is selected. 

There are two options available in this field:

 l Select Actual Costs to expense WIP costs using actual costs posted to the job that 
have not been previously billed as of the job billing date.

 l Select % of Estimate to expense the WIP costs as cost of goods sold by multiplying 
the revised estimated cost by the job's completion percentage less the previously 
recognized estimated costs.
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After converting company data from an earlier version of Sage 100, the default selection 
is Actual Costs. For new companies, the default selection is % of Estimate.

If you change the selection in this field, and there are open jobs that have been billed 
using the original method, the next time you process an invoice in which WIP is accrued, 
that accrual will include a reversal for costs recognized when you were using the 
previously selected WIP accrual method. Consider processing a zero-dollar invoice after 
making the change to process the reversal.

Actual % Complete Field

A new field, Actual % Complete, has been added to the locations listed below so that you 
can enter the job’s completion percentage when processing invoices for the job. 

 l S/O Invoice Data Entry Header tab

 l Shipping Data Entry Shipping tab

This field is available if:

 l The Job Cost module is integrated with Sales Order.

 l In Job Cost Options, % of Estimate is selected in the Recognize WIP when Billing % 
Complete Jobs field.

 l In Job Maintenance, for the selected job, Percentage of Completed is selected in the 
Acct Method field, and Fixed is selected in the Billing Method field. 

A view-only Job No. field has also been added to the Shipping tab in Shipping Data Entry. 

eInvoicing for Job Cost Invoices

Through the eInvoicing feature that works with Paya Connect Desktop, you can send your 
customers emails that include an invoice summary and a link for online payments. 
Customers can use the payment link to make online credit card and ACH payments. If 
you’re using Paperless Office for invoicing, the invoice PDF is attached to the email. After 
customers make online payments, you can import them into Cash Receipts Entry.

An eInvoice Payments check box has been added to the Header tab in Job Billing Data 
Entry. The check box is available and selected by default if the eInvoice Payments check 
box in Customer Maintenance is selected, but you can clear it as needed. 
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If the check box is selected, the invoice information is sent to Paya when the Job Billing 
Register is updated, and the invoice is then emailed to the customer. For more 
information, see the eInvoicing article in the Sage 100 help. 

A merchant account with Paya (formerly Sage Payment Solutions) is required to use 
eInvoicing. Paya will provide you with a user ID and API key, which you must enter in 
System Configuration. Next, enable the feature in Company Maintenance, and then you 
can enable it for customers in Customer Maintenance. For more information, see the 
eInvoicing article in the Sage 100 help. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Library Master

The following changes were made in the Library Master module.

Conversion Options

Two new options in the Convert Module Data Files window allow you to do more when 
converting company data.

Convert SAP Crystal Reports

If you select the Convert SAP Crystal Reports check box, the custom reports and forms 
for active modules are converted to the current level when you run conversion. 

After the company data conversion is complete, anyone logged into Sage 100 can 
continue working while the reports and forms are being converted. 

The amount of time needed to convert company data is not affected by the SAP Crystal 
Reports conversion. 

Update Custom Office Panels to Current Level

If you select the Update Custom Office Panels to Current Level check box, the Custom 
Office panel update is run for any customized panels for the companies being converted. 
This update runs without any prompts.

Purchase Order

The following changes were made in the Purchase Order module.
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Apply Multiple Purchase Orders to An Invoice or Receipt

In Receipt of Invoice Entry and Receipt of Goods Entry, an Apply Purchase Orders button 
has been added next to the Purchase Order Number field on the Header tab. After 
selecting the first order for the invoice or receipt, click this button to add additional orders. 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

The first purchase order applied is considered the primary order. To add additional 
orders, the information in the following fields must match:

 l Terms code 

 l Sales tax schedule for purchase order 

 l Sales tax schedule for purchase address 

 l Shipping code (entered in Ship Via field) 

Reports, Forms, and Registers

The documents listed below have been modified to display "Multiple" in the purchase 
order number field if more than one order has been applied to the applicable document. 

 l Receipt of Goods Register

 l Receipt of Invoice Register

 l Daily Purchases Journal

 l Receipt History Report

 l A/P Invoice History Report

Inquiry Windows 

In Receipt History Inquiry and A/P Invoice History Inquiry, "Multiple" appears in the 
purchase order number field if multiple purchase orders were applied to the receipt or 
invoice. You can click the Multiple Purchase Orders zoom button to view a list of orders 
applied to the document. 

In both inquiry windows, if multiple purchase orders with prepayments were applied to the 
receipt or invoice, the total prepayment amount from all orders appears in the prepayment 
field. You can click the Prepayments button to view a list of applied purchase orders, 
along with the prepayment amount and check number. 
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Landed Cost Calculation 

If entry of landed cost is enabled in Purchase Order Options and Automatic Update is 
selected for the FRGHT cost type in Landed Cost Maintenance, the landed cost for all 
purchase orders applied to a receipt of goods is totaled and allocated to each line item. 

If entry of landed cost is not enabled, the freight amount for all orders applied to the 
receipt is totaled and allocated to each line item based on the selection in the Allocate 
Freight on a Line Item Basis field in Purchase Order Options. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Sales Order

The following changes were made in the Sales Order module.

eInvoicing for Sales Order Invoices

Through the eInvoicing feature that works with Paya Connect Desktop, you can send your customers 
emails that include an invoice summary and a Pay Now link. Customers can click the Pay Now link to make 
online credit card and ACH payments. If you’re using Paperless Office for invoicing, the invoice PDF is 
attached to the email. After customers make online payments, you can import them into Cash Receipts 
Entry.

An eInvoice Payments check box has been added to the Header tab in Invoice Data 
Entry. The check box is available and selected by default if the eInvoice Payments check 
box in Customer Maintenance is selected, but you can clear it as needed. 

If the check box is selected, the invoice information is sent to Paya when the Sales 
Journal is updated, and the invoice is then emailed to the customer. For more 
information, see the eInvoicing article in the Sage 100 help. 

A merchant account with Paya (formerly Sage Payment Solutions) is required to use 
eInvoicing. Paya will provide you with a user ID and API key, which you must enter in 
System Configuration. 

Next, enable the feature in Company Maintenance, and then you can enable it for 
customers in Customer Maintenance or by using the Global Customer Field Change 
utility. For more information, see the eInvoicing article in the Sage 100 help. 
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Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Visual Integrator

The following changes relate to the Visual Integrator module.

Change for Import Jobs that Include Addresses

Any import jobs that include address information must be modified to include the 
CountryCode column, and it must be imported before the ZipCode column. This 
requirement is related to changes made to support international addresses. For more 
information, see "International Address Support" (page 99).

Office 365 Integration

A new screen has been added to the Sage 100 Office Configuration wizard. On the 
Microsoft Power Apps and Power Automate screen, if you select the check box, the 
information needed to create a custom connector appears on the last page of the wizard. 

The same information is automatically copied to the Windows clipboard so that you can 
paste it into a document to reference when setting up your custom connector. This is 
required if you plan to use Power Automate or Power Apps that work with your Sage 100 
data. 

Retired Features

The following features are no longer available in version 2020.

Classic Desktop

The classic version of the Sage 100 Desktop is no longer available. To learn more about 
the standard version of the Desktop, refer to the following resources:

 l To watch a video providing an overview of the standard Desktop, click the Help tab at 
the top of the Desktop, and then click Tour the Desktop.

 l To read detailed instructions on using and customizing the Desktop, see the  Getting 
Started Guide, which is available on the Sage 100 documents page. 

If you were using the classic Desktop and had created public or private tasks or 
customized the button bar, you can run a utility to add those tasks and/or programs to the 
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Favorites panel in the standard Desktop. For more information, see "Customization 
Import" (page 103).
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Changes in Version 2019

This chapter describes the changes made in the Sage 100 2019 release and the 
subsequent updates for that version. Installation and global changes are listed first 
followed by module changes, third-party features, and then retirements.

Global
Global changes are carried throughout multiple modules. 

The following changes were made in version 2019.2. 

Automatic Update of Daily Transaction Register

A security event has been added to Role Maintenance that allows you to automatically 
update the Daily Transaction Register. For any series of journal and register updates that 
concludes with the Daily Transaction Register, you will not receive a prompt to print and 
update the register if the security event check box is selected for your role. The Daily 
Transaction Register will be printed and updated automatically. 

The security event has been added for the following modules:

 l Accounts Payable

 l Accounts Receivable

 l Bank Reconciliation 

 l Bill of Materials

 l Inventory Management

 l Job Cost

 l Purchase Order

 l Sales Order

 l Work Order
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Warning Message for Document Dates

A Use Document Date Warning check box has been added to the Preferences tab in 
Company Maintenance. After selecting this check box, you can enter a value in one or 
both of the following fields:

 l Document Date - Prior Periods to Allow Outside of Current Period 

 l Document Date - Future Periods to Allow Outside of Current Period

These values are compared to the current period entered in the module's Options task to 
determine when a date falls outside of the valid date range. Alternately, in Bill of 
Materials, Inventory Management, Purchase Order, Return Merchandise, and Sales 
Order, the values are compared to the current calendar month and year if Calendar 
Months is selected in the Base Inventory Periods On field in Inventory Management 
Options. 

If you start to create a document with a date that falls outside of the valid range, you'll 
receive one of two messages:

 l If you're using the default date for that session, a warning message appears, and you 
can click OK to continue. 

 l If you manually enter the date, a warning message asks if you want to proceed. If you 
click Yes to continue with the date entered, a record is written to the Activity Log. 

If you import records with a document date falling outside of the specified range through 
Visual Integrator, a warning is written to the Import Log.

Document dates are checked in the following tasks:

 l Bank Reconciliation

 l Reconcile Bank

 l Check Deposit and Adjustment Entry

 l Bill of Materials

 l Disassembly Entry

 l Production Entry

 l Accounts Payable

 l Invoice Data Entry

 l Repetitive Invoice Selection
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 l Manual Check and Payment Entry

 l Accounts Receivable

 l Invoice Data Entry

 l Cash Receipts Deposit

 l Repetitive Invoice Selection

 l Inventory Management 

 l Transaction Entry

 l Job Cost

 l Job Billing Selection

 l Purchase Order

 l Material Requisition Issue Entry

 l Purchase Order Entry

 l Receipt of Goods

 l Receipt of Invoice Entry

 l Return of Goods 

 l Return Merchandise Authorization

 l Generate Transactions

 l RMA Entry

 l Receipts Entry

 l Sales Order

 l Sales Order Entry

 l Invoice Data Entry 

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Links to Sage University Training

A Sage University button (with a graduation cap icon) has been added to additional 
Purchase Order and Sales Order task windows. Click the button to view a list of training 
videos related to the task. Depending on your Business Care plan, there may be no 
charge to watch the videos. 
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The following changes were made in version 2019.1. 

View Paperless Documents from Journal Drill Down Window

A Paperless Viewer button has been added to the Journal Drill Down window. If you've 
set up Paperless Office and have the appropriate security setup, you can click the button 
to open the Journal and Register Viewer. The button is available when you access the 
Journal Drill Down window from the following tasks:

 l A/P Invoice History Inquiry

 l A/P Payment History Inquiry

 l A/R Invoice History Inquiry

 l G/L Account Maintenance/Inquiry

 l G/L Source Journal Maintenance

 l I/M Item Maintenance/Inquiry

 l P/O Receipt History Inquiry

Links to Sage University Training

A Sage University button (with a graduation cap icon) has been added to additional task 
windows. Click the button to view a list of training videos related to the task. Depending 
on your Business Care plan, there may be no charge to watch the videos. 

The following changes were made in version 2019.

Auto-Complete for Account Numbers

The auto-complete feature has been added for general ledger account number fields. 
You can now search for an account by entering any of the following in an account number 
field:

 l Account number

 l Main account

 l Account description

 l Account group

As you type, a list of accounts matching your entry appears, and you can select one from 
the list. 
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This feature is automatically enabled for all users. You can disable the feature for 
individual users in Library Master > User Maintenance. 

To enable this feature, run the Build Search Index utility on the Library Master Utilities 
menu to create an index. As you add accounts, you’ll need to run the utility again to index 
the new records.

Print Status Updated When Using Keep Open Check Boxes

In the tasks listed below, when you print a document while the Keep Window Open After 
Print or Keep Window Open After Preview check box is selected, the document’s print 
status will reflect that the document has been printed. Previously the document’s print 
status would have been set to not printed. 

 l Invoice Printing (Job Cost)

 l Purchase Order Printing

 l Return Order Printing

 l Sales Order Printing

 l Picking Sheet Printing

 l Shipping Label Printing

 l Invoice Printing (Sales Order)

Security Update for E-mail Delivery

Transport Layer Security (TLS) 1.2 is now supported when sending e-mails through 
Paperless Office and eBusiness Manager.

Message Enhancements

Some message windows now have a More Info link. When you click this link, you will see 
another message with additional information or a related help article.

When you’re opening a task and a message appears indicating that a file is locked, you 
can click More Info to see who has the file locked and in which task.

Copy Feature for Custom Lookup Views

A Copy button has been added to the User Lookup Wizard. You can now copy a custom 
lookup for other companies and users. Also, selecting companies and users is now 
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easier—check boxes have been added to the company and user list.

Links to Sage University

A Sage University button (with a graduation cap icon) has been added to additional task 
windows. 

You can click the button to view a list of training videos related to the task. Depending on 
your Business Care plan, there may be no charge to watch the videos.

The Sage University button has been added to the tasks windows listed below. 

 l Accounts Payable

 l ACH Maintenance

 l Expense Distribution Table Maintenance

 l Invoice Payment Selection

 l Repetitive Invoice Selection

 l Vendor Maintenance

 l Accounts Receivable

 l Cash Receipts Entry

 l Commission Edit Maintenance

 l Customer Maintenance

 l Invoice Printing

 l Repetitive Invoice Entry

 l Repetitive Invoice Selection

 l Salesperson Maintenance

 l Bank Reconciliation

 l Auto Check Reconciliation

 l Bank Code Maintenance

 l Check, Deposit and Adjustment Entry

 l Positive Pay Export 

 l General Ledger 

 l Transaction Journal Entry
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 l Job Cost

 l Contractor Maintenance

 l Job Maintenance

 l Library Master 

 l Activity Log

Payroll Module Removed from Installation Program

The Payroll module is no longer part of the Sage 100 installation program. To install the 
module, use the standalone installation program. For information on installing the Payroll 
module, see the Sage 100 Payroll Installation and Upgrade Guide. The guide is available 
online at: http://cdn.na.sage.com/docs/en/customer/100erp/Documentation.htm

Custom Office
You can now customize the columns and buttons on the following Paperless Office 
viewers:

 l Journal and Register Viewer

 l Period End Report Viewer 

 l Report Viewer

General Ledger
The following changes were made in the General Ledger module.

Consolidate Journal Entries in General Journal PDF

When printing the General Journal and selecting PDF output, you can now consolidate all 
General Journal entries into one PDF. A module option, Print Multiple PDFs for General 
Journal, has been added in Role Maintenance. Clear the check box for this option to 
consolidate the entries. 

Account Appears on All Pages of Detail Reports

The account number and description are now printed on each page of the General 
Ledger Detail Report and General Ledger Detail by Source Report. 
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Inventory Management

Encrypted Bank Information

Bank descriptions and account numbers are now encrypted. Bank descriptions are still 
visible in windows and on reports and forms. 

A new security event, “Allow Viewing, Printing and Editing of Highly Sensitive Personally 
Identifiable Information,” determines whether users will be able to view and print bank 
account numbers.

For more information, see Additional Security for Bank Information in the help. 

Inventory Management 
The following changes were made in the Inventory Management module.

Option to Include Inactive Items in Physical Count

An Include Inactive Items check box has been added to the Physical Count Worksheet 
task window. If you select this check box, inactive items are printed on the worksheet and 
included in Physical Count Entry and on the Variance Register. If the check box is 
cleared, inactive items are excluded from the physical count process.

Option to Print Variances Only

An Only Print Variances on Register check box has been added to the Physical Count 
Variance Register task window. If you select this check box, all items for which there is no 
variance are omitted from the register. 

Item Quantity Inquiry Button in Physical Count Entry

An Item Quantity Inquiry button has been added to the Lines tab in Physical Count Entry. 
Click this button to view quantity information for the selected item.

You can click the arrow next to this button and select Item Inquiry to open the Item Inquiry 
window, or select Item Memo to view, create, or maintain memos for the selected item. 

Note: To see the Item Memo option, it must be enabled in Memo Manager 
Maintenance:
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 1. Select Inventory Management > Setup > Memo Manager Maintenance.

 2. In the Memo Type field, select Item.

 3. Select a role. 

 4. To add Physical Count Entry to the Task list, click the Reset All to Defaults button.

 5. For Physical County Entry, in the Memo option column, select Show or Maintain. 

Library Master
The following changes were made in the Library Master module.

Data File Display and Maintenance

Data File Display and Maintenance has been upgraded with several new features. 

 l If you’re using Sage 100 Premium, you can now access files stored in a SQL 
database. 

 l To select a file in the File Name field, you can enter the company code, followed by a 
colon, followed by the file name. For example: ABC:AR_Customer

 l For files in modules upgraded to Business Framework, the Data File Display and 
Maintenance – Edit window now lists all fields and values in a grid. 

Encrypted fields are not available to edit, but you can select the Allow Read-Only 
Fields to Be Changed check box to edit the read-only fields. 

Validation is now performed on date and numeric fields. 

 l For multi-segment keys, the key scan filter allows you to filter the records using one 
or more segments of the key. Enter the selected key column separators as needed to 
indicate which segments of the key your search criteria must match. 

For example, the key for customer records is ARDivisionNo:CustomerNo. To search 
for customer number 02-CAPRI, you can enter the following in the Key field:

:CAPRI

Alternately, you can select a different character to separate the segments of the key 
in the Key Column Separator field. If you select the tilde (~) character, you can then 
search by entering the following in the Key field:

~CAPRI

Note that you don’t need to enter the full value contained in the segment. Continuing 
with the above example above, you could also enter the following:
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~CAP

You can filter by multiple segments. For example, to view records in the GL_
DailyPosting file from 2018 with AP as the source journal, enter the following in the 
Key field:

2018:AP

 l For modules that have been upgraded to Business Framework, you can click Add to 
add a record. 

 l If you adjust the width of the Data File Display and Maintenance – Key Scan window, 
and then close the window to run a second scan, the window reopens at the width 
that you used previously. The Key and Data columns are automatically adjusted to fill 
the width of the window. 

 l In the Data File Display and Maintenance – Key Scan window, when entering search 
criteria in the Search field, you can use a special character to define the scope of the 
search:

 l To search for text in any location within the current key, add an asterisk (*) 
at the beginning of your search text. For example: *14072

 l To search for text within the current key and the data record, add a percent 
symbol (%) at the beginning of your search text. For example: %14072 

 l The Print button has been removed. 

When starting Data File Display and Maintenance using the Run Program window 
accessed on the File menu, you can now enter SY_FileDisplay_UI. 

Activity Log

The following changes have been made to the Activity Log:

 l Changes made in Role Maintenance and User Maintenance are now tracked. A new 
activity type, Security, has been added and is used to categorize these changes. 

 l You now have the option to track changes in Company Maintenance and System 
Configuration. For more information, see "Activity Log Configuration Window" (page 
130).

 l To improve performance, there is now a configurable limit on the number of records 
that display when you open the Activity Log window. If the number of records in the 
log file exceeds this threshold, the Activity Log / window automatically opens before 
any records are loaded. Use the Activity Log - Filter window to filter the records and 
then view them in the Activity Log window.
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To change the auto-load threshold, click the Configure button on the Activity Log 
window. 

 l A Cancel button is now available while the progress bar indicates that records are 
loading so that you can cancel the process if needed. 

 l A Refresh button has been added to the window. Click this button to reload the 
records, including any new ones created after you started the session.

 l The newly added first column in the grid contains an asterisk (*) if a log file is 
available for the record.

 l The Purge button now appears below the list of records. Also, a purge utility has 
been added to the Utilities menu. For more information, see "Activity Log Purge 
Utility" (page 130).

 l When purged, records are either deleted or added to an archive file based on 
settings in the Activity Log Purge Configuration window. 

 l You can view purged records stored in an archive file by clicking the History button 
and, in the Select Archive Year window, selecting a year. Archived records from that 
year are then displayed in the Activity Log window. 

Activity Log Configuration Window

The Activity Log Configuration Window, accessed by clicking the Configure button in the 
Activity Log window, allows you to set various options. You can use this window to:

 l Control how many records are loaded by default, either by entering a value or setting 
a date range. 

 l Specify whether to track changes made in Company Maintenance and System 
Configuration. 

 l Specify how data is purged. 

 l Specify what information is recorded when errors occur in Sage 100.

For more information, refer to the on-screen help that appears at the bottom of the 
configuration window when you click one of the rows. 

Activity Log Purge Utility

You can use the Activity Log Purge utility to purge records from the Activity Log file. To 
access the utility:  
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 l Click the Purge button on the Activity Log window.

 l Select the task on the Library Master Utilities menu. 

When purged, records are either deleted or added to an archive file based on settings in 
the Activity Log Purge Configuration window, which is described in more detail in the next 
section. You can schedule automatic purges using Task Scheduler. Archive files are 
stored here: ..\MAS90\MAS_System\Archive  

Activity Log Purge Configuration Window

Click the Activity Log Purge Configuration button to open the configuration window. Use 
this window to control how many records are loaded by default and specify how data is 
purged.

Note that the default setting for the Minimum Days to Keep field is 365; therefore, the 
Records to Purge list may be empty when you initially start the utility. 

Activity Log Filter Window

The Activity Log Search window has been renamed Activity Log Filter. In addition, the 
following changes have been made:

 l You can filter records by company code and module code.

 l You can enter search text to filter records by the text in the Description column.

 l File Display/Maintenance and Visual Integrator have been added as options to filter 
records. 

Activity Log Report

The following changes were made to the Activity Log Report task window:

 l An Archive Year field has been added to the Activity Log Report. If you have archived 
records, you can select a year in this field, and only the archived records from that 
year are included in the report. 

 l To include unarchived records on the report, select Current Activity in the Archive 
Year field.

 l You can filter the report by module using the Module Code fields in the Selections 
grid.
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User ID Field Expanded

The User ID field on the E-mail tab in Company Maintenance has been expanded to hold 
254 characters. 

Keep Window Open Check Box in Rebuild Key Files

A Keep Window Open check box has been added to the Rebuild Key Files window. If you 
select this check box, the window remains open after you rebuild files, but the company, 
module, and file selections are cleared. 

Paperless Office
The following changes were made in the Paperless Office module.

Text Formatting Options for Messages

A new message editor has been added to Electronic Delivery Message Maintenance and 
to the Edit Message window accessed through the Customer, Employee, and Vendor 
Viewer windows. The editor features a tool bar with text formatting options, including the 
ability to:

 l Change the text color, font, and size

 l Use bold or italic text

 l Create bulleted and numbered lists

 l Insert links and images

Square Brackets Replace Angled Brackets for Merge Fields

Previously the merge fields were enclosed in angled brackets (< >). However, the new 
message editor is HTML based, and angled brackets are reserved for a specific purpose 
in HTML. Therefore, square brackets ( [  ] ) are now used to enclose the merge fields. 

If you have existing messages that contain merge fields in your earlier version of Sage 
100, the angled brackets will be replaced with square brackets when you convert your 
data. For example, <DocumentNo> will be converted to [DocumentNo]. 
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If you have message fields that contain an angled bracket that is not being used to 
enclose a merged field, the bracket is not converted, and an entry is written to the 
Conversion Log.

Angled brackets used for merge fields in the Subject field are also converted, but the 
Subject field does not support formatted text; only plain text is allowed. 

Be sure to test any messages that were saved in your prior version of Sage 100 after 
converting your data. 

Size of Message Field Increased

The message field holds 7168 characters, increased from 4096. However, the special 
characters used in the HTML code count toward this limit. 

New Merge Fields

Three new merge fields have been added in Electronic Delivery Message Maintenance: 

 l [CustomerPoNo] for sales orders and Accounts Receivable and Sales Order invoices

 l [InvoiceDueDate] for invoices 

 l [ShipDate] for sales orders and Sales Order invoices

The merge fields are available depending on which module and document is selected. 

Also a Copy Merge Field to Clipboard button has been added to the window. Click this 
button to copy the selected merge field to the Windows clipboard and then paste it in 
multiple locations.

Cc and Bcc Options for E-mail Address

You can now specify whether the e-mail addresses used when e-mailing documents are 
added to the To, Cc, or Bcc field when e-mails are sent. 

In the locations listed below, a Recipient field has been added; use this field to select To, 
Cc, or Bcc. 

 l Paperless Office Delivery Options (accessed from Customer Maintenance and 
Vendor Maintenance)

 l Electronic Delivery (accessed from the customer, employee, and vendor viewers)

 l Paperless Office Selection (accessed from all reports supported by Paperless Office)
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When converting data, To is automatically selected in the Recipient field for the existing 
e-mail addresses.

In the Paperless Office Delivery Options window accessed through Employee 
Maintenance, the E-Mail Address field has been relabeled as the To field, and Cc and 
Bcc fields have been added. When converting data, existing e-mail addresses are added 
to the To field.

E-mail addresses entered in the Cc and Bcc fields are included in the customer, 
employee, and vendor listings if the option to print Paperless Office delivery options is 
selected. 

Additional Attachments When Emailing Forms

In the Electronic Delivery for Forms window, you can now select additional attachments 
to include when emailing forms. You can select multiple attachments, and there is no 
restriction on the file type. 

PDF File Name Options

A PDF File Name field has been added in Form Maintenance. In this field, if you select 
Document No., the document number is used as the file name for the PDF that is 
attached to the email. The full description is still used for the PDF file that is stored in the 
PDF directory. 

If you select Full Description, the file name will vary depending on the document type. 
The file naming convention for this option is the same that was used in earlier versions of 
Sage 100. 

Option to Copy Salespeople When E-mailing Forms

A Paperless button has been added in Salesperson Maintenance. Click this button to 
open the Electronic Delivery Options window and specify whether the salesperson will 
receive a copy of orders, invoices, and statements when they are e-mailed to customers 
from data entry, inquiry, and history tasks. 

Search by Posting Date in Journal and Register Viewer

A Posting Date column has been added to the list box in the Journal and Register Viewer. 
When you click the Search button, you can include a posting date or range of posting 
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Purchase Order

dates in the search criteria.

Updated Printer Driver

The Amyuni PDF Converter, the virtual printer driver used to create PDF documents, has 
been updated to version 6.0.1.1.

Purchase Order
The following changes were made in the Purchase Order module.

Change for Drop-Ship Purchase Orders 

In Purchase Order Entry and Receipt of Invoice Entry, if Drop Ship is selected in the 
Order Type field, the Work Order field on the Lines tab is not available. 

When copying from a purchase order in Purchase Order Entry, if Drop Ship is selected in 
the Order Type field for the new purchase order, no history or work order information is 
copied from the source document. 

Data Conversion

When converting your data after upgrading to version 2019, work order fields for drop-
ship inventory lines and the corresponding history detail lines are cleared in purchase 
order and receipt of invoice records. History detail records that do not have corresponding 
data entry records are not affected. 

Sales Order
The following changes were made in the Sales Order module in version 2019.1.

Add Tracking Number to Email Messages

In Electronic Delivery Message Maintenance, when you're creating a message for a 
Sales Order invoice, you can add the tracking number to the subject or the body of the 
message. To add the tracking number, insert the new TrackingNo merge field.

If you add the tracking number to the subject, they are displayed in plain text and multiple 
tracking numbers are separated by commas. In the body of the message, the tracking 
numbers are links that the recipient can click to track the shipment.
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Upgrade Checklists

These checklists provide instructions for migrating your data from your older Sage 100 
installation and then upgrading the data to version 2025.

If you haven’t already, follow the instructions in the Sage 100 2025 Installation and 
System Administrator’s Guide to install and set up Sage 100 2025. The guide is in the 
Documents folder accessible within the installation program, and it’s also available on the 
Sage 100 Documents page.  

The data upgrade process consists of three steps:

 1. Preparing your data for upgrading

 2. Migrating your data to your version 2025 installation

 3. Converting your data to version 2025

This guide contains the information you'll need to migrate and convert your data. Use one 
of the following checklists based on the version of Sage 100 you're upgrading from. 

 l "Upgrading from Version 2024 to Version 2025" (page 137)

 l "Upgrading from Version 2023 to Version 2025" (page 147)

 l "Upgrading from Version 2022 to Version 2025" (page 157)

 l "Upgrading from Version 2021 to Version 2025" (page 167)

 l "Upgrading from Version 2020 to Version 2025" (page 177)

 l "Upgrading from Version 2019 to Version 2025" (page 187)
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Upgrading from Version 2024 to Version 2025
When upgrading to version 2025, you must perform a parallel installation, and use the 
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to 
upgrade your data. For more information, consult with your Sage business partner. 

If you have custom modules or modifications to any of your modules, consult your Sage 
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for 
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide. 
You can find the guide on the Sage 100 Documents page. 

Pre-Upgrade Checklist

You must prepare your version 2024 data for upgrading. This should be done for each 
company you plan to upgrade.

Complete these steps in your version 2024 installation. 

 1. Process all pending credit card transactions.

 2. Print and update all journals and registers.         

Important! Failure to complete this step may result in loss of data.

 3. If you use the Payroll module:             

 l Update the Payroll Check Register.

 l Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is 
not part of the Sage 100 installation program. To avoid the need to run a 
separate data conversion for Payroll, install the module before proceeding to 
the Upgrade Checklist. 

For more information, see the Sage 100 Payroll Installation and Upgrade Guide 
available on the Sage 100 Documents page. 

 4. Create a backup of your version 2024 MAS90 folder, which includes data for all of 
your companies. Perform this step following your usual backup process. For 
specific support on how to back up your data, refer to manuals for your backup 
software or contact the vendor from whom you purchased that product.
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Upgrading from Version 2024 to Version 2025

 5. Rebuild all data files.             

 l If you're upgrading from Sage 100 Standard or Advanced, use the Rebuild Key 
Files and Rebuild Sort File utilities.

 l If you're upgrading from Sage 100 Premium, use the Rebuild Sort File utility.

You must answer Yes to all recalculation questions.

 6. Print all customized form definitions.

 7. If you're using eBusiness Manager, back up any templates, .htm files, and the IW 
folder before uninstalling the previous version of the Web Engine.

 8. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility 
examines your data and displays a list of tasks that you should run before migrating 
your data. For more information, see the Pre-Migration Utility help.

 9. If you're upgrading Sage 100 Premium, configure your firewall to allow access to 
port number 1433 on the server with your version 2024 installation. Port 1433 is the 
default SQL Server port

Upgrade Checklist 

After completing the "Pre-Upgrade Checklist" (page 137), you are ready to migrate your 
data to your version 2025 system.

Complete these steps in your version 2025 installation.

 l For Sage 100 Standard or Advanced, use the checklist below. 

 l For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 139).

Note: If you’re going to convert data for the Payroll module, you’ll need access to 
Tax Profile Maintenance. If you use Payroll departments, you must have access to 
all departments in each company.

Upgrade Checklist for Sage 100 Standard and Advanced

 1. Create a backup of your version 2025 MAS90 folder. Creating a backup now will 
save time if you need to revert to the folder’s original state. 

 2. Log into Sage 100 2025 as the Administrator. From the Administrative Tools 
window:             

 a. Start Role Maintenance and create a role that you’ll use to run the Parallel 
Migration Wizard. 
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 b. On the Tasks tab, expand Library Master > Miscellaneous Tasks, and then 
select the Parallel Migration check box.

 c. Start User Maintenance, create a logon, and select the role that you 
created.

 d. Close the Administrative Tools window.

 3. Log in to Sage 100 2025, and select Library Master > Utilities > Parallel Migration. 
Follow the steps in the wizard to migrate your data. 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Upgrade Checklist for Sage 100 Premium 

Use this checklist to migrate your Sage 100 Premium data.

Important!  

 l You must have administrator rights for the server with your prior version of 
Sage 100 and the server with your version 2025 installation.

 l Clustered drives do not allow hidden shares. If you are using clustered drives, 
follow the instructions in the Manual Workaround section of Sage 
Knowledgebase article: During Parallel Migration where Sage 100 Premium is 
on one server and SQL Server is on a different server (solution ID 
224924950076993).
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 1. For your Sage 100 2025 installation, create a backup of the following:             

 a. The Sage 100 MAS90 folder

 b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original 
state.

 2. Verify that the required rights and permissions are set up on the server(s) where 
SQL Server is installed. If the instance of SQL Server for Sage 100 2025 is installed 
on a different server than the instance used for your prior version, you must 
complete these steps on both servers.                  

 a. Open the Control Panel, select Administrative Tools, and then select 
Services. 

 b. In the Services window, locate the SQL Server instance used for Sage 100 
Premium, right-click it, and select Properties.

 c. In the Properties window, click the Log On tab and select an option.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on the same server as the instance used for your prior version of Sage 
100 Premium, select Local System Account.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on a different server than the one used for your prior version of Sage 
100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator  

Replace "ServerName" with the name of the server. Sage strongly 
recommends using the actual Administrator or Domain Administrator 
account. 

Enter the password for the account.

 d. Apply your changes and then stop and restart the services.

 e. If you’re working with more than one server, make sure that all servers can 
access each other through hidden shares. 

For example: \\ServerName\C$, \\ServerName\D$

 3. Start the Parallel Migration Wizard using one of the methods below, and follow the 
steps in the wizard.             

 l If you are using Windows Server 2008, start the Parallel Migration Wizard from 
the Sage program group on the Start menu.
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 l If you are using Windows Server 2012 or later, start the Parallel Migration 
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL 
Server locations. The hidden shares are used to access the source databases to 
create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL 
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the 
destination ..\DATA SQL Server folders. 

To complete the process, the wizard then restores the databases into the new SQL 
Server location and removes the .bak files from both the source and destination 
locations.

If permissions were not set correctly on both servers, you may receive the following 
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied 
2 Setup will now terminate"

If this error occurs, see Sage Knowledgebase article: During Parallel Migration 
where Sage 100 Premium is on one server and SQL Server is on a different server 
(solution ID 224924950076993). 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

You're now ready to convert your data to version 2025. 

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.
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Data Conversion Checklist

Follow these steps to convert your data. 

 1. Select Library Master Main menu > Company Maintenance. Select a company, and 
then click Convert to convert your data. You must convert data for each of your 
companies. In addition, you can select one or more of the following options:                              

 l Convert Data for All Companies: Select this check box to convert data for all of 
your companies instead of doing it one-by-one. This check box may be 
unavailable if you’re converting Payroll data, depending on which version of 
Payroll you’re upgrading from. 

 l Convert SAP Crystal Reports: Select this check box to convert all of your 
custom reports and forms. The time required to convert your reports and forms 
depends on how many of them you have that need to be converted. The 
process runs in the background, and you can continue working in Sage 100 
while it’s running. 

You can convert custom forms and reports later by running the Sage 100 
Crystal Report Conversion Wizard.

 l Update Custom Office Panels to Current Level: Select this check box to run the 
Custom Office panel update for any customized panels for the companies being 
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels 
to Current Level utility on the Custom Office Utilities menu. 

 2. If your system is integrated with Sage CRM, go into CRM Server Options, and 
update the following information as needed.             

 l Integration server port ID

 l Sage CRM SQL server name

 l Sage CRM SQL database name

The server name and database name should reference the mirror installation that 
you created for integration with Sage 100 2025. For more information on this 
process, refer to the Installing Sage CRM section in the Sage 100 Installation and 
System Administrator’s Guide. 

After updating the information, load the Sage CRM data.

 3. If you synchronize payroll data between your General Ledger module and Sage 
Payroll Services, verify that your Sage 100 company or companies are still linked to 
the service. 
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 a. Select General Ledger > Payroll Services > Payroll Services 
Synchronization Wizard. 

 b. Sign in to Sage Payroll Services. 

 c. Proceed through the wizard. 

 d. Review the status messages shown in the Synchronizing Data with Sage 
Payroll Services window. 

If you see a "Synchronization Complete" message, no further action is 
required. 

If you see a "Synchronization failed" message, contact iSolved Support for 
assistance with resetting the link.   

 4. Update customized panels by selecting Custom Office Utilities menu > Update 
Customized Panels to Current Level. Review the placement of all user-defined 
fields. 

 5. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to 
the new version of the software and prior to accessing other modules, select Library 
Master Utilities menu > Lookup Conversion to convert your lookups. 

 6. Verify that all module links are functional by selecting Library Master Utilities menu 
> Link Maintenance Utility. Links that appear in red are broken and will need to be 
fixed using the Relink button in Link Maintenance Utility. For more information on 
relinking files, see Copy/Move/Relink Files in your Help system.

 7. If you are also upgrading your Payroll Module, review the list of enhancements and 
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide, 
available on the Sage 100 Documents page. 

 8. Test your customized Crystal reports and forms.             

 l If you need to troubleshoot issues with customized reports and forms, run the 
Crystal Form Comparison Report utility to compare your customized reports 
and forms to the standard ones in version 2025.

To run the utility, select File menu > Run, and then type SYWFCU. The utility 
tells you which tables, if any, have been added to a report or form. It does not 
provide information about formatting changes, such as those affecting fonts, 
logos, and so forth 

 l If you were previously using non-graphical forms, you will need to set them up 
using SAP Crystal Reports.

 l If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal 
Reports Conversion Wizard to convert your Crystal reports and forms. For more 
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information, see SAP Crystal Reports FAQs in the Help system. If you do not 
run the wizard now, it will automatically run the first time that someone runs a 
form or report.

 l If you are using Sage 100 Premium, refer to the Converting Reports for Sage 
100 Premium section in the Sage 100 Installation and System Administrator's 
Guide for more information.

 9. If Sage 100 2025 is installed on the same computer as an earlier version of 
Sage 100, complete this step to avoid errors when printing forms and reports in the 
earlier version: 

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2024 
installation to the same folder in your 2025 installation. You must complete this step 
on both the server and the workstation.

 10. If your system has custom reports, review the Custom Reports menus to make sure 
they are available. If they are not, add them using Report Manager.

 11. If you use Sage Intelligence Reporting, create a new repository for use with the 
latest version of Sage 100 and import any custom reports into it. For detailed 
instructions, see the "Upgrading Sage Intelligence Reporting" (page 197) checklist.

 12. Review the Paperless Office module configuration for emailing statements, reports, 
journals, registers, and other forms. For more information, see Set Up Paperless 
Office in the Help.

 13. Review your Business Insights Dashboard pages. For more information, see Set Up 
Business Insights Dashboard in the Help.

 14. To use the eBusiness Manager module:              

 a. Restore the copied templates back to the IW folder after re-installing the 
Web Engine.

 b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS 
Inetpup\wwwroot\images folder and restart the IIS Web service.

 15. If you use Custom Financials Reporting, you must unhide the menu and tasks. 
Select File menu > Run and type *unhidegl in the Run Program window.

 16. Print all customized form definitions and compare them to the ones previously 
printed. Default forms may be erased in the upgrade process.

 17. If you purchased the Return Merchandise Authorization module, after setting up the 
data files for the first time, select Return Merchandise Authorization Setup menu > 
Create Customer Invoice Search Records to create customer invoice search 
records in RMA.
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 18. To run Microsoft Script links, you must have the Microsoft Windows Script Host 
processor on your system. For information on installing the Microsoft Windows 
Script Host processor, refer to the Microsoft Download Center website.

 19. If you use Automatic Update or Task Scheduler, review your scheduled automatic 
updates and reschedule those updates by selecting Library Master Main menu > 
Automatic Update or Task Scheduler, as applicable.

 20. If you were using the classic Desktop, which is no longer available, and had task 
folders in your My Tasks area, you can add tasks to the Favorites list instead. For 
more information, see Add Items to the Favorites Content Group in the Help. 

 21. Test all printers, including Device Configurator printers, that you normally use for 
printing forms and reports. Each workstation must have a default printer defined.

 22. To use the auto-complete feature with enhanced search, run the Build Search Index 
utility to index your existing customer, vendor, and item records. To run the utility, 
select Library Master > Utilities > Build Search Index.             

 23. Install Paya Connect Desktop on each workstation for each Windows user who 
needs to access credit card and ACH payment information in Sage 100.             

To install Paya Connect Desktop for Sage 100 Standard: 

 a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects 
to a Sage 100 Standard installation on a server, browser to the 
MAS90\Wksetup folder on the server.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

 a. Use File Explorer to browse to the server where Sage 100 is installed, and 
locate the MAS90\Wksetup folder.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.
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 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

 24. If you installed the 32-bit version of Sage 100 and need to convert to the 64-bit 
version, see "Converting to 64-bit Version of Sage 100" (page 201).
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When upgrading to version 2025, you must perform a parallel installation, and use the 
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to 
upgrade your data. For more information, consult with your Sage business partner. 

If you have custom modules or modifications to any of your modules, consult your Sage 
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for 
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide. 
You can find the guide on the Sage 100 Documents page. 

Pre-Upgrade Checklist

You must prepare your version 2023 data for upgrading. This should be done for each 
company you plan to upgrade.

Complete these steps in your version 2023 installation. 

 1. Process all pending credit card transactions.

 2. Print and update all journals and registers.         

Important! Failure to complete this step may result in loss of data.

 3. If you use the Payroll module:             

 l Update the Payroll Check Register.

 l Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is 
not part of the Sage 100 installation program. To avoid the need to run a 
separate data conversion for Payroll, install the module before proceeding to 
the Upgrade Checklist. 

For more information, see the Sage 100 Payroll Installation and Upgrade Guide 
available on the Sage 100 Documents page. 

 4. Create a backup of your version 2023 MAS90 folder, which includes data for all of 
your companies. Perform this step following your usual backup process. For 
specific support on how to back up your data, refer to manuals for your backup 
software or contact the vendor from whom you purchased that product.
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 5. Rebuild all data files.             

 l If you're upgrading from Sage 100 Standard or Advanced, use the Rebuild Key 
Files and Rebuild Sort File utilities.

 l If you're upgrading from Sage 100 Premium, use the Rebuild Sort File utility.

You must answer Yes to all recalculation questions.

 6. Print all customized form definitions.

 7. If you're using eBusiness Manager, back up any templates, .htm files, and the IW 
folder before uninstalling the previous version of the Web Engine.

 8. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility 
examines your data and displays a list of tasks that you should run before migrating 
your data. For more information, see the Pre-Migration Utility help.

 9. If you're upgrading Sage 100 Premium, configure your firewall to allow access to 
port number 1433 on the server with your version 2023 installation. Port 1433 is the 
default SQL Server port

Upgrade Checklist 

After completing the "Pre-Upgrade Checklist" (page 147), you are ready to migrate your 
data to your version 2025 system.

Complete these steps in your version 2025 installation.

 l For Sage 100 Standard or Advanced, use the checklist below. 

 l For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 149).

Note: If you’re going to convert data for the Payroll module, you’ll need access to 
Tax Profile Maintenance. If you use Payroll departments, you must have access to 
all departments in each company.

Upgrade Checklist for Sage 100 Standard and Advanced

 1. Create a backup of your version 2025 MAS90 folder. Creating a backup now will 
save time if you need to revert to the folder’s original state. 

 2. Log into Sage 100 2025 as the Administrator. From the Administrative Tools 
window:             

 a. Start Role Maintenance and create a role that you’ll use to run the Parallel 
Migration Wizard. 
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 b. On the Tasks tab, expand Library Master > Miscellaneous Tasks, and then 
select the Parallel Migration check box.

 c. Start User Maintenance, create a logon, and select the role that you 
created.

 d. Close the Administrative Tools window.

 3. Log in to Sage 100 2025, and select Library Master > Utilities > Parallel Migration. 
Follow the steps in the wizard to migrate your data. 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Upgrade Checklist for Sage 100 Premium 

Use this checklist to migrate your Sage 100 Premium data.

Important!  

 l You must have administrator rights for the server with your prior version of 
Sage 100 and the server with your version 2025 installation.

 l Clustered drives do not allow hidden shares. If you are using clustered drives, 
follow the instructions in the Manual Workaround section of Sage 
Knowledgebase article: During Parallel Migration where Sage 100 Premium is 
on one server and SQL Server is on a different server (solution ID 
224924950076993).
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 1. For your Sage 100 2025 installation, create a backup of the following:             

 a. The Sage 100 MAS90 folder

 b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original 
state.

 2. Verify that the required rights and permissions are set up on the server(s) where 
SQL Server is installed. If the instance of SQL Server for Sage 100 2025 is installed 
on a different server than the instance used for your prior version, you must 
complete these steps on both servers.                  

 a. Open the Control Panel, select Administrative Tools, and then select 
Services. 

 b. In the Services window, locate the SQL Server instance used for Sage 100 
Premium, right-click it, and select Properties.

 c. In the Properties window, click the Log On tab and select an option.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on the same server as the instance used for your prior version of Sage 
100 Premium, select Local System Account.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on a different server than the one used for your prior version of Sage 
100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator  

Replace "ServerName" with the name of the server. Sage strongly 
recommends using the actual Administrator or Domain Administrator 
account. 

Enter the password for the account.

 d. Apply your changes and then stop and restart the services.

 e. If you’re working with more than one server, make sure that all servers can 
access each other through hidden shares. 

For example: \\ServerName\C$, \\ServerName\D$

 3. Start the Parallel Migration Wizard using one of the methods below, and follow the 
steps in the wizard.             

 l If you are using Windows Server 2008, start the Parallel Migration Wizard from 
the Sage program group on the Start menu.
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 l If you are using Windows Server 2012 or later, start the Parallel Migration 
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL 
Server locations. The hidden shares are used to access the source databases to 
create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL 
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the 
destination ..\DATA SQL Server folders. 

To complete the process, the wizard then restores the databases into the new SQL 
Server location and removes the .bak files from both the source and destination 
locations.

If permissions were not set correctly on both servers, you may receive the following 
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied 
2 Setup will now terminate"

If this error occurs, see Sage Knowledgebase article: During Parallel Migration 
where Sage 100 Premium is on one server and SQL Server is on a different server 
(solution ID 224924950076993). 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

You're now ready to convert your data to version 2025. 

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.
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Data Conversion Checklist

Follow these steps to convert your data. 

 1. Select Library Master Main menu > Company Maintenance. Select a company, and 
then click Convert to convert your data. You must convert data for each of your 
companies. In addition, you can select one or more of the following options:                              

 l Convert Data for All Companies: Select this check box to convert data for all of 
your companies instead of doing it one-by-one. This check box may be 
unavailable if you’re converting Payroll data, depending on which version of 
Payroll you’re upgrading from. 

 l Convert SAP Crystal Reports: Select this check box to convert all of your 
custom reports and forms. The time required to convert your reports and forms 
depends on how many of them you have that need to be converted. The 
process runs in the background, and you can continue working in Sage 100 
while it’s running. 

You can convert custom forms and reports later by running the Sage 100 
Crystal Report Conversion Wizard.

 l Update Custom Office Panels to Current Level: Select this check box to run the 
Custom Office panel update for any customized panels for the companies being 
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels 
to Current Level utility on the Custom Office Utilities menu. 

 2. If your system is integrated with Sage CRM, go into CRM Server Options, and 
update the following information as needed.             

 l Integration server port ID

 l Sage CRM SQL server name

 l Sage CRM SQL database name

The server name and database name should reference the mirror installation that 
you created for integration with Sage 100 2025. For more information on this 
process, refer to the Installing Sage CRM section in the Sage 100 Installation and 
System Administrator’s Guide. 

After updating the information, load the Sage CRM data.

 3. If you synchronize payroll data between your General Ledger module and Sage 
Payroll Services, verify that your Sage 100 company or companies are still linked to 
the service. 
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 a. Select General Ledger > Payroll Services > Payroll Services 
Synchronization Wizard. 

 b. Sign in to Sage Payroll Services. 

 c. Proceed through the wizard. 

 d. Review the status messages shown in the Synchronizing Data with Sage 
Payroll Services window. 

If you see a "Synchronization Complete" message, no further action is 
required. 

If you see a "Synchronization failed" message, contact iSolved Support for 
assistance with resetting the link.   

 4. Update customized panels by selecting Custom Office Utilities menu > Update 
Customized Panels to Current Level. Review the placement of all user-defined 
fields. 

 5. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to 
the new version of the software and prior to accessing other modules, select Library 
Master Utilities menu > Lookup Conversion to convert your lookups. 

 6. Verify that all module links are functional by selecting Library Master Utilities menu 
> Link Maintenance Utility. Links that appear in red are broken and will need to be 
fixed using the Relink button in Link Maintenance Utility. For more information on 
relinking files, see Copy/Move/Relink Files in your Help system.

 7. If you are also upgrading your Payroll Module, review the list of enhancements and 
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide, 
available on the Sage 100 Documents page. 

 8. Test your customized Crystal reports and forms.             

 l If you need to troubleshoot issues with customized reports and forms, run the 
Crystal Form Comparison Report utility to compare your customized reports 
and forms to the standard ones in version 2025.

To run the utility, select File menu > Run, and then type SYWFCU. The utility 
tells you which tables, if any, have been added to a report or form. It does not 
provide information about formatting changes, such as those affecting fonts, 
logos, and so forth 

 l If you were previously using non-graphical forms, you will need to set them up 
using SAP Crystal Reports.

 l If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal 
Reports Conversion Wizard to convert your Crystal reports and forms. For more 
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information, see SAP Crystal Reports FAQs in the Help system. If you do not 
run the wizard now, it will automatically run the first time that someone runs a 
form or report.

 l If you are using Sage 100 Premium, refer to the Converting Reports for Sage 
100 Premium section in the Sage 100 Installation and System Administrator's 
Guide for more information.

 9. If Sage 100 2025 is installed on the same computer as an earlier version of 
Sage 100, complete this step to avoid errors when printing forms and reports in the 
earlier version: 

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2023 
installation to the same folder in your 2025 installation. You must complete this step 
on both the server and the workstation.

 10. If your system has custom reports, review the Custom Reports menus to make sure 
they are available. If they are not, add them using Report Manager.

 11. If you use Sage Intelligence Reporting, create a new repository for use with the 
latest version of Sage 100 and import any custom reports into it. For detailed 
instructions, see the "Upgrading Sage Intelligence Reporting" (page 197) checklist.

 12. Review the Paperless Office module configuration for emailing statements, reports, 
journals, registers, and other forms. For more information, see Set Up Paperless 
Office in the Help.

 13. Review your Business Insights Dashboard pages. For more information, see Set Up 
Business Insights Dashboard in the Help.

 14. To use the eBusiness Manager module:              

 a. Restore the copied templates back to the IW folder after re-installing the 
Web Engine.

 b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS 
Inetpup\wwwroot\images folder and restart the IIS Web service.

 15. If you use Custom Financials Reporting, you must unhide the menu and tasks. 
Select File menu > Run and type *unhidegl in the Run Program window.

 16. Print all customized form definitions and compare them to the ones previously 
printed. Default forms may be erased in the upgrade process.

 17. If you purchased the Return Merchandise Authorization module, after setting up the 
data files for the first time, select Return Merchandise Authorization Setup menu > 
Create Customer Invoice Search Records to create customer invoice search 
records in RMA.
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 18. To run Microsoft Script links, you must have the Microsoft Windows Script Host 
processor on your system. For information on installing the Microsoft Windows 
Script Host processor, refer to the Microsoft Download Center website.

 19. If you use Automatic Update or Task Scheduler, review your scheduled automatic 
updates and reschedule those updates by selecting Library Master Main menu > 
Automatic Update or Task Scheduler, as applicable.

 20. If you were using the classic Desktop, which is no longer available, and had task 
folders in your My Tasks area, you can add tasks to the Favorites list instead. For 
more information, see Add Items to the Favorites Content Group in the Help. 

 21. Test all printers, including Device Configurator printers, that you normally use for 
printing forms and reports. Each workstation must have a default printer defined.

 22. To use the auto-complete feature with enhanced search, run the Build Search Index 
utility to index your existing customer, vendor, and item records. To run the utility, 
select Library Master > Utilities > Build Search Index.             

 23. Install Paya Connect Desktop on each workstation for each Windows user who 
needs to access credit card and ACH payment information in Sage 100.             

To install Paya Connect Desktop for Sage 100 Standard: 

 a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects 
to a Sage 100 Standard installation on a server, browser to the 
MAS90\Wksetup folder on the server.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

 a. Use File Explorer to browse to the server where Sage 100 is installed, and 
locate the MAS90\Wksetup folder.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.
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Upgrading from Version 2023 to Version 2025

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

 24. If you installed the 32-bit version of Sage 100 and need to convert to the 64-bit 
version, see "Converting to 64-bit Version of Sage 100" (page 201).
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Upgrading from Version 2022 to Version 2025
When upgrading to version 2025, you must perform a parallel installation, and use the 
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to 
upgrade your data. For more information, consult with your Sage business partner. 

If you have custom modules or modifications to any of your modules, consult your Sage 
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for 
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide. 
You can find the guide on the Sage 100 Documents page. 

Pre-Upgrade Checklist

You must prepare your version 2022 data for upgrading. This should be done for each 
company you plan to upgrade.

Complete these steps in your version 2022 installation. 

 1. Process all pending credit card transactions.

 2. Print and update all journals and registers.         

Important! Failure to complete this step may result in loss of data.

 3. If you use the Payroll module:             

 l Update the Payroll Check Register.

 l Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is 
not part of the Sage 100 installation program. To avoid the need to run a 
separate data conversion for Payroll, install the module before proceeding to 
the Upgrade Checklist. 

For more information, see the Sage 100 Payroll Installation and Upgrade Guide 
available on the Sage 100 Documents page. 

 4. If you're upgrading the Work Order module to Production Management, run Work 
Order Purge to move closed work orders into the history files. Work Order Purge is 
located on the Work Order Main menu.     
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Upgrading from Version 2022 to Version 2025

 5. Create a backup of your version 2022 MAS90 folder, which includes data for all of 
your companies. Perform this step following your usual backup process. For specific 
support on how to back up your data, refer to manuals for your backup software or 
contact the vendor from whom you purchased that product.

 6. Rebuild all data files.             

 l If you're upgrading from Sage 100 Standard or Advanced, use the Rebuild Key 
Files and Rebuild Sort File utilities.

 l If you're upgrading from Sage 100 Premium, use the Rebuild Sort File utility.

You must answer Yes to all recalculation questions.

 7. Print all customized form definitions.

 8. If you're using eBusiness Manager, back up any templates, .htm files, and the IW 
folder before uninstalling the previous version of the Web Engine.

 9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility 
examines your data and displays a list of tasks that you should run before migrating 
your data. For more information, see the Pre-Migration Utility help.

 10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to 
port number 1433 on the server with your version 2022 installation. Port 1433 is the 
default SQL Server port

Upgrade Checklist 

After completing the "Pre-Upgrade Checklist" (page 157), you are ready to migrate your 
data to your version 2025 system.

Complete these steps in your version 2025 installation.

 l For Sage 100 Standard or Advanced, use the checklist below. 

 l For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 159).

Note: If you’re going to convert data for the Payroll module, you’ll need access to 
Tax Profile Maintenance. If you use Payroll departments, you must have access to 
all departments in each company.

Upgrade Checklist for Sage 100 Standard and Advanced

 1. Create a backup of your version 2025 MAS90 folder. Creating a backup now will 
save time if you need to revert to the folder’s original state. 
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 2. Log into Sage 100 2025 as the Administrator. From the Administrative Tools 
window:             

 a. Start Role Maintenance and create a role that you’ll use to run the Parallel 
Migration Wizard. 

 b. On the Tasks tab, expand Library Master > Miscellaneous Tasks, and then 
select the Parallel Migration check box.

 c. Start User Maintenance, create a logon, and select the role that you 
created.

 d. Close the Administrative Tools window.

 3. Log in to Sage 100 2025, and select Library Master > Utilities > Parallel Migration. 
Follow the steps in the wizard to migrate your data. 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Upgrade Checklist for Sage 100 Premium 

Use this checklist to migrate your Sage 100 Premium data.
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Upgrading from Version 2022 to Version 2025

Important!  

 l You must have administrator rights for the server with your prior version of 
Sage 100 and the server with your version 2025 installation.

 l Clustered drives do not allow hidden shares. If you are using clustered drives, 
follow the instructions in the Manual Workaround section of Sage 
Knowledgebase article: During Parallel Migration where Sage 100 Premium is 
on one server and SQL Server is on a different server (solution ID 
224924950076993).

 1. For your Sage 100 2025 installation, create a backup of the following:             

 a. The Sage 100 MAS90 folder

 b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original 
state.

 2. Verify that the required rights and permissions are set up on the server(s) where 
SQL Server is installed. If the instance of SQL Server for Sage 100 2025 is installed 
on a different server than the instance used for your prior version, you must 
complete these steps on both servers.                  

 a. Open the Control Panel, select Administrative Tools, and then select 
Services. 

 b. In the Services window, locate the SQL Server instance used for Sage 100 
Premium, right-click it, and select Properties.

 c. In the Properties window, click the Log On tab and select an option.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on the same server as the instance used for your prior version of Sage 
100 Premium, select Local System Account.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on a different server than the one used for your prior version of Sage 
100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator  

Replace "ServerName" with the name of the server. Sage strongly 
recommends using the actual Administrator or Domain Administrator 
account. 

Enter the password for the account.

Sage 100 Customer Upgrade Guide 160

https://us-kb.sage.com/portal/app/portlets/results/viewsolution.jsp?solutionid=224924950076993
https://us-kb.sage.com/portal/app/portlets/results/viewsolution.jsp?solutionid=224924950076993
https://us-kb.sage.com/portal/app/portlets/results/viewsolution.jsp?solutionid=224924950076993


 d. Apply your changes and then stop and restart the services.

 e. If you’re working with more than one server, make sure that all servers can 
access each other through hidden shares. 

For example: \\ServerName\C$, \\ServerName\D$

 3. Start the Parallel Migration Wizard using one of the methods below, and follow the 
steps in the wizard.             

 l If you are using Windows Server 2008, start the Parallel Migration Wizard from 
the Sage program group on the Start menu.

 l If you are using Windows Server 2012 or later, start the Parallel Migration 
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL 
Server locations. The hidden shares are used to access the source databases to 
create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL 
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the 
destination ..\DATA SQL Server folders. 

To complete the process, the wizard then restores the databases into the new SQL 
Server location and removes the .bak files from both the source and destination 
locations.

If permissions were not set correctly on both servers, you may receive the following 
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied 
2 Setup will now terminate"

If this error occurs, see Sage Knowledgebase article: During Parallel Migration 
where Sage 100 Premium is on one server and SQL Server is on a different server 
(solution ID 224924950076993). 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

You're now ready to convert your data to version 2025. 
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Upgrading from Version 2022 to Version 2025

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Data Conversion Checklist

Follow these steps to convert your data. 

 1. Select Library Master Main menu > Company Maintenance. Select a company, and 
then click Convert to convert your data. You must convert data for each of your 
companies. In addition, you can select one or more of the following options:                              

 l Convert Data for All Companies: Select this check box to convert data for all of 
your companies instead of doing it one-by-one. This check box may be 
unavailable if you’re converting Payroll data, depending on which version of 
Payroll you’re upgrading from. 

 l Convert SAP Crystal Reports: Select this check box to convert all of your 
custom reports and forms. The time required to convert your reports and forms 
depends on how many of them you have that need to be converted. The 
process runs in the background, and you can continue working in Sage 100 
while it’s running. 

You can convert custom forms and reports later by running the Sage 100 
Crystal Report Conversion Wizard.

 l Update Custom Office Panels to Current Level: Select this check box to run the 
Custom Office panel update for any customized panels for the companies being 
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels 
to Current Level utility on the Custom Office Utilities menu. 

 2. If your system is integrated with Sage CRM, go into CRM Server Options, and 
update the following information as needed.             

 l Integration server port ID

 l Sage CRM SQL server name

 l Sage CRM SQL database name

The server name and database name should reference the mirror installation that 
you created for integration with Sage 100 2025. For more information on this 
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process, refer to the Installing Sage CRM section in the Sage 100 Installation and 
System Administrator’s Guide. 

After updating the information, load the Sage CRM data.

 3. If you synchronize payroll data between your General Ledger module and Sage 
Payroll Services, verify that your Sage 100 company or companies are still linked to 
the service. 

 a. Select General Ledger > Payroll Services > Payroll Services 
Synchronization Wizard. 

 b. Sign in to Sage Payroll Services. 

 c. Proceed through the wizard. 

 d. Review the status messages shown in the Synchronizing Data with Sage 
Payroll Services window. 

If you see a "Synchronization Complete" message, no further action is 
required. 

If you see a "Synchronization failed" message, contact iSolved Support for 
assistance with resetting the link.   

 4. Update customized panels by selecting Custom Office Utilities menu > Update 
Customized Panels to Current Level. Review the placement of all user-defined 
fields. 

 5. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to 
the new version of the software and prior to accessing other modules, select Library 
Master Utilities menu > Lookup Conversion to convert your lookups. 

 6. Verify that all module links are functional by selecting Library Master Utilities menu 
> Link Maintenance Utility. Links that appear in red are broken and will need to be 
fixed using the Relink button in Link Maintenance Utility. For more information on 
relinking files, see Copy/Move/Relink Files in your Help system.

 7. If you are also upgrading your Payroll Module, review the list of enhancements and 
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide, 
available on the Sage 100 Documents page. 

 8. Test your customized Crystal reports and forms.             

 l If you need to troubleshoot issues with customized reports and forms, run the 
Crystal Form Comparison Report utility to compare your customized reports 
and forms to the standard ones in version 2025.
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Upgrading from Version 2022 to Version 2025

To run the utility, select File menu > Run, and then type SYWFCU. The utility 
tells you which tables, if any, have been added to a report or form. It does not 
provide information about formatting changes, such as those affecting fonts, 
logos, and so forth 

 l If you were previously using non-graphical forms, you will need to set them up 
using SAP Crystal Reports.

 l If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal 
Reports Conversion Wizard to convert your Crystal reports and forms. For more 
information, see SAP Crystal Reports FAQs in the Help system. If you do not 
run the wizard now, it will automatically run the first time that someone runs a 
form or report.

 l If you are using Sage 100 Premium, refer to the Converting Reports for Sage 
100 Premium section in the Sage 100 Installation and System Administrator's 
Guide for more information.

 9. If Sage 100 2025 is installed on the same computer as an earlier version of 
Sage 100, complete this step to avoid errors when printing forms and reports in the 
earlier version: 

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2022 
installation to the same folder in your 2025 installation. You must complete this step 
on both the server and the workstation.

 10. If your system has custom reports, review the Custom Reports menus to make sure 
they are available. If they are not, add them using Report Manager.

 11. If you use Sage Intelligence Reporting, create a new repository for use with the 
latest version of Sage 100 and import any custom reports into it. For detailed 
instructions, see the "Upgrading Sage Intelligence Reporting" (page 197) checklist.

 12. Review the Paperless Office module configuration for emailing statements, reports, 
journals, registers, and other forms. For more information, see Set Up Paperless 
Office in the Help.

 13. Review your Business Insights Dashboard pages. For more information, see Set Up 
Business Insights Dashboard in the Help.

 14. To use the eBusiness Manager module:              

 a. Restore the copied templates back to the IW folder after re-installing the 
Web Engine.

 b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS 
Inetpup\wwwroot\images folder and restart the IIS Web service.
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 15. If you converted Work Order data to Production Management data, purchase orders 
that were linked to work orders must be relinked to work tickets. Use either of the 
following methods to relink:         

 l Use the Work Ticket to Purchase Order Post-Conversion Link Utility. Select File 
menu > Run, type *utl in the Run Program window, and click OK. In the 
Sage 100 Utilities window, select the utility and click OK.

 l Manually relink by selecting the purchase order in Purchase Order Entry and 
entering the applicable work ticket number in the Work Ticket No. field on the 
Lines tab.

 16. If you use Custom Financials Reporting, you must unhide the menu and tasks. 
Select File menu > Run and type *unhidegl in the Run Program window.

 17. Print all customized form definitions and compare them to the ones previously 
printed. Default forms may be erased in the upgrade process.

 18. If you purchased the Return Merchandise Authorization module, after setting up the 
data files for the first time, select Return Merchandise Authorization Setup menu > 
Create Customer Invoice Search Records to create customer invoice search 
records in RMA.

 19. To run Microsoft Script links, you must have the Microsoft Windows Script Host 
processor on your system. For information on installing the Microsoft Windows 
Script Host processor, refer to the Microsoft Download Center website.

 20. If you use Automatic Update or Task Scheduler, review your scheduled automatic 
updates and reschedule those updates by selecting Library Master Main menu > 
Automatic Update or Task Scheduler, as applicable.

 21. If you were using the classic Desktop, which is no longer available, and had task 
folders in your My Tasks area, you can add tasks to the Favorites list instead. For 
more information, see Add Items to the Favorites Content Group in the Help. 

 22. Test all printers, including Device Configurator printers, that you normally use for 
printing forms and reports. Each workstation must have a default printer defined.

 23. To use the auto-complete feature with enhanced search, run the Build Search Index 
utility to index your existing customer, vendor, and item records. To run the utility, 
select Library Master > Utilities > Build Search Index.             

 24. Install Paya Connect Desktop on each workstation for each Windows user who 
needs to access credit card and ACH payment information in Sage 100.             
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To install Paya Connect Desktop for Sage 100 Standard: 

 a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects 
to a Sage 100 Standard installation on a server, browser to the 
MAS90\Wksetup folder on the server.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

 a. Use File Explorer to browse to the server where Sage 100 is installed, and 
locate the MAS90\Wksetup folder.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

 25. If you installed the 32-bit version of Sage 100 and need to convert to the 64-bit 
version, see "Converting to 64-bit Version of Sage 100" (page 201).
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When upgrading to version 2025, you must perform a parallel installation, and use the 
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to 
upgrade your data. For more information, consult with your Sage business partner. 

If you have custom modules or modifications to any of your modules, consult your Sage 
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for 
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide. 
You can find the guide on the Sage 100 Documents page. 

Pre-Upgrade Checklist

You must prepare your version 2021 data for upgrading. This should be done for each 
company you plan to upgrade.

Complete these steps in your version 2021 installation. 

 1. Process all pending credit card transactions.

 2. Print and update all journals and registers.         

Important! Failure to complete this step may result in loss of data.

 3. If you use the Payroll module:             

 l Update the Payroll Check Register.

 l Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is 
not part of the Sage 100 installation program. To avoid the need to run a 
separate data conversion for Payroll, install the module before proceeding to 
the Upgrade Checklist. 

For more information, see the Sage 100 Payroll Installation and Upgrade Guide 
available on the Sage 100 Documents page. 

 4. If you're upgrading the Work Order module to Production Management, run Work 
Order Purge to move closed work orders into the history files. Work Order Purge is 
located on the Work Order Main menu.     

Sage 100 Customer Upgrade Guide 167

Upgrading from Version 2021 to Version 2025

https://help-sage100.na.sage.com/cdn_redirects/cdn_documentation.htm
https://help-sage100.na.sage.com/cdn_redirects/cdn_documentation.htm


Upgrading from Version 2021 to Version 2025

 5. Create a backup of your version 2021 MAS90 folder, which includes data for all of 
your companies. Perform this step following your usual backup process. For specific 
support on how to back up your data, refer to manuals for your backup software or 
contact the vendor from whom you purchased that product.

 6. Rebuild all data files.             

 l If you're upgrading from Sage 100 Standard or Advanced, use the Rebuild Key 
Files and Rebuild Sort File utilities.

 l If you're upgrading from Sage 100 Premium, use the Rebuild Sort File utility.

You must answer Yes to all recalculation questions.

 7. Print all customized form definitions.

 8. If you're using eBusiness Manager, back up any templates, .htm files, and the IW 
folder before uninstalling the previous version of the Web Engine.

 9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility 
examines your data and displays a list of tasks that you should run before migrating 
your data. For more information, see the Pre-Migration Utility help.

 10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to 
port number 1433 on the server with your version 2021 installation. Port 1433 is the 
default SQL Server port

Upgrade Checklist 

After completing the "Pre-Upgrade Checklist" (page 167), you are ready to migrate your 
data to your version 2025 system.

Complete these steps in your version 2025 installation.

 l For Sage 100 Standard or Advanced, use the checklist below. 

 l For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 169).

Note: If you’re going to convert data for the Payroll module, you’ll need access to 
Tax Profile Maintenance. If you use Payroll departments, you must have access to 
all departments in each company.

Upgrade Checklist for Sage 100 Standard and Advanced

 1. Create a backup of your version 2025 MAS90 folder. Creating a backup now will 
save time if you need to revert to the folder’s original state. 
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 2. Log into Sage 100 2025 as the Administrator. From the Administrative Tools 
window:             

 a. Start Role Maintenance and create a role that you’ll use to run the Parallel 
Migration Wizard. 

 b. On the Tasks tab, expand Library Master > Miscellaneous Tasks, and then 
select the Parallel Migration check box.

 c. Start User Maintenance, create a logon, and select the role that you 
created.

 d. Close the Administrative Tools window.

 3. Log in to Sage 100 2025, and select Library Master > Utilities > Parallel Migration. 
Follow the steps in the wizard to migrate your data. 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Upgrade Checklist for Sage 100 Premium 

Use this checklist to migrate your Sage 100 Premium data.
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Important!  

 l You must have administrator rights for the server with your prior version of 
Sage 100 and the server with your version 2025 installation.

 l Clustered drives do not allow hidden shares. If you are using clustered drives, 
follow the instructions in the Manual Workaround section of Sage 
Knowledgebase article: During Parallel Migration where Sage 100 Premium is 
on one server and SQL Server is on a different server (solution ID 
224924950076993).

 1. For your Sage 100 2025 installation, create a backup of the following:             

 a. The Sage 100 MAS90 folder

 b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original 
state.

 2. Verify that the required rights and permissions are set up on the server(s) where 
SQL Server is installed. If the instance of SQL Server for Sage 100 2025 is installed 
on a different server than the instance used for your prior version, you must 
complete these steps on both servers.                  

 a. Open the Control Panel, select Administrative Tools, and then select 
Services. 

 b. In the Services window, locate the SQL Server instance used for Sage 100 
Premium, right-click it, and select Properties.

 c. In the Properties window, click the Log On tab and select an option.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on the same server as the instance used for your prior version of Sage 
100 Premium, select Local System Account.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on a different server than the one used for your prior version of Sage 
100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator  

Replace "ServerName" with the name of the server. Sage strongly 
recommends using the actual Administrator or Domain Administrator 
account. 

Enter the password for the account.
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 d. Apply your changes and then stop and restart the services.

 e. If you’re working with more than one server, make sure that all servers can 
access each other through hidden shares. 

For example: \\ServerName\C$, \\ServerName\D$

 3. Start the Parallel Migration Wizard using one of the methods below, and follow the 
steps in the wizard.             

 l If you are using Windows Server 2008, start the Parallel Migration Wizard from 
the Sage program group on the Start menu.

 l If you are using Windows Server 2012 or later, start the Parallel Migration 
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL 
Server locations. The hidden shares are used to access the source databases to 
create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL 
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the 
destination ..\DATA SQL Server folders. 

To complete the process, the wizard then restores the databases into the new SQL 
Server location and removes the .bak files from both the source and destination 
locations.

If permissions were not set correctly on both servers, you may receive the following 
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied 
2 Setup will now terminate"

If this error occurs, see Sage Knowledgebase article: During Parallel Migration 
where Sage 100 Premium is on one server and SQL Server is on a different server 
(solution ID 224924950076993). 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

You're now ready to convert your data to version 2025. 
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Upgrading from Version 2021 to Version 2025

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Data Conversion Checklist

Follow these steps to convert your data. 

 1. Select Library Master Main menu > Company Maintenance. Select a company, and 
then click Convert to convert your data. You must convert data for each of your 
companies. In addition, you can select one or more of the following options:                              

 l Convert Data for All Companies: Select this check box to convert data for all of 
your companies instead of doing it one-by-one. This check box may be 
unavailable if you’re converting Payroll data, depending on which version of 
Payroll you’re upgrading from. 

 l Convert SAP Crystal Reports: Select this check box to convert all of your 
custom reports and forms. The time required to convert your reports and forms 
depends on how many of them you have that need to be converted. The 
process runs in the background, and you can continue working in Sage 100 
while it’s running. 

You can convert custom forms and reports later by running the Sage 100 
Crystal Report Conversion Wizard.

 l Update Custom Office Panels to Current Level: Select this check box to run the 
Custom Office panel update for any customized panels for the companies being 
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels 
to Current Level utility on the Custom Office Utilities menu. 

 2. If your system is integrated with Sage CRM, go into CRM Server Options, and 
update the following information as needed.             

 l Integration server port ID

 l Sage CRM SQL server name

 l Sage CRM SQL database name

The server name and database name should reference the mirror installation that 
you created for integration with Sage 100 2025. For more information on this 
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process, refer to the Installing Sage CRM section in the Sage 100 Installation and 
System Administrator’s Guide. 

After updating the information, load the Sage CRM data.

 3. If you synchronize payroll data between your General Ledger module and Sage 
Payroll Services, verify that your Sage 100 company or companies are still linked to 
the service. 

 a. Select General Ledger > Payroll Services > Payroll Services 
Synchronization Wizard. 

 b. Sign in to Sage Payroll Services. 

 c. Proceed through the wizard. 

 d. Review the status messages shown in the Synchronizing Data with Sage 
Payroll Services window. 

If you see a "Synchronization Complete" message, no further action is 
required. 

If you see a "Synchronization failed" message, contact iSolved Support for 
assistance with resetting the link.   

 4. Update customized panels by selecting Custom Office Utilities menu > Update 
Customized Panels to Current Level. Review the placement of all user-defined 
fields. 

 5. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to 
the new version of the software and prior to accessing other modules, select Library 
Master Utilities menu > Lookup Conversion to convert your lookups. 

 6. Verify that all module links are functional by selecting Library Master Utilities menu 
> Link Maintenance Utility. Links that appear in red are broken and will need to be 
fixed using the Relink button in Link Maintenance Utility. For more information on 
relinking files, see Copy/Move/Relink Files in your Help system.

 7. If you are also upgrading your Payroll Module, review the list of enhancements and 
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide, 
available on the Sage 100 Documents page. 

 8. Test your customized Crystal reports and forms.             

 l If you need to troubleshoot issues with customized reports and forms, run the 
Crystal Form Comparison Report utility to compare your customized reports 
and forms to the standard ones in version 2025.
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Upgrading from Version 2021 to Version 2025

To run the utility, select File menu > Run, and then type SYWFCU. The utility 
tells you which tables, if any, have been added to a report or form. It does not 
provide information about formatting changes, such as those affecting fonts, 
logos, and so forth 

 l If you were previously using non-graphical forms, you will need to set them up 
using SAP Crystal Reports.

 l If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal 
Reports Conversion Wizard to convert your Crystal reports and forms. For more 
information, see SAP Crystal Reports FAQs in the Help system. If you do not 
run the wizard now, it will automatically run the first time that someone runs a 
form or report.

 l If you are using Sage 100 Premium, refer to the Converting Reports for Sage 
100 Premium section in the Sage 100 Installation and System Administrator's 
Guide for more information.

 9. If Sage 100 2025 is installed on the same computer as an earlier version of 
Sage 100, complete this step to avoid errors when printing forms and reports in the 
earlier version: 

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2021 
installation to the same folder in your 2025 installation. You must complete this step 
on both the server and the workstation.

 10. If your system has custom reports, review the Custom Reports menus to make sure 
they are available. If they are not, add them using Report Manager.

 11. If you use Sage Intelligence Reporting, create a new repository for use with the 
latest version of Sage 100 and import any custom reports into it. For detailed 
instructions, see the "Upgrading Sage Intelligence Reporting" (page 197) checklist.

 12. Review the Paperless Office module configuration for emailing statements, reports, 
journals, registers, and other forms. For more information, see Set Up Paperless 
Office in the Help.

 13. Review your Business Insights Dashboard pages. For more information, see Set Up 
Business Insights Dashboard in the Help.

 14. To use the eBusiness Manager module:              

 a. Restore the copied templates back to the IW folder after re-installing the 
Web Engine.

 b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS 
Inetpup\wwwroot\images folder and restart the IIS Web service.

Sage 100 Customer Upgrade Guide 174



 15. If you converted Work Order data to Production Management data, purchase orders 
that were linked to work orders must be relinked to work tickets. Use either of the 
following methods to relink:         

 l Use the Work Ticket to Purchase Order Post-Conversion Link Utility. Select File 
menu > Run, type *utl in the Run Program window, and click OK. In the 
Sage 100 Utilities window, select the utility and click OK.

 l Manually relink by selecting the purchase order in Purchase Order Entry and 
entering the applicable work ticket number in the Work Ticket No. field on the 
Lines tab.

 16. If you use Custom Financials Reporting, you must unhide the menu and tasks. 
Select File menu > Run and type *unhidegl in the Run Program window.

 17. Print all customized form definitions and compare them to the ones previously 
printed. Default forms may be erased in the upgrade process.

 18. If you purchased the Return Merchandise Authorization module, after setting up the 
data files for the first time, select Return Merchandise Authorization Setup menu > 
Create Customer Invoice Search Records to create customer invoice search 
records in RMA.

 19. To run Microsoft Script links, you must have the Microsoft Windows Script Host 
processor on your system. For information on installing the Microsoft Windows 
Script Host processor, refer to the Microsoft Download Center website.

 20. If you use Automatic Update or Task Scheduler, review your scheduled automatic 
updates and reschedule those updates by selecting Library Master Main menu > 
Automatic Update or Task Scheduler, as applicable.

 21. If you were using the classic Desktop, which is no longer available, and had task 
folders in your My Tasks area, you can add tasks to the Favorites list instead. For 
more information, see Add Items to the Favorites Content Group in the Help. 

 22. Test all printers, including Device Configurator printers, that you normally use for 
printing forms and reports. Each workstation must have a default printer defined.

 23. To use the auto-complete feature with enhanced search, run the Build Search Index 
utility to index your existing customer, vendor, and item records. To run the utility, 
select Library Master > Utilities > Build Search Index.             

 24. Install Paya Connect Desktop on each workstation for each Windows user who 
needs to access credit card and ACH payment information in Sage 100.             
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To install Paya Connect Desktop for Sage 100 Standard: 

 a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects 
to a Sage 100 Standard installation on a server, browser to the 
MAS90\Wksetup folder on the server.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

 a. Use File Explorer to browse to the server where Sage 100 is installed, and 
locate the MAS90\Wksetup folder.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

 25. If you installed the 32-bit version of Sage 100 and need to convert to the 64-bit 
version, see "Converting to 64-bit Version of Sage 100" (page 201).
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Upgrading from Version 2020 to Version 2025
When upgrading to version 2025, you must perform a parallel installation, and use the 
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to 
upgrade your data. For more information, consult with your Sage business partner. 

If you have custom modules or modifications to any of your modules, consult your Sage 
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for 
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide. 
You can find the guide on the Sage 100 Documents page. 

Pre-Upgrade Checklist

You must prepare your version 2020 data for upgrading. This should be done for each 
company you plan to upgrade.

Complete these steps in your version 2020 installation. 

 1. Process all pending credit card transactions.

 2. Print and update all journals and registers.         

Important! Failure to complete this step may result in loss of data.

 3. If you use the Payroll module:             

 l Update the Payroll Check Register.

 l Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is 
not part of the Sage 100 installation program. To avoid the need to run a 
separate data conversion for Payroll, install the module before proceeding to 
the Upgrade Checklist. 

For more information, see the Sage 100 Payroll Installation and Upgrade Guide 
available on the Sage 100 Documents page. 

 4. If you're upgrading the Work Order module to Production Management, run Work 
Order Purge to move closed work orders into the history files. Work Order Purge is 
located on the Work Order Main menu.     
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Upgrading from Version 2020 to Version 2025

 5. Create a backup of your version 2020 MAS90 folder, which includes data for all of 
your companies. Perform this step following your usual backup process. For specific 
support on how to back up your data, refer to manuals for your backup software or 
contact the vendor from whom you purchased that product.

 6. Rebuild all data files.             

 l If you're upgrading from Sage 100 Standard or Advanced, use the Rebuild Key 
Files and Rebuild Sort File utilities.

 l If you're upgrading from Sage 100 Premium, use the Rebuild Sort File utility.

You must answer Yes to all recalculation questions.

 7. Print all customized form definitions.

 8. If you're using eBusiness Manager, back up any templates, .htm files, and the IW 
folder before uninstalling the previous version of the Web Engine.

 9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility 
examines your data and displays a list of tasks that you should run before migrating 
your data. For more information, see the Pre-Migration Utility help.

 10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to 
port number 1433 on the server with your version 2020 installation. Port 1433 is the 
default SQL Server port.

Upgrade Checklist 

After completing the "Pre-Upgrade Checklist" (page 177), you are ready to migrate your 
data to your version 2025 system.

Complete these steps in your version 2025 installation.

 l For Sage 100 Standard or Advanced, use the checklist below. 

 l For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium " (page 179).

Note: If you’re going to convert data for the Payroll module, you’ll need access to 
Tax Profile Maintenance. If you use Payroll departments, you must have access to 
all departments in each company.

Upgrade Checklist for Sage 100 Standard and Advanced

 1. Create a backup of your version 2025 MAS90 folder. Creating a backup now will 
save time if you need to revert to the folder’s original state. 
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 2. Log into Sage 100 2025 as the Administrator. From the Administrative Tools 
window:             

 a. Start Role Maintenance and create a role that you’ll use to run the Parallel 
Migration Wizard. 

 b. On the Tasks tab, expand Library Master > Miscellaneous Tasks, and then 
select the Parallel Migration check box.

 c. Start User Maintenance, create a logon, and select the role that you 
created.

 d. Close the Administrative Tools window.

 3. Log in to Sage 100 2025, and select Library Master > Utilities > Parallel Migration. 
Follow the steps in the wizard to migrate your data. 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Upgrade Checklist for Sage 100 Premium 

Use this checklist to migrate your Sage 100 Premium data.
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Important!  

 l You must have administrator rights for the server with your prior version of 
Sage 100 and the server with your version 2025 installation.

 l Clustered drives do not allow hidden shares. If you are using clustered drives, 
follow the instructions in the Manual Workaround section of Sage 
Knowledgebase article: During Parallel Migration where Sage 100 Premium is 
on one server and SQL Server is on a different server (solution ID 
224924950076993).

 1. For your Sage 100 2025 installation, create a backup of the following:             

 a. The Sage 100 MAS90 folder

 b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original 
state.

 2. Verify that the required rights and permissions are set up on the server(s) where 
SQL Server is installed. If the instance of SQL Server for Sage 100 2025 is installed 
on a different server than the instance used for your prior version, you must 
complete these steps on both servers.                  

 a. Open the Control Panel, select Administrative Tools, and then select 
Services. 

 b. In the Services window, locate the SQL Server instance used for Sage 100 
Premium, right-click it, and select Properties.

 c. In the Properties window, click the Log On tab and select an option.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on the same server as the instance used for your prior version of Sage 
100 Premium, select Local System Account.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on a different server than the one used for your prior version of Sage 
100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator  

Replace "ServerName" with the name of the server. Sage strongly 
recommends using the actual Administrator or Domain Administrator 
account. 

Enter the password for the account.
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 d. Apply your changes and then stop and restart the services.

 e. If you’re working with more than one server, make sure that all servers can 
access each other through hidden shares. 

For example: \\ServerName\C$, \\ServerName\D$

 3. Start the Parallel Migration Wizard using one of the methods below, and follow the 
steps in the wizard.             

 l If you are using Windows Server 2008, start the Parallel Migration Wizard from 
the Sage program group on the Start menu.

 l If you are using Windows Server 2012 or later, start the Parallel Migration 
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL 
Server locations. The hidden shares are used to access the source databases to 
create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL 
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the 
destination ..\DATA SQL Server folders. 

To complete the process, the wizard then restores the databases into the new SQL 
Server location and removes the .bak files from both the source and destination 
locations.

If permissions were not set correctly on both servers, you may receive the following 
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied 
2 Setup will now terminate"

If this error occurs, see Sage Knowledgebase article: During Parallel Migration 
where Sage 100 Premium is on one server and SQL Server is on a different server 
(solution ID 224924950076993). 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

You're now ready to convert your data to version 2025. 
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Upgrading from Version 2020 to Version 2025

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Data Conversion Checklist

Follow these steps to convert your data. 

 1. Select Library Master Main menu > Company Maintenance. Select a company, and 
then click Convert to convert your data. You must convert data for each of your 
companies. In addition, you can select one or more of the following options:                              

 l Convert Data for All Companies: Select this check box to convert data for all of 
your companies instead of doing it one-by-one. This check box may be 
unavailable if you’re converting Payroll data, depending on which version of 
Payroll you’re upgrading from. 

 l Convert SAP Crystal Reports: Select this check box to convert all of your 
custom reports and forms. The time required to convert your reports and forms 
depends on how many of them you have that need to be converted. The 
process runs in the background, and you can continue working in Sage 100 
while it’s running. 

You can convert custom forms and reports later by running the Sage 100 
Crystal Report Conversion Wizard.

 l Update Custom Office Panels to Current Level: Select this check box to run the 
Custom Office panel update for any customized panels for the companies being 
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels 
to Current Level utility on the Custom Office Utilities menu. 

 2. If your system is integrated with Sage CRM, go into CRM Server Options, and 
update the following information as needed.             

 l Integration server port ID

 l Sage CRM SQL server name

 l Sage CRM SQL database name

The server name and database name should reference the mirror installation that 
you created for integration with Sage 100 2025. For more information on this 
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process, refer to the Installing Sage CRM section in the Sage 100 Installation and 
System Administrator’s Guide. 

After updating the information, load the Sage CRM data.

 3. If you synchronize payroll data between your General Ledger module and Sage 
Payroll Services, verify that your Sage 100 company or companies are still linked to 
the service. 

 a. Select General Ledger > Payroll Services > Payroll Services 
Synchronization Wizard. 

 b. Sign in to Sage Payroll Services. 

 c. Proceed through the wizard. 

 d. Review the status messages shown in the Synchronizing Data with Sage 
Payroll Services window. 

If you see a "Synchronization Complete" message, no further action is 
required. 

If you see a "Synchronization failed" message, contact iSolved Support for 
assistance with resetting the link.   

 4. Update customized panels by selecting Custom Office Utilities menu > Update 
Customized Panels to Current Level. Review the placement of all user-defined 
fields. 

 5. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to 
the new version of the software and prior to accessing other modules, select Library 
Master Utilities menu > Lookup Conversion to convert your lookups. 

 6. Verify that all module links are functional by selecting Library Master Utilities menu 
> Link Maintenance Utility. Links that appear in red are broken and will need to be 
fixed using the Relink button in Link Maintenance Utility. For more information on 
relinking files, see Copy/Move/Relink Files in your Help system.

 7. If you are also upgrading your Payroll Module, review the list of enhancements and 
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide, 
available on the Sage 100 Documents page. 

 8. Test your customized Crystal reports and forms.             

 l If you need to troubleshoot issues with customized reports and forms, run the 
Crystal Form Comparison Report utility to compare your customized reports 
and forms to the standard ones in version 2025.
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Upgrading from Version 2020 to Version 2025

To run the utility, select File menu > Run, and then type SYWFCU. The utility 
tells you which tables, if any, have been added to a report or form. It does not 
provide information about formatting changes, such as those affecting fonts, 
logos, and so forth 

 l If you were previously using non-graphical forms, you will need to set them up 
using SAP Crystal Reports.

 l If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal 
Reports Conversion Wizard to convert your Crystal reports and forms. For more 
information, see SAP Crystal Reports FAQs in the Help system. If you do not 
run the wizard now, it will automatically run the first time that someone runs a 
form or report.

 l If you are using Sage 100 Premium, refer to the Converting Reports for Sage 
100 Premium section in the Sage 100 Installation and System Administrator's 
Guide for more information.

 9. If Sage 100 2025 is installed on the same computer as an earlier version of 
Sage 100, complete this step to avoid errors when printing forms and reports in the 
earlier version: 

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2020 
installation to the same folder in your 2025 installation. You must complete this step 
on both the server and the workstation.

 10. If your system has custom reports, review the Custom Reports menus to make sure 
they are available. If they are not, add them using Report Manager.

 11. If you use Sage Intelligence Reporting, create a new repository for use with the 
latest version of Sage 100 and import any custom reports into it. For detailed 
instructions, see the "Upgrading Sage Intelligence Reporting" (page 197) checklist.

 12. Review the Paperless Office module configuration for emailing statements, reports, 
journals, registers, and other forms. For more information, see Set Up Paperless 
Office in the Help.

 13. Review your Business Insights Dashboard pages. For more information, see Set Up 
Business Insights Dashboard in the Help.

 14. To use the eBusiness Manager module:              

 a. Restore the copied templates back to the IW folder after re-installing the 
Web Engine.

 b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS 
Inetpup\wwwroot\images folder and restart the IIS Web service.
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 15. If you converted Work Order data to Production Management data, purchase orders 
that were linked to work orders must be relinked to work tickets. Use either of the 
following methods to relink:         

 l Use the Work Ticket to Purchase Order Post-Conversion Link Utility. Select File 
menu > Run, type *utl in the Run Program window, and click OK. In the 
Sage 100 Utilities window, select the utility and click OK.

 l Manually relink by selecting the purchase order in Purchase Order Entry and 
entering the applicable work ticket number in the Work Ticket No. field on the 
Lines tab.

 16. If you use Custom Financials Reporting, you must unhide the menu and tasks. 
Select File menu > Run and type *unhidegl in the Run Program window.

 17. Print all customized form definitions and compare them to the ones previously 
printed. Default forms may be erased in the upgrade process.

 18. If you purchased the Return Merchandise Authorization module, after setting up the 
data files for the first time, select Return Merchandise Authorization Setup menu > 
Create Customer Invoice Search Records to create customer invoice search 
records in RMA.

 19. To run Microsoft Script links, you must have the Microsoft Windows Script Host 
processor on your system. For information on installing the Microsoft Windows 
Script Host processor, refer to the Microsoft Download Center website.

 20. If you use Automatic Update or Task Scheduler, review your scheduled automatic 
updates and reschedule those updates by selecting Library Master Main menu > 
Automatic Update or Task Scheduler, as applicable.

 21. If you were using the classic Desktop, which is no longer available, and had task 
folders in your My Tasks area, you can add tasks to the Favorites list instead. For 
more information, see Add Items to the Favorites Content Group in the Help. 

 22. Test all printers, including Device Configurator printers, that you normally use for 
printing forms and reports. Each workstation must have a default printer defined.

 23. To use the auto-complete feature with enhanced search, run the Build Search Index 
utility to index your existing customer, vendor, and item records. To run the utility, 
select Library Master > Utilities > Build Search Index.             

 24. Install Paya Connect Desktop on each workstation for each Windows user who 
needs to access credit card and ACH payment information in Sage 100.             
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To install Paya Connect Desktop for Sage 100 Standard: 

 a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects 
to a Sage 100 Standard installation on a server, browser to the 
MAS90\Wksetup folder on the server.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

 a. Use File Explorer to browse to the server where Sage 100 is installed, and 
locate the MAS90\Wksetup folder.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

 25. If you installed the 32-bit version of Sage 100 and need to convert to the 64-bit 
version, see "Converting to 64-bit Version of Sage 100" (page 201).
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Upgrading from Version 2019 to Version 2025
When upgrading to version 2025, you must perform a parallel installation, and use the 
Pre-Migration and Parallel Migration utilities from the Library Master Utilities menu to 
upgrade your data. For more information, consult with your Sage business partner. 

If you have custom modules or modifications to any of your modules, consult your Sage 
business partner or development partner prior to beginning the upgrade process.

If your system is integrated with Sage CRM, you must follow the instructions for 
upgrading Sage CRM in the Sage 100 Installation and System Administrator's Guide. 
You can find the guide on the Sage 100 Documents page.

Pre-Upgrade Checklist

You must prepare your version 2019 data for upgrading. This should be done for each 
company you plan to upgrade.

Complete these steps in your version 2019 installation. 

 1. Process all pending credit card transactions.

 2. Print and update all journals and registers.         

Important! Failure to complete this step may result in loss of data.

 3. If you use the Payroll module:             

 l Update the Payroll Check Register.

 l Complete and purge all direct deposit transactions.

You must install the Payroll module in addition to installing Sage 100. Payroll is 
not part of the Sage 100 installation program. To avoid the need to run a 
separate data conversion for Payroll, install the module before proceeding to 
the Upgrade Checklist. 

For more information, see the Sage 100 Payroll Installation and Upgrade Guide 
available on the Sage 100 Documents page. 

 4. If you're upgrading the Work Order module to Production Management, run Work 
Order Purge to move closed work orders into the history files. Work Order Purge is 
located on the Work Order Main menu.     
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Upgrading from Version 2019 to Version 2025

 5. Create a backup of your version 2019 MAS90 folder, which includes data for all of 
your companies. Perform this step following your usual backup process. For specific 
support on how to back up your data, refer to manuals for your backup software or 
contact the vendor from whom you purchased that product.

 6. Rebuild all data files.             

 l If you're upgrading from Sage 100 Standard or Advanced, use the Rebuild Key 
Files and Rebuild Sort File utilities.

 l If you're upgrading from Sage 100 Premium, use the Rebuild Sort File utility.

You must answer Yes to all recalculation questions.

 7. Print all customized form definitions.

 8. If you're using eBusiness Manager, back up any templates, .htm files, and the IW 
folder before uninstalling the previous version of the Web Engine.

 9. Run the Pre-Migration Utility on the Library Master Utilities menu. The utility 
examines your data and displays a list of tasks that you should run before migrating 
your data. For more information, see the Pre-Migration Utility help.

 10. If you are upgrading Sage 100 Premium, configure your firewall to allow access to 
port number 1433 on the server with your version 2019 installation. Port 1433 is the 
default SQL Server port.

Upgrade Checklist 

After completing the "Pre-Upgrade Checklist" (page 187), you are ready to migrate your 
data to your version 2025 system.

Complete these steps in your version 2025 installation.

 l For Sage 100 Standard or Advanced, use the checklist below. 

 l For Sage 100 Premium, see "Upgrade Checklist for Sage 100 Premium" (page 189).

Note: If you’re going to convert data for the Payroll module, you’ll need access to 
Tax Profile Maintenance. If you use Payroll departments, you must have access to 
all departments in each company.

Upgrade Checklist for Sage 100 Standard and Advanced

 1. Create a backup of your version 2025 MAS90 folder. Creating a backup now will 
save time if you need to revert to the folder’s original state. 

Sage 100 Customer Upgrade Guide 188



 2. Log into Sage 100 2025 as the Administrator. From the Administrative Tools 
window:             

 a. Start Role Maintenance and create a role that you’ll use to run the Parallel 
Migration Wizard. 

 b. On the Tasks tab, expand Library Master > Miscellaneous Tasks, and then 
select the Parallel Migration check box.

 c. Start User Maintenance, create a logon, and select the role that you 
created.

 d. Close the Administrative Tools window.

 3. Log in to Sage 100 2025, and select Library Master > Utilities > Parallel Migration. 
Follow the steps in the wizard to migrate your data. 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Upgrade Checklist for Sage 100 Premium

Use this checklist to migrate your Sage 100 Premium data.
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Important!  

 l You must have administrator rights for the server with your prior version of 
Sage 100 and the server with your version 2025 installation.

 l Clustered drives do not allow hidden shares. If you are using clustered drives, 
follow the instructions in the Manual Workaround section of Sage 
Knowledgebase article: During Parallel Migration where Sage 100 Premium is 
on one server and SQL Server is on a different server (solution ID 
224924950076993).

 1. For your Sage 100 2025 installation, create a backup of the following:             

 a. The Sage 100 MAS90 folder

 b. The MAS_System SQL Server database

Creating backups now will save time if you need to revert to the installation’s original 
state.

 2. Verify that the required rights and permissions are set up on the server(s) where 
SQL Server is installed. If the instance of SQL Server for Sage 100 2025 is installed 
on a different server than the instance used for your prior version, you must 
complete these steps on both servers.                  

 a. Open the Control Panel, select Administrative Tools, and then select 
Services. 

 b. In the Services window, locate the SQL Server instance used for Sage 100 
Premium, right-click it, and select Properties.

 c. In the Properties window, click the Log On tab and select an option.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on the same server as the instance used for your prior version of Sage 
100 Premium, select Local System Account.

 l If the SQL Server instance that you’re using for version 2025 is installed 
on a different server than the one used for your prior version of Sage 
100 Premium, select This Account.

In the account field, enter: \\ServerName\Administrator  

Replace "ServerName" with the name of the server. Sage strongly 
recommends using the actual Administrator or Domain Administrator 
account. 

Enter the password for the account.
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 d. Apply your changes and then stop and restart the services.

 e. If you’re working with more than one server, make sure that all servers can 
access each other through hidden shares. 

For example: \\ServerName\C$, \\ServerName\D$

 3. Start the Parallel Migration Wizard using one of the methods below, and follow the 
steps in the wizard.             

 l If you are using Windows Server 2008, start the Parallel Migration Wizard from 
the Sage program group on the Start menu.

 l If you are using Windows Server 2012 or later, start the Parallel Migration 
Wizard from the Start window.

The Migration Wizard creates .bak files in the ..\DATA folders for the two SQL 
Server locations. The hidden shares are used to access the source databases to 
create the .bak files. For example:

\\ServerName\c$\Program Files\Microsoft SQL 
Server\MSSQL12.MSSQLSERVER\MSSQL\Data

After the .bak files are created, the wizard copies them to the hidden share of the 
destination ..\DATA SQL Server folders. 

To complete the process, the wizard then restores the databases into the new SQL 
Server location and removes the .bak files from both the source and destination 
locations.

If permissions were not set correctly on both servers, you may receive the following 
error: "Error Number : 0x80040e14 Description: Access Denied 5 or Access Denied 
2 Setup will now terminate"

If this error occurs, see Sage Knowledgebase article: During Parallel Migration 
where Sage 100 Premium is on one server and SQL Server is on a different server 
(solution ID 224924950076993). 

 4. After the migration is complete, log into Sage 100 2025 as the Administrator. Use 
the tasks available from the Administrative Tools window to review user security 
and set up and assign the appropriate roles to your users.

 5. Review security tasks for new features in version 2025. Review ODBC security if it 
is used.

 6. If you are using Unified Logon and you upgraded your system files, you must add 
the following statement on one workstation SOTA.ini: Logon=Yes. 

 7. If you customized your Desktop, review the customizations. 

You're now ready to convert your data to version 2025. 
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Upgrading from Version 2019 to Version 2025

Important! After migrating data for companies that are connected to Bank Feeds, 
you cannot use Bank Feeds in any pre-existing company that was not migrated 
and converted. You will not be able to connect or disconnect banks or process 
transactions.

Data Conversion Checklist

Follow these steps to convert your data. 

 1. Select Library Master Main menu > Company Maintenance. Select a company, and 
then click Convert to convert your data. You must convert data for each of your 
companies. In addition, you can select one or more of the following options:                              

 l Convert Data for All Companies: Select this check box to convert data for all of 
your companies instead of doing it one-by-one. This check box may be 
unavailable if you’re converting Payroll data, depending on which version of 
Payroll you’re upgrading from. 

 l Convert SAP Crystal Reports: Select this check box to convert all of your 
custom reports and forms. The time required to convert your reports and forms 
depends on how many of them you have that need to be converted. The 
process runs in the background, and you can continue working in Sage 100 
while it’s running. 

You can convert custom forms and reports later by running the Sage 100 
Crystal Report Conversion Wizard.

 l Update Custom Office Panels to Current Level: Select this check box to run the 
Custom Office panel update for any customized panels for the companies being 
converted. This update runs without any prompts.

You can update custom panels later by running the Update Customized Panels 
to Current Level utility on the Custom Office Utilities menu. 

 2. If your system is integrated with Sage CRM, go into CRM Server Options, and 
update the following information as needed.             

 l Integration server port ID

 l Sage CRM SQL server name

 l Sage CRM SQL database name

The server name and database name should reference the mirror installation that 
you created for integration with Sage 100 2025. For more information on this 
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process, refer to the Installing Sage CRM section in the Sage 100 Installation and 
System Administrator’s Guide. 

After updating the information, load the Sage CRM data.

 3. If you synchronize payroll data between your General Ledger module and Sage 
Payroll Services, verify that your Sage 100 company or companies are still linked to 
the service. 

 a. Select General Ledger > Payroll Services > Payroll Services 
Synchronization Wizard. 

 b. Sign in to Sage Payroll Services. 

 c. Proceed through the wizard. 

 d. Review the status messages shown in the Synchronizing Data with Sage 
Payroll Services window. 

If you see a "Synchronization Complete" message, no further action is 
required. 

If you see a "Synchronization failed" message, contact iSolved Support for 
assistance with resetting the link.   

 4. Update customized panels by selecting Custom Office Utilities menu > Update 
Customized Panels to Current Level. Review the placement of all user-defined 
fields. 

 5. If you have customized Advanced Lookup Engine (ALE) lookups, after converting to 
the new version of the software and prior to accessing other modules, select Library 
Master Utilities menu > Lookup Conversion to convert your lookups. 

 6. Verify that all module links are functional by selecting Library Master Utilities menu 
> Link Maintenance Utility. Links that appear in red are broken and will need to be 
fixed using the Relink button in Link Maintenance Utility. For more information on 
relinking files, see Copy/Move/Relink Files in your Help system.

 7. If you are also upgrading your Payroll Module, review the list of enhancements and 
upgrade instructions in the Sage 100 Payroll Installation and Upgrade Guide, 
available on the Sage 100 Documents page. 

 8. Test your customized Crystal reports and forms.             

 l If you need to troubleshoot issues with customized reports and forms, run the 
Crystal Form Comparison Report utility to compare your customized reports 
and forms to the standard ones in version 2025.
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Upgrading from Version 2019 to Version 2025

To run the utility, select File menu > Run, and then type SYWFCU. The utility 
tells you which tables, if any, have been added to a report or form. It does not 
provide information about formatting changes, such as those affecting fonts, 
logos, and so forth 

 l If you were previously using non-graphical forms, you will need to set them up 
using SAP Crystal Reports.

 l If you are using Sage 100 Standard or Sage 100 Advanced, use the Crystal 
Reports Conversion Wizard to convert your Crystal reports and forms. For more 
information, see SAP Crystal Reports FAQs in the Help system. If you do not 
run the wizard now, it will automatically run the first time that someone runs a 
form or report.

 l If you are using Sage 100 Premium, refer to the Converting Reports for Sage 
100 Premium section in the Sage 100 Installation and System Administrator's 
Guide for more information.

 9. If Sage 100 2025 is installed on the same computer as an earlier version of 
Sage 100, complete this step to avoid errors when printing forms and reports in the 
earlier version: 

Copy the pvxwin32.exe.config file from the ..\MAS90\Home folder in your 2019 
installation to the same folder in the 2025 installation. You must complete this step 
on both the server and the workstation.

 10. If your system has custom reports, review the Custom Reports menus to make sure 
they are available. If they are not, add them using Report Manager.

 11. If you use Sage Intelligence Reporting, create a new repository for use with the 
latest version of Sage 100 and import any custom reports into it. For detailed 
instructions, see the "Upgrading Sage Intelligence Reporting" (page 197) checklist.

 12. Review the Paperless Office module configuration for emailing statements, reports, 
journals, registers, and other forms. For more information, see Set Up Paperless 
Office in the Help.

 13. Review your Business Insights Dashboard pages. For more information, see Set Up 
Business Insights Dashboard in the Help.

 14. To use the eBusiness Manager module:              

 a. Restore the copied templates back to the IW folder after re-installing the 
Web Engine.

 b. Copy the poweredby.gif image from the MAS90\Images folder to the IIS 
Inetpup\wwwroot\images folder and restart the IIS Web service.
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 15. If you converted Work Order data to Production Management data, purchase orders 
that were linked to work orders must be relinked to work tickets. Use either of the 
following methods to relink:         

 l Use the Work Ticket to Purchase Order Post-Conversion Link Utility. Select File 
menu > Run, type *utl in the Run Program window, and click OK. In the 
Sage 100 Utilities window, select the utility and click OK.

 l Manually relink by selecting the purchase order in Purchase Order Entry and 
entering the applicable work ticket number in the Work Ticket No. field on the 
Lines tab.

 16. If you use Custom Financials Reporting, you must unhide the menu and tasks. 
Select File menu > Run and type *unhidegl in the Run Program window.

 17. Print all customized form definitions and compare them to the ones previously 
printed. Default forms may be erased in the upgrade process.

 18. If you purchased the Return Merchandise Authorization module, after setting up the 
data files for the first time, select Return Merchandise Authorization Setup menu > 
Create Customer Invoice Search Records to create customer invoice search 
records in RMA.

 19. To run Microsoft Script links, you must have the Microsoft Windows Script Host 
processor on your system. For information on installing the Microsoft Windows 
Script Host processor, refer to the Microsoft Download Center website.

 20. If you use Automatic Update or Task Scheduler, review your scheduled automatic 
updates and reschedule those updates by selecting Library Master Main menu > 
Automatic Update or Task Scheduler, as applicable.

 21. If you were using the classic Desktop, which is no longer available, and had task 
folders in your My Tasks area, you can add tasks to the Favorites list instead. For 
more information, see Add Items to the Favorites Content Group in the Help. 

 22. Test all printers, including Device Configurator printers, that you normally use for 
printing forms and reports. Each workstation must have a default printer defined.

 23. To use the auto-complete feature with enhanced search, run the Build Search Index 
utility to index your existing customer, vendor, and item records. To run the utility, 
select Library Master > Utilities > Build Search Index.             

 24. Install Paya Connect Desktop on each workstation for each Windows user who 
needs to access credit card and ACH payment information in Sage 100.             
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To install Paya Connect Desktop for Sage 100 Standard: 

 a. Use File Explorer to browse to the MAS90\Wksetup folder.

If you are installing Paya Connect Desktop on a workstation that connects 
to a Sage 100 Standard installation on a server, browser to the 
MAS90\Wksetup folder on the server.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

To install Paya Connect Desktop for Sage 100 Advanced and Premium:

 a. Use File Explorer to browse to the server where Sage 100 is installed, and 
locate the MAS90\Wksetup folder.

 b. Double-click Autorun.exe to open the Workstation Setup program; it takes a 
few seconds to launch.

 c. Click Install Paya Connect Desktop.

 d. Proceed through the steps in the Paya Connect Desktop installation wizard 
to install the program.

 25. If you installed the 32-bit version of Sage 100 and need to convert to the 64-bit 
version, see "Converting to 64-bit Version of Sage 100" (page 201).
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Upgrading Sage Intelligence Reporting

If you use Sage Intelligence Reporting, follow the steps in this chapter to create a new 
repository for Sage 100 2025. If you have custom reports, follow the instructions to export 
custom reports from your prior version of the program and import them into the new 
repository. 

For detailed instructions on each step, see:

 l "Export Custom Reports" (page 197)

 l "Create a New Repository" (page 198)

 l "Set Up Sage Intelligence Reporting in Sage 100 2025" (page 198)

 l "Import Custom Reports" (page 199)

Report Compatibility
Reports can be imported only from an earlier version of the program or another instance 
of the same version. For example, you can import a report created in version 2013 into 
version 2025. You cannot import a report created in version 2025 into version 2013.  

Reports created in Sage 100 Standard and Sage 100 Advanced are not compatible with 
Sage 100 Premium. Likewise, reports created in Sage 100 Premium are not compatible 
with  Sage 100 Standard and Sage 100 Advanced.

Export Custom Reports
In your prior version of Sage 100, export all of the custom reports that you want to use in 
version 2025.

To export custom reports

 1. In your prior version of Sage 100, select Sage Intelligence Reporting Main menu > 
Report Manager. 

 2. Right-click a report and then click Export Report. (Alternately, select a report and 
then, on the Tools menu, click Export Report.)

Sage 100 Customer Upgrade Guide 197

Upgrading Sage Intelligence Reporting



Create a New Repository

 3. Select the location where you want to save the file and then click Save. A file with an 
AL_ extension is created.  

 4. Repeat these steps for all custom reports that you want to use in version 2025.

Create a New Repository
Create a shared folder to use as the Sage Intelligence Reporting repository for Sage 100 
2025. We recommend using a separate repository for each installation of Sage 
Intelligence Reporting. 

Note: These steps may vary depending on what version of Windows you are 
using. Check with your network administrator if you need assistance.

To create a repository 

 1. Use Windows File Explorer to create a folder in the desired location.

 2. Right-click the folder, point to "Share with," and click "Advanced sharing."

 3. On the Sharing tab, select the "Share this folder" check box.

 4. Enter a share name.

 5. Click Permissions.  

 6. For all applicable users, select the Full Control or Read and Write check boxes. 

 7. Click OK. 

 8. If you use reporting trees or distribution settings, copy the following folders from the 
old repository to the new one:

 l Report Trees

 l Distribution

Set Up Sage Intelligence Reporting in Sage 100 2025
After creating the shared folder, enter its location in Sage 100 2025. If you haven’t already 
registered your 2025 version of Sage Intelligence Reporting, you will be asked to do so. 

To set up Sage Intelligence Reporting

 1. In Sage 100 2025, select Sage Intelligence Reporting Main menu > Report 
Manager.
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 2. Click File and then click Change. 

 3. Click Yes in the message window.

 4. In the Network Repository Path field, type the UNC path to the shared folder that 
you created. For example: \\ServerName\ReportRpository

 5. Click OK.

 6. If you receive a message asking you to register Sage Intelligence Reporting, click 
OK to open the License Manager window.

 7. In the Account Number field, enter your Sage customer number.

 8. In the Serial Number field, enter you unlocking key. This field is case-sensitive. 

 9. Click Apply and then click Perform Registration. 

Import Custom Reports
After creating the new repository and registering Sage Intelligence Reporting, import any 
custom report files.

To import custom reports

 1. If you want to create folders to organize your reports, on the Home tab, click Add 
Folder. 

 2. Right-click either the Home folder or any custom folder created in the prior step, and 
then click Import Report. (Alternately, you can click the Tools tab, and then click 
Import Report.) 

 3. Select one of the custom reports that you exported from your prior version.

 4. In the Import Report window, in the Target Connection field, select a connection. 

 l For consolidated reports, select Sage MAS Consolidation. 

Note: You must own the Sage 100 Intelligence Connector module to 
generate consolidated reports.

 l For any other type of report, select Sage MAS (Auto Connect).  

 5. In the Report Destination field, select the folder for the report. 

 6. Click Import.

 7. On the Home tab in the Actions group, click Refresh.
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 8. Repeat these steps for any other custom reports that you exported from your prior 
version of Sage Intelligence Reporting. 
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Converting to 64-bit Version of 
Sage 100

If you installed the 32-bit version of Sage 100 on a computer running the 64-bit version of 
Windows, you can convert it to the 64-bit version. You should do this only if you are no 
longer using any earlier 32-bit versions of Sage 100 installed on the same computer, and 
if all of your Sage 100 workstations are running the 64-bit version of Windows. 

All versions of Sage 100 released before version 2021 are 32-bit. 

Warnings!

 l If you have an earlier 32-bit version of Sage 100 installed on the computer, it will 
no longer work after you convert version 2025 to 64-bit.                 

 l If you have any Sage 100 workstations running the 32-bit version of Windows, 
they will no longer be able to run Sage 100 after it has been converted to 64-bit.                 

Do not convert to 64-bit until after you’ve completed your testing and have created a 
backup of the data from your earlier version. 

To convert from 32-bit to 64-bit

 1. On the computer where Sage 100 2025 is installed, open the folder where the 
Sage 100 installation program is located. 

 2. Click or double-click the 32_64_Bit_Switch_Utility.exe file. 

 3. Click Next and then enter the password for the Sage 100 Administrator account. 

 4. Click Convert. 

Sage 100 is converted to the 64-bit version. 

The Workstation Synchronization program automatically upgrades the workstations the 
next time Sage 100 is started on the workstation. 
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Time Track Task Locations 

Refer to the following table to see which Time Track tasks replaced TimeCard tasks in 
version 2018.2 and where they are located.

TimeCard Task Time Track Task

Setup Menu  

Cost Code/Earnings Code Setup
Select Job Cost > Setup > Cost Code 
Maintenance. Click Earnings to open the Valid 
Earnings Code window. 

Exception Code Maintenance Not available.

TimeCard & TimeClock Options Payroll > Setup > Time Track Options 

TimeCard Employee Maintenance
Select Payroll > Main > Employee Maintenance. 
Click More and select Time Track to open the 
Employee Time Track Settings window. 

TimeCard Job Maintenance
Select Job Cost > Main > Job Cost Maintenance. 
Select or clear the Exclude from Certified Payroll 
Report check box. 

TimeCard Utilities Not available.

TimeClock Shift Maintenance Select Payroll > Time Track > Shift Maintenance. 

Main Menu  

TimeCard Entry and Edit Select Payroll > Time Track > Time Track Entry. 

TimeCard Entry and Edit --New 
Entries Only

Select Payroll > Time Track > Time Track Entry. 

TimeCard Inquiry Select Payroll > Time Track > Time Track Inquiry.

TimeCard History Inquiry
Not available. To view history, select Payroll > 
Time Track > Time Track Report, and select the 
History check box before printing the report. 
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TimeCard Task Time Track Task

TimeClock Punch In/Punch Out Select Payroll > Time Track > Punch In/Out.

Period End Menu  

Purge History Files
Select Payroll > Period End > Period End 
Processing. 

Purge/Transfer to History
Not available. Data is automatically transferred to 
history when time entries are updated in the Job 
Cost and Payroll modules.

Job Cost Menu  

Calculate Job Cost Selections Not available.*

Daily Transaction Register Not available.*

J/C Distribution Register/Update
Select Job Cost > Time Track > Time Track 
Register / Update. 

J/C Selection Audit Report
Select Job Cost > Time Track > Time Track 
Register / Update.

Job Costs Selection
Select Job Cost > Time Track > Time Track 
Selection.

Reports Menu  

Approaching Overtime Report
Select Payroll > Time Track > Approaching 
Overtime Report.

Attendance Worksheet
Select Payroll > Time Track > Attendance 
Worksheet. 

Average Hourly Pay Report Not available. 

Certified Payroll Report
Select Payroll > Main > Certified Payroll 
Worksheet. 

Departmental Exception Report Not available. 

Employee Exception Report Not available.
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Exception Calendar Report Not available. 

Gross Earnings Report Not available. 

Job Daily Production Report
Select Job Cost > Time Track > Job Daily 
Production Report.

TimeCard Report Select Payroll > Time Track > Time Track Report. 

*Labor costs are automatically calculated when they are selected and updated to the Job 
Cost module. There is not a separate Daily Transaction Register for Time Track. Costs 
are updated when you update the Job Cost Daily Transaction Register. For more 
information, see Post Time Track Entry Costs for Jobs in the help. 
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64-Bit version of Sage 100  74

A

Accounts Payable
changes in 2021  75
changes in 2021.2  71
changes in 2021.6  69
changes in version 2020  103
enhancements in 2022.3  55
enhancements in 2023  43
enhancements in 2023.4  36
enhancements in 2024  26
enhancements in 2024.1  20
enhancements in 2025  4

Accounts Receivable
changes in 2020  106
changes in 2021  75
changes in 2021.5  70
enhancements in 2022  60
enhancements in 2022.2  57
enhancements in 2025  5

Activity Log  129

Activity Log Configuration  130
Activity Log Purge Utility  130
Actual % Complete field  114
addresses

expanded fields  99
international support  99

auto-complete  123

B

Bank Reconciliation
changes in 2021  76
enhancements in 2025  5

Business Insights
enhancements in 2025  6

C

changes in 2021
Accounts Payable  75
Accounts Receivable  75
Bank Reconciliation  76
Custom Office  76
Fixed Assets  77
global  72

Index
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Inventory Management  77
Library Master  78
Office 365 Integration  90
Paperless Office  83
Purchase Order  86
Sales Order  88
Visual Integrator  89
Visual Process Flows  89

changes in 2021.2
Accounts Payable  71
Library Master  72

changes in 2021.5
Accounts Receivable  70

changes in 2021.6
Accounts Payable  69

check number field expanded  73
checks

reversing in Accounts Payable  104
classic Desktop  118
classic Desktop customizations, 

importing  102
company types  72
confirm-to name, expanded field  99
contact name, expanded field  99
conversion options

custom office panels  115
SAP Crystal Reports  115

Custom Office
changes in 2020  108
changes in 2021  76
enhancements in 2019  126

customer name, expanded field  99

D

Daily Transaction Register, automatic 
updates  120

data conversion
default country code  100

data entry fields, masked input  110
Data File Display and Maintenance  128
Default Country Code field  100
default form codes, maintaining  82
Desktop changes

enhancements in 2023  41
enhancements in 2024  23
enhancements in 2024.1  20
enhancements in 2025  2

Development Studio
enhancements in 2023  44
enhancements in 2023.2  39

E

eInvoicing  106
Accounts Receivable invoices  106
Job Cost Invoices  114

encryption
bank information  127
inactive customers  107
inactive vendors  104

enhancements in 2019
Custom Office  126
General Ledger  126
global  120
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Inventory Management  127
Library Master  128
Paperless Office  132
Purchase Order  135

enhancements in 2020
accounts payable  103
Accounts Receivable  106
Custom Office  108
global  98
Inventory Management  110
Job Cost  113
Library Master  115
Purchase Order  115
Sales Order  117
Visual Integrator  118

enhancements in 2022
Accounts Receivable  60
global  59
Inventory Management  61
Microsoft 365  68
Production Management  63
Sales Order  66
Visual Process Flows  67

enhancements in 2022.1
Inventory Requirements Planning  57
Library Master  58

enhancements in 2022.2
Accounts Receivable  57

enhancements in 2022.3
Accounts Payable  55
Production Management  57

enhancements in 2022.4
global  55

enhancements in 2022.5
Production Management  54

enhancements in 2023
Accounts Payable  43
Desktop changes  41
Development Studio  44
global  41
Inventory Management  45
Inventory Requirements Planning  46
Library Master  47
Paperless Office  48
Production Management  48

enhancements in 2023.1
global  40

enhancements in 2023.2
Development Studio  39
Production Management  39

enhancements in 2023.3
Inventory Requirements Planning  38
Production Management  39

enhancements in 2023.4
Accounts Payable  36
Inventory Requirements Planning  36
Library Master  37
Production Management  38
Sage Connect  37
Sales Order  38

enhancements in 2023.5
Production Management  35
Sage Supply Chain Intelligence 

(Anvyl)  35
enhancements in 2024

Accounts Payable  26
Desktop  23
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global  23
Inventory Management  27
Inventory Requirements Planning  28
Library Master  28
Paperless Office  29
Production Management  31
Purchase Order  32
Return Merchandise Authorization  33
Sales Order  33

enhancements in 2024.1
Accounts Payable  20
Desktop  20
global  20
Inventory Requirements Planning  21
Library Master  21
Production Management  22
Sage Connect  22
Sales Order  22

enhancements in 2024.2
Production Management  19
Sage Supply Chain Intelligence 

(Anvyl)  19
enhancements in 2025

Accounts Payable  4
Accounts Receivable  5
Bank Reconciliation  5
Business Insights  6
Desktop  2
General Ledger  7
global  3
integrations  17
Inventory Management  7
Inventory Requirements Planning  8
Paperless Office  9

Production Management  10
Purchase Order  12
Sales Order  15
Visual Integrator  16
Visual Process Flows  16

expanded fields
address  99
names  99
telephone and fax numbers  99

expiration dates for lot/serial items  110
exporting to Excel from list boxes  102

F

fax numbers, expanded fields  99
Fixed Assets

changes in 2021  77
Form 1099-NEC  87, 105

G

General Journal, consolidating entries in 
one PDF  126

General Ledger
enhancements in 2019  126
enhancements in 2025  7

global
changes in 2021  72
enhancements in 2019  120
enhancements in 2020  98
enhancements in 2022  59
enhancements in 2022.4  55
enhancements in 2023  41
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enhancements in 2023.1  40
enhancements in 2024  23
enhancements in 2024.1  20
enhancements in 2025  3

grid customization  108

I

import jobs
change required for addresses  101, 

118
Integrations

enhancements in 2025  17
Sage Intelligence Reporting  17
Sage Supply Chain Intelligence 

(Anvyl)  17
international address support  99
Inventory Management

changes in 2020  110
changes in 2021  77
enhancements in 2019  127
enhancements in 2022  61
enhancements in 2023  45
enhancements in 2024  27
enhancements in 2025  7

Inventory Requirements Planning
enhancements in 2022.1  57
enhancements in 2023  46
enhancements in 2023.3  38
enhancements in 2023.4  36
enhancements in 2024  28
enhancements in 2024.1  21
enhancements in 2025  8

invoices, e-mailing to customers  106

J

Job Cost
changes in 2020  113

job costs, expensing  113
Journal Drill Down window, Paperless 

Viewer button  123

L

Library Master
changes in 2020  115
changes in 2021  78
changes in 2021.2  72
enhancements in 2019  128
enhancements in 2022.1  58
enhancements in 2023  47
enhancements in 2023.4  37
enhancements in 2024  28
enhancements in 2024.1  21

list boxes, exporting to Excel  102
Logging Level utility  103
lookup views, copying  124
lots, expiration dates  110

M

map services  101
Microsoft 365

enhancements in 2022  68
Microsoft 365 Connector, retired  17
Months to Retain Paid Invoices field  104
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O

OAuth authentication  83
Office 365 Integration

changes in 2021  90
Office 365 integration, configuration 

wizard  118
online payments, accepting from 

customers  106
Open Invoice By Job Report, unlimited 

cost types  105

P

Paperless Office
changes in 2021  83
enhancements in 2019  132
enhancements in 2023  48
enhancements in 2024  29
enhancements in 2025  9

Paperless Office Delivery Options 
window  108

Payment Center
renamed  74

PDF printer driver  135
Physical Count Entry  127
Physical Count Variance Register  127
Physical Count Worksheet  127
PII work tables, adding to custom 

reports  102
posting date warning message  121
Production Management

enhancements in 2022  63

enhancements in 2022.3  57
enhancements in 2022.5  54
enhancements in 2023  48
enhancements in 2023.2  39
enhancements in 2023.3  39
enhancements in 2023.4  38
enhancements in 2023.5  35
enhancements in 2024  31
enhancements in 2024.1  22
enhancements in 2024.2  19
enhancements in 2025  10

public favorites  59
Purchase Order

changes in 2020  115
changes in 2021  86
enhancements in 2019  135
enhancements in 2024  32
enhancements in 2025  12

purchase orders, applying to invoices and 
receipts  116

Purchases Clearing From History 
Report  86

R

Rebuild Key Files  132
requested-by name, expanded field  99
retired features

Microsoft 365 Connector and Office 
365 Contacts  17

SData Security  17
vault-only accounts  18
version 2020  118
version 2025  17
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Return Merchandise Authorization
enhancements in 2024  33

Reverse Check Run Utility  104
role security  78

S

Sage Connect
enhancements in 2023.4  37
enhancements in 2024.1  22

Sage Supply Chain Intelligence (Anvyl)
enhancements in 2023.5  35
enhancements in 2024.2  19

Sage University videos  103, 122-123, 
125

Sales Order
changes in 2021  88
enhancements in 2020  117
enhancements in 2022  66
enhancements in 2023.4  38
enhancements in 2024  33
enhancements in 2024.1  22
enhancements in 2025  15

Security menu  78
serial items, expiration dates  110
State/Province Code Maintenance  100

T

telephone numbers
expanded fields  99
phone type  99

TLS 1.2  124

tracking numbers, adding to invoice 
emails  135

U

UDFs
saving changes in pending status  109

user identifiers, displaying  73

V

vendor name, expanded field  99
Visual Integrator

changes in 2021  89
enhancements in 2020  118
enhancements in 2025  16

Visual Process Flows
changes in 2021  89
enhancements in 2022  67
enhancements in 2025  16

W

work-in-process job costs, 
expensing  113

Workstation Synchronization
admin rights  102
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